
Dell B5460dn Laser Printer

User's Guide

May 2012 www.dell.com | support.dell.com

Trademarks
Information in this document is subject to change without notice.
© 2012 Dell, Inc. All rights reserved.
Reproduction of this material in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.
Trademarks used in this text: Dell, the DELL logo, Inspiron, Dell Precision, Dimension, OptiPlex, Latitude, PowerEdge, PowerVault, PowerApp, and Dell OpenManage are trademarks
of Dell Inc.; Intel, Pentium, and Celeron are registered trademarks of Intel Corporation; Microsoft and Windows are registered trademarks of Microsoft Corporation.
Other trademarks and trade names may be used in this document to refer to the entities claiming the marks and names of their products. Dell Inc. disclaims any proprietary
interest in trademarks and trade names other than its own.

http://www.dell.com
http://support.dell.com


Contents

Safety information.......................................................................................6

Learning about the printer...........................................................................8
Finding information about the printer......................................................................................................8

Selecting a location for the printer............................................................................................................9

Printer configurations.............................................................................................................................10

Using the printer control panel...............................................................................................................12

Understanding the colors of the indicator and Sleep button lights........................................................12

Additional printer setup.............................................................................14
Installing internal options........................................................................................................................14

Installing hardware options.....................................................................................................................30

Attaching cables......................................................................................................................................32

Setting up the printer software...............................................................................................................34

Networking..............................................................................................................................................36

Verifying printer setup............................................................................................................................42

Loading paper and specialty media............................................................44
Setting the paper size and type...............................................................................................................44

Configuring Universal paper settings......................................................................................................44

Loading the 550‑sheet tray.....................................................................................................................44

Loading the 2100‑sheet tray...................................................................................................................49

Loading the multipurpose feeder............................................................................................................56

Linking and unlinking trays......................................................................................................................60
Linking and unlinking trays ...............................................................................................................................60
Creating a custom name for a paper type ........................................................................................................60
Assigning a custom paper type name ...............................................................................................................61
Assigning a custom paper type .........................................................................................................................61

Paper and specialty media guide................................................................63
Using specialty media..............................................................................................................................63

Paper guidelines......................................................................................................................................64

Supported paper sizes, types, and weights.............................................................................................67

Printing......................................................................................................72
Printing a document................................................................................................................................72

Contents 2



Printing a document .........................................................................................................................................72
Adjusting toner darkness ..................................................................................................................................72

Printing from a flash drive.......................................................................................................................73
Supported flash drives and file types................................................................................................................73
Printing from a flash drive ................................................................................................................................74

Printing confidential and other held jobs................................................................................................75
Storing print jobs in the printer ........................................................................................................................75
Printing confidential and other held jobs .........................................................................................................76

Printing information pages......................................................................................................................77
Printing a font sample list .................................................................................................................................77
Printing a directory list......................................................................................................................................77

Canceling a print job................................................................................................................................77
Canceling a print job from the printer control panel........................................................................................77
Canceling a print job from the computer .........................................................................................................77

Understanding printer menus....................................................................79
Menus list................................................................................................................................................79

Paper menu.............................................................................................................................................79

Reports menu..........................................................................................................................................90

Network/Ports menu...............................................................................................................................91

Security menu.......................................................................................................................................104

Settings menu........................................................................................................................................107

Help menu.............................................................................................................................................127

Saving money and the environment.........................................................128
Saving paper and toner.........................................................................................................................128

Saving energy........................................................................................................................................128

Recycling................................................................................................................................................132

Securing the printer..................................................................................133
Using the security lock feature..............................................................................................................133

Statement of Volatility..........................................................................................................................133

Erasing volatile memory........................................................................................................................134

Erasing non‑volatile memory................................................................................................................134

Erasing printer hard disk memory.........................................................................................................135

Configuring printer hard disk encryption..............................................................................................135

Finding printer security information.....................................................................................................136

Contents 3



Maintaining the printer............................................................................137
Estimated number of remaining pages.................................................................................................137

Cleaning the printer..............................................................................................................................137

Checking the status of parts and supplies.............................................................................................138

Ordering supplies..................................................................................................................................139

Storing supplies.....................................................................................................................................140

Replacing supplies.................................................................................................................................141

Moving the printer................................................................................................................................146

Managing the printer...............................................................................149
Managing printer messages..................................................................................................................149

Accessing Status Monitor Center..........................................................................................................149

Checking the virtual display...................................................................................................................149

Modifying confidential print settings....................................................................................................150

Copying printer settings to other printers.............................................................................................150

Restoring factory default settings.........................................................................................................151

Clearing jams............................................................................................152
Avoiding jams........................................................................................................................................152

Understanding jam messages and locations.........................................................................................154

[x]‑page jam, lift front cover to remove cartridge. [200–201]..............................................................156

[x]‑page jam, open upper rear door. [202]...........................................................................................158

[x]‑page jam, remove standard bin jam. [203]......................................................................................159

[x]‑page jam, open upper and lower rear door. [231–234]..................................................................159

[x]‑page jam, remove tray 1 to clear duplex. [235–239].......................................................................162

[x]‑page jam, open tray [x]. [24x]..........................................................................................................163

[x]‑page jam, clear manual feeder. [250]..............................................................................................164

[x]‑page jam, remove paper, open mailbox rear door. Leave paper in bin. [41y.xx]............................165

[x]‑page jam, remove paper, open expander rear door. Leave paper in bin. [43y.xx]..........................167

[x]‑page jam, remove paper, open finisher rear door. Leave paper in bin. [451].................................168

[x]‑page jam, remove paper, open stapler door. Leave paper in bin. [455–457]..................................169

Troubleshooting.......................................................................................172
Understanding the printer messages....................................................................................................172

Solving printer problems.......................................................................................................................189

Solving print problems..........................................................................................................................197

Contents 4



Embedded Web Server does not open.................................................................................................222

Contacting technical support................................................................................................................223

Appendix..................................................................................................224

Index........................................................................................................226

Contents 5



Safety information
Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.

Do not place or use this product near water or wet locations.

CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.

This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.

CAUTION—POTENTIAL INJURY:  The lithium battery in this product is not intended to be replaced. There is a
danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble, or incinerate a
lithium battery. Discard used lithium batteries according to the manufacturer's instructions and local
regulations.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn off the printer, and then unplug the power cord from the electrical outlet.

• Disconnect all cords and cables from the printer.

• If two or more optional finishers are installed, then remove the finishers individually from the printer.

Notes:

– Make sure to remove the topmost finisher first.

– To remove the finisher, hold the finisher on both sides, and then lift the latches to unlock the finisher.

• If the printer does not have a caster base but is configured with optional trays, then remove the trays.

Note: Slide the latch on the right side of the optional tray toward the front of the tray until it clicks into place.

• Use the handholds located on both sides of the printer to lift it.

• Make sure your fingers are not under the printer when you set it down.

• Make sure there is adequate clearance around the printer.

• Use only the power cord provided with this product or the manufacturer's authorized replacement.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before proceeding.

Use only the power cord provided with this product or the manufacturer's authorized replacement.

CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.
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This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.

CAUTION—POTENTIAL INJURY:  Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.

Refer service or repairs, other than those described in the user documentation, to a service representative.

CAUTION—SHOCK HAZARD: Do not set up this product or make any electrical or cabling connections, such as a
power cord, a fax feature or USB cable, during a lightning storm.

CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity tray or more than one option. If you
purchased a printer with a similar configuration, you may need additional furniture. For more information,
contact the place where you purchased the printer.

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

SAVE THESE INSTRUCTIONS.
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Learning about the printer

Finding information about the printer
What are you looking for? Find it here

Initial setup instructions:

• Connecting the printer

• Installing the printer software

Setup documentation—The setup documentation came
with the printer.

Additional setup and instructions for using the printer:

• Selecting and storing paper and specialty media

• Loading paper

• Configuring printer settings

• Viewing and printing documents and photos

• Setting up and using the printer software

• Configuring the printer on a network

• Caring for and maintaining the printer

• Troubleshooting and solving problems

User's Guide and Quick Reference Guide—The guides are
available on the Software and Documentation CD.

For updates, visit our Web site at
http://support.dell.com.

Instructions for:

• Connecting the printer to an Ethernet network

• Troubleshooting printer connection problems

Networking Guide—Open the Software and
Documentation CD, and then look for Printer and
Software Documentation under the Pubs folder. From
the list of publications, click the Networking Guide link.

Help using the printer software Windows or Mac Help—Open a printer software program
or application, and then click Help.

Click ?  to view context‑sensitive information.

Notes:

• Help is automatically installed with the printer
software.

• The printer software is located in the printer
program folder or on the desktop, depending on
your operating system.

The latest supplemental information, updates, and technical
support:

• Documentation

• Driver downloads

• Product upgrades

• Service call and repair information

• Order status

• Live chat support

• E‑mail support

• Voice support

Dell Support Web site—http://support.dell.com

Support telephone numbers and hours of operation for
your country or region can be found on the Support Web
site.

Have the following information ready when you contact
support so that they may serve you faster:

• service tag

• express service Code

Note: The service tag and express service code appear
on labels located on your printer.
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What are you looking for? Find it here

• Software and Drivers—Certified drivers for my printer and
installers for Dell printer software

• Readme files—Last‑minute technical changes, or advanced
technical reference materials for experienced users or
technicians

Software and Documentation CD

• Supplies and accessories for my printer

• Replacement cartridges

Dell Printer Supplies Web site–http://dell.com/supplies

You can purchase printer supplies online, by telephone,
or in select retail stores.

• Safety information for preparing to operate my printer

• Regulatory information

• Warranty information

Product Information Guide

Note: The Product Information Guide may not be
available in your country or region.

Selecting a location for the printer
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any
options, then leave enough room for them also. It is important to:

• Set up the printer near a properly grounded and easily accessible electrical outlet.

• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard or the CEN Technical Committee
156 standard.

• Provide a flat, sturdy, and stable surface.

• Keep the printer:

– Clean, dry, and free of dust.

– Away from stray staples and paper clips.

– Away from the direct airflow of air conditioners, heaters, or ventilators.

– Free from direct sunlight and humidity extremes.

• Observe the recommended temperatures and avoid fluctuations:

Ambient temperature 15.6°C – 32.2°C

Storage temperature 10°C – 43.3°C

• Allow the following recommended amount of space around the printer for proper ventilation:
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1

2

3

4

5

1 Right side 305 mm (12 in.)

2 Front 508 mm (20 in.)

3 Left side 305 mm (12 in.)

4 Rear 305 mm (12 in.)

5 Top 115 mm (4.5 in.)

Printer configurations

Basic model
1

2

4 3

1 Standard bin

2 Printer control panel

3 Multipurpose feeder

4 Standard 550‑sheet tray (Tray 1)
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Fully configured model
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity tray or more than one option. If you
purchased a printer with a similar configuration, you may need additional furniture. For more information,
contact the place where you purchased the printer.

The following illustration shows the maximum number of optional finishers and trays that are supported by the printer.
For more information on other configurations, visit our Web site.

4

1

5

3

2

6

1 High‑capacity output expander

2 Caster base

3 2100‑sheet tray

4 550‑sheet tray

5 4‑bin mailbox

6 Stapler finisher

Notes:

• When using a staple finisher and 4‑bin mailbox, the staple finisher must always be on top.

• Do not install any finisher on top of the high‑capacity output expander.

• Always use a caster base when the printer is configured with a 2100‑sheet tray.

• The 2100‑sheet tray must always be at the bottom of a configuration.

• A maximum of four optional trays may be configured with the printer.
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Using the printer control panel

1
2 3 4 5

6
78910

Use the To

1 Display • View the printer status.

• Set up and operate the printer.

2 Select button Submit changes made in the printer settings.

3 Arrow buttons Scroll up and down or left and right.

4 Keypad Enter numbers, letters, or symbols.

5 Sleep button Enable Sleep mode or Hibernate mode.

Do the following to wake the printer from Sleep mode:

• Press any hard button.

• Pull out Tray 1 or load paper in the multipurpose feeder.

• Open a door or cover.

• Send a print job from the computer.

• Perform a power‑on reset with the main power switch.

• Attach a device to the USB port on the printer.

6 Stop or Cancel button Stop all printer activity.

7 Back button Return to the previous screen.

8 Home button Go to the home screen.

9 Indicator light Check the status of the printer.

10 USB port Connect a flash drive to the printer.

Note: Only the front USB port supports flash drives.

Understanding the colors of the indicator and Sleep button
lights
The colors of the indicator and Sleep button lights on the printer control panel signify a certain printer status or condition.
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Indicator light color and its corresponding printer status

Indicator light Printer status

Off The printer is off or in Hibernate mode.

Blinking green The printer is warming up, processing data, or printing.

Solid green The printer is on, but idle.

Blinking red The printer requires user intervention.

Sleep button light color and its corresponding printer status

Sleep button light Printer status

Off The printer is idle or in Ready state.

Solid amber The printer is in Sleep mode.

Blinking amber The printer is waking from or entering Hibernate mode.

Blinking amber for 0.1 second, then goes
completely off for 1.9 seconds in pulsing
pattern

The printer is in Hibernate mode.
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Additional printer setup

Installing internal options
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and then unplug the power
cord from the electrical outlet before continuing. If you have any other devices attached to the printer, then
turn them off as well, and unplug any cables going into the printer.

Available internal options
Note: Some options are available only in select printer models. For more information, contact the place where you
purchased your printer.

• Memory card

– DDR3 DIMM

– Flash memory

• Fonts

• Firmware cards

– Forms barcode

– PRESCRIBE

– IPDS

– Printcryption

• Printer hard disk

• Internal Solutions Ports (ISP)

Accessing the controller board
Note: This task requires a flathead screwdriver.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Remove the controller board access cover.

1 2
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2 Using a screwdriver, loosen the screws on the controller board shield.

3 Remove the controller board shield.

1

2

4 Use the following illustration to locate the appropriate connector:

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer first before touching any controller board electronic component or
connector.
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1

2

3

1 Internal Solutions Port or printer hard disk connector

2 Option card connector

3 Memory card connector

5 Align the screws with the holes on the controller board shield, and then reattach the controller board shield.

1

2
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6 Tighten the screws on the controller board shield.

7 Reattach the controller board access cover.

21

Installing a memory card

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer first before touching any controller board electronic components or
connectors.
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An optional memory card can be purchased separately and attached to the controller board.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 14.

2 Unpack the memory card.

Warning—Potential Damage: Do not touch the connection points along the edge of the card. Doing so may
cause damage.

3 Align the notch (1) on the memory card with the ridge (2) on the connector.

1

2

4 Push the memory card straight into the connector, and then push the card toward the controller board wall until
it clicks into place.

5 Reattach the controller board shield, and then the controller board access cover.
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Installing an Internal Solutions Port
The controller board supports one optional Internal Solutions Port (ISP).

Note: This task requires a flathead screwdriver.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer first before touching any controller board electronic components or
connectors.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 14.

2 If an optional printer hard disk is installed, then remove the printer hard disk first.

For more information, see “Removing a printer hard disk” on page 29.

3 Unpack the ISP kit.

1

2
34

1 ISP solution

2 Screw for attaching the plastic bracket to the ISP

3 Screws for attaching the ISP mounting bracket to the controller board shield

4 Plastic bracket
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4 Remove the metal cover from the ISP opening.

a Loosen the screw.

b Lift the metal cover, and then pull it out completely.

1 2 3

5 Align the posts of the plastic bracket to the holes on the controller board cage, and then press the plastic bracket
on the controller board cage until it clicks into place.

Note: Make sure that the plastic bracket has latched completely, and that the plastic bracket is seated firmly on
the controller board cage.
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6 Install the ISP on the plastic bracket.

Note: Hold the ISP at an angle over the plastic bracket so that any overhanging connectors will pass through the
ISP opening in the controller board cage.

7 Lower the ISP toward the plastic bracket until the ISP is seated between the guides of the plastic bracket.
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8 Use the provided thumbscrew for the ISP to attach the plastic bracket to the ISP.

Note: Turn the screw clockwise, enough to hold the ISP in place, but do not tighten it yet.

9 Attach the two provided screws to secure the ISP mounting bracket to the controller board shield.

10 Tighten the thumbscrew that is attached to the ISP.

Warning—Potential Damage: Do not screw it on too tightly.
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11 Connect the ISP solution interface cable into the receptacle of the controller board.

Note: The plugs and receptacles are color-coded.

Installing an optional card
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have other devices attached to the printer, then turn them
off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or connectors.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 14.

2 Unpack the optional card.

Warning—Potential Damage: Avoid touching the connection points along the edge of the card.
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3 Holding the card by its sides, align the plastic pins (1) on the card with the holes (2) on the controller board.

1

2

4 Push the card firmly into place as shown in the illustration.

Warning—Potential Damage: Improper installation of the card may cause damage to the card and the
controller board.

Note: The entire length of the connector on the card must touch and be flushed against the controller board.

5 Close the controller board access door.

Note: When the printer software and any hardware options are installed, it may be necessary to manually add
the options in the printer driver to make them available for print jobs. For more information, see “Updating
available options in the printer driver” on page 35.
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Installing a printer hard disk
Note: This task requires a flathead screwdriver.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer first before touching any controller board electronic components or
connectors.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 14.

2 Unpack the printer hard disk.

3 Locate the appropriate connector on the controller board cage.

Note: If an optional ISP is currently installed, then the printer hard disk must be installed onto the ISP.
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To install a printer hard disk onto the ISP:

a Remove the screws attached to the printer hard disk mounting bracket, and then remove the bracket.

b Align the standoffs of the printer hard disk to the holes in the ISP, and then press the printer hard disk down
until the standoffs are in place.

Installation warning: Hold only the edges of the printed circuit board assembly. Do not touch or press on
the center of the printer hard disk. Doing so may cause damage.

c Insert the plug of the printer hard disk interface cable into the receptacle of the ISP.

Note: The plugs and receptacles are color‑coded.

Additional printer setup 26



To install a printer hard disk directly on the controller board cage:

a Align the standoffs of the printer hard disk to the holes in the controller board cage, and then press the printer
hard disk down until the standoffs are in place.

Installation warning: Hold only the edges of the printed circuit board assembly. Do not touch or press on
the center of the printer hard disk. Doing so may cause damage.
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b Use the two provided screws to attach the printer hard disk mounting bracket.

c Insert the plug of the printer hard disk interface cable into the receptacle of the controller board.

Note: The plugs and receptacles are color‑coded.
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Removing a printer hard disk
Note: This task requires a flathead screwdriver.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer first before touching any controller board electronic components or
connectors.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 14.

2 Unplug the printer hard disk interface cable from the controller board, leaving the cable attached to the printer
hard disk. To unplug the cable, squeeze the paddle at the plug of the interface cable to disengage the latch before
pulling the cable out.
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3 Remove the screws holding the printer hard disk in place.

4 Remove the printer hard disk.

5 Set aside the printer hard disk.

Installing hardware options

Order of installation

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity tray or more than one option. If you
purchased a printer with a similar configuration, you may need additional furniture. For more information,
contact the place where you purchased the printer.
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Install the printer and any hardware options you have purchased in the following order:

• Caster base

• 2100‑sheet tray or spacer

• Optional 550‑sheet tray

• Printer

For more information on installing a caster base, optional 550‑sheet tray, spacer, or 2100‑sheet tray, see the setup
sheet that came with the option.

Installing optional trays
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity tray or more than one option. If you
purchased a printer with a similar configuration, you may need additional furniture. For more information,
contact the place where you purchased the printer.

1 Turn off the printer.

2 Unpack the optional tray, and then remove all packing material.

3 Pull out the tray, and then remove any packing material from inside the tray.

4 Insert the tray.

5 Place the tray near the printer.
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6 Align the printer with the tray, and then slowly lower the printer into place.

7 Turn the printer back on.

Note: When the printer software and any optional trays are installed, you may need to manually add the
options in the printer driver to make them available for print jobs. For more information, see “Updating
available options in the printer driver” on page 35.

Attaching cables
CAUTION—POTENTIAL INJURY: Do not set up this product or make any electrical or cabling connections, such
as a power cord, a fax feature, or USB cable, during a lightning storm.

Connect the printer to the computer using a USB cable or Ethernet cable.

Make sure to match the following:

• The USB symbol on the cable with the USB symbol on the printer

• The appropriate Ethernet cable to the Ethernet port

• The appropriate parallel cable with the parallel port
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1

2

3

4
5

6

Use the To

1 Parallel port Connect the printer to a computer.

Note: This can also be used in installing an optional Internal Solutions Port (ISP).

2 USB port Attach an optional wireless network adapter.

3 Ethernet port Connect the printer to a network.

4 USB printer port Connect the printer to a computer.

5 Security slot Attach a lock that will secure the controller board.

6 Printer power cord socket Connect the printer to a properly grounded electrical outlet.

Warning—Potential Damage: Do not touch the USB cable, any wireless network adapter, or the printer in the area
shown while actively printing. Loss of data or a malfunction can occur.

Organizing the cables

Note: This feature is available only if you purchase optional trays and a caster base.

After attaching the Ethernet cable and power cord, neatly tuck the cables in the channels at the back of the printer.
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Setting up the printer software

Installing the printer software

Note: If you installed the printer software on the computer before but need to reinstall the software, then uninstall
the current software first.

For Windows users

1 Close all open software programs.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run dialog, type D:\setup.exe, where D is the letter of your CD or DVD drive.

c Press Enter, or click OK.

3 Click Install, and then follow the instructions on the computer screen.
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For Macintosh users

1 Close all open applications.

2 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

3 Double-click the software installer package, and then follow the instructions on the computer screen.

Note: To take advantage of the full features of your printer, select the custom install option, and then select all
packages listed.

Using the Internet

An updated printer software may be available at http://support.dell.com.

Updating available options in the printer driver
When the printer software and any hardware options are installed, you may need to manually add the options in the
printer driver to make them available for print jobs.

For Windows users

1 Open the printers folder.

a Click , or click Start and then click Run.

b In the Start Search or Run dialog, type control printers.

c Press Enter, or click OK.

2 Select the printer.

3 Right‑click the printer, and then select Properties.

4 Click the Configuration tab.

5 Do either of the following:

• Click Update Now ‑ Ask Printer.

• Under Configuration Options, manually add any installed hardware options.

6 Click Apply.

For Macintosh users

1 From the Apple menu, navigate to either of the following:

• System Preferences > Print & Scan > select your printer > Options & Supplies > Driver

• System Preferences > Print & Fax > select your printer > Options & Supplies > Driver

2 Add any installed hardware options, and then click OK.
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Networking
Notes:

• Purchase a wireless network adapter first before setting up the printer on a wireless network. For more
information, contact the place where you purchased the printer.

• A Service Set Identifier (SSID) is a name assigned to a wireless network. Wired Equivalent Privacy (WEP), Wi-Fi
Protected Access (WPA), WPA2, and 802.1X-RADIUS are types of security used on a network.

Preparing to set up the printer on an Ethernet network
To configure your printer to connect to an Ethernet network, organize the following information before you begin:

Note: If your network automatically assigns IP addresses to computers and printers, continue on to installing the
printer.

• A valid, unique IP address for the printer to use on the network

• The network gateway

• The network mask

• A nickname for the printer (optional)

Note: A printer nickname can make it easier for you to identify your printer on the network. You can choose to
use the default printer nickname, or assign a name that is easier for you to remember.

You will need an Ethernet cable to connect the printer to the network and an available port where the printer can
physically connect to the network. Use a new network cable when possible to avoid potential problems caused by a
damaged cable.

Installing the printer on an Ethernet network

For Windows users

1 Insert the Software and Documentation CD.

If the installation dialog does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run dialog, type D:\setup.exe, where D is the letter of the CD or DVD drive.

c Press Enter, or click OK.

2 Click Install, and then follow the instructions on the computer screen.

3 Select Ethernet connection, and then click Continue.

4 Attach the Ethernet cable when instructed to do so.

5 Select the printer from the list, and then click Continue.

Note: If the configured printer does not appear in the list, then click Modify Search.

6 Follow the instructions on the computer screen.
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For Macintosh users

1 Allow the network DHCP server to assign an IP address to the printer.

2 Obtain the printer IP address either:

• From the printer control panel

• From the TCP/IP section in the Network/Ports menu

• By printing a network setup page or menu settings page, and then finding the TCP/IP section

Note: You will need the IP address if you are configuring access for computers on a different subnet than the printer.

3 Install the printer driver on the computer.

a Insert the Software and Documentation CD, and then double‑click the installer package for the printer.

b Follow the instructions on the computer screen.

c Select a destination, and then click Continue.

d From the Easy Install screen, click Install.

e Type the user password, and then click OK.
All the necessary applications are installed on the computer.

f Click Close when installation is complete.

4 Add the printer.

• For IP printing:
a From the Apple menu, navigate to either of the following:

– System Preferences > Print & Scan

– System Preferences > Print & Fax
b Click +.
c Click the IP tab.
d Type the printer IP address in the address field, and then click Add.

• For AppleTalk printing:

Notes:

– Make sure AppleTalk is activated on your printer.

– This feature is supported only in Mac OS X version 10.5.
a From the Apple menu, navigate to:

System Preferences > Print & Fax
b Click +, and then navigate to:

AppleTalk > select your printer > Add

Preparing to set up the printer on a wireless network

Notes:

• Make sure your wireless network adapter is installed in your printer and working properly.

• Make sure your access point (wireless router) is turned on and is working properly.
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Make sure you have the following information before setting up the printer on a wireless network:

• SSID—The SSID is also referred to as the network name.

• Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc.

• Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks.

Some ad hoc networks will also require the automatic setting. Check with your system support person if you are
not sure which channel to select.

• Security Method—There are three basic options for Security Method:

– WEP key
If your network uses more than one WEP key, then enter up to four in the provided spaces. Select the key
currently in use on the network by selecting the default WEP transmit key.
or

– WPA or WPA2 preshared key or passphrase
WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must be set
for the same type on the router and on the printer, or the printer will not be able to communicate on the
network.

– 802.1X–RADIUS

If you are installing the printer on an 802.1X network, then you may need the following:

• Authentication type

• Inner authentication type

• 802.1X user name and password

• Certificates

– No security
If your wireless network does not use any type of security, then you will not have any security information.

Note: Using an unsecured wireless network is not recommended.

Notes:

– If you do not know the SSID of the network that your computer is connected to, then launch the wireless utility
of the computer network adapter, and then look for the network name. If you cannot find the SSID or the
security information for your network, then see the documentation that came with the access point, or contact
your system support person.

– To find the WPA/WPA2 preshared key/passphrase for the wireless network, see the documentation that came
with the access point, see the Web page associated with the access point, or consult your system support
person.

Connecting the printer to a wireless network using Wi-Fi Protected Setup (WPS)
Before you begin, make sure that:

• The access point (wireless router) is WPS certified.

• A wireless network adapter is installed in the printer and is working properly. For more information, see the
instruction sheet that came with the wireless network adapter.
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Using the Push Button Configuration (PBC) method

1 From the printer control panel, navigate to:

 > Settings >  >Network/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless >  >

Wi‑Fi Protected Setup >  > Start Push Button Method > 

2 Follow the instructions on the printer display.

Using the Personal Identification Number (PIN) method

1 From the printer control panel, navigate to:

 > Settings >  >Network/Ports >  > Network [x] > Wireless >  > Wi‑Fi Protected Setup >  >

Start PIN Method > 

2 Copy the eight‑digit WPS PIN.

3 Open a Web browser, and then type the IP address of your access point in the address bar.

Notes:

• The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

4 Access the WPS settings.

5 Enter the eight‑digit PIN, and then save the setting.

Connecting the printer to a wireless network using the Embedded Web Server
Before you begin, make sure that:

• Your printer is connected temporarily to an Ethernet network.

• A wireless network adapter is installed in your printer and working properly. For more information, see the
instruction sheet that came with your wireless network adapter.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Network/Ports > Wireless.

3 Modify the settings to match the settings of your access point (wireless router).

Note: Make sure to enter the correct SSID.

4 Click Submit.
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5 Turn off the printer, and then disconnect the Ethernet cable. Then wait for at least five seconds, and then turn the
printer back on.

6 To verify if your printer is connected to the network, print a network setup page. Then in the Network Card [x]
section, see if the status is “Connected”.

For more information, see the “Verifying printer setup” section of the User’s Guide.

Changing port settings after installing a new network Internal Solutions Port
When a new Internal Solutions Port (ISP) is installed in the printer, the printer configurations on computers that access
the printer must be updated since the printer will be assigned a new IP address. All computers that access the printer
must be updated with this new IP address.

Notes:

• If the printer has a static IP address, then you do not need to make any changes to the computer configurations.

• If the computers are configured to use the network name, instead of an IP address, then you do not need to
make any changes to your computer configurations.

• If you are adding a wireless ISP to a printer previously configured for an Ethernet connection, then make sure
the printer is disconnected from the Ethernet network when you configure the printer to operate wirelessly. If
the printer is not disconnected from the Ethernet network, then the wireless configuration will complete, but
the wireless ISP will not be active. To activate the wireless ISP, disconnect the printer from the Ethernet
network, turn off the printer, and then turn it back on.

• Only one network connection is active at a time. To switch between Ethernet and wireless connection types,
turn off the printer, connect the cable (to switch to an Ethernet connection) or disconnect the cable (to switch
to a wireless connection), and then turn the printer back on.

For Windows users

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address on the printer control panel. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click , or click Start and then click Run.

3 In the Start Search or Run dialog, type control printers.

4 Press Enter, or click OK.

5 Locate the printer that has changed.

Note: If there is more than one copy of the printer, then update all of them with the new IP address.

6 Right‑click the printer.

7 Click Properties > Ports tab.

8 Select the port from the list, and then click Configure Port.

9 Type the new IP address in the “Printer Name or IP Address” field.

10 Click OK > Close.
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For Macintosh users

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address on the printer control panel. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Add the printer.

• For IP printing:
a From the Apple menu, navigate to either of the following:

– System Preferences > Print & Scan

– System Preferences > Print & Fax
b Click +.
c Click the IP tab.
d Type the printer IP address in the address field, and then click Add.

• For AppleTalk printing:

Notes:

– Make sure AppleTalk is activated on your printer.

– This feature is supported only in Mac OS X version 10.5.
a From the Apple menu, navigate to:

System Preferences > Print & Fax
b Click +, and then navigate to:

AppleTalk > select the printer > Add

Setting up serial printing
Use serial printing to print even when the computer is far from the printer, or to print at a reduced speed.

After installing the serial or communication (COM) port, configure the printer and the computer. Make sure you have
connected the serial cable to the COM port on your printer.

1 Set the parameters in the printer.

a From the printer control panel, navigate to the menu for the port settings.

b Locate the menu for the serial port settings, and then adjust the settings, if necessary.

c Save the modified settings, and then print a menu settings page.

2 Install the printer driver.

a Insert the Software and Documentation CD.
If the installation dialog does not appear after a minute, then launch the CD manually:

1 Click , or click Start and then click Run.
2 In the Start Search or Run dialog, type D:\setup.exe, where D is the letter of the CD or DVD drive.
3 Press Enter, or click OK.

b Click Install.

c Follow the instructions on the computer screen.
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d Select Advanced, and then click Continue.

e From the Configure Printer Connection dialog, select a port.

f If the port is not in the list, then click Refresh, or navigate to:
Add port > select a port type > enter the necessary information > OK

g Click Continue > Finish.

3 Set the COM port parameters.

After installing the printer driver, set the serial parameters in the COM port assigned to the printer driver.

Note: Make sure the serial parameters in the COM port match the serial parameters you set in the printer.

a Open Device Manager.

1 Click , or click Start and then click Run.
2 In the Start Search or Run dialog, type devmgmt.msc.
3 Press Enter, or click OK.

b Click + beside “Ports” to expand the list of available ports.

c Right‑click the COM port where you attached the serial cable to your computer (example: COM1), and then
click Properties.

d On the Port Settings tab, set the serial parameters to the same serial parameters set in the printer.
Check the serial heading of the menu settings page for the printer settings.

e Click OK, and then close all the dialogs.

f Print a test page to verify printer installation.

Verifying printer setup

Printing a menu settings page
Print a menu settings page to review the current menu settings and to verify if the printer options are installed correctly.

Note: If you have not changed any menu settings, then the menu settings page lists all the factory default settings.
When you select and save other settings from the menus, they replace the factory default settings as user default
settings. A user default setting remains in effect until you access the menu again, choose another value, and save it.

From the printer control panel, navigate to:

 > Settings >  >Reports >  > Menu Settings Page > 
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Printing a network setup page
If the printer is attached to a network, then print a network setup page to verify the network connection. This page
also provides important information that aids network printing configuration.

1 From the printer control panel, navigate to:

 > Settings >  > Reports >  > Network Setup Page > 

2 Check the first section of the network setup page, and then confirm that the status is Connected.

If the status is Not Connected, then the LAN drop may not be active, or the network cable may be malfunctioning.
Consult your system support person for a solution, and then print another network setup page.
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Loading paper and specialty media
The selection and handling of paper and specialty media can affect how reliably documents print. For more information,
see “Avoiding jams” on page 152 and “Storing paper” on page 67.

Setting the paper size and type
1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Paper Size/Type > 

2 Press the up or down arrow button to select the tray or feeder, and then press .

3 Press the up or down arrow button to select the paper size, and then press .

4 Press the up or down arrow button to select the paper type, and then press  to change the settings.

Configuring Universal paper settings
The Universal paper size is a user‑defined setting that lets you print on paper sizes that are not preset in the printer
menus.

Notes:

• The smallest supported Universal size is 70 x 127 mm (2.76 x 5 inches) for one‑sided printing and
105 x 148 mm (4.13 x 5.83 inches) for two‑sided (duplex) printing.

• The largest supported Universal size is 216 x 356 mm (8.5 x 14 inches) for one‑sided and two‑sided printing.

From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Universal Setup >  > Units of Measure >  > select unit of

measure > 

Loading the 550‑sheet tray
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

1 Pull out the tray.

Notes:

• When loading folio‑, legal‑, or oficio‑size paper, lift the tray slightly and pull it out completely.

• Avoid removing trays while a job prints or while Busy appears on the display. Doing so may cause a jam.
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2 Squeeze and slide the width guide to the correct position for the size of the paper being loaded until it clicks into
place.

1

2

Note: Use the paper size indicators on the bottom of the tray to help position the guides.
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3 Unlock the length guide, and then squeeze and slide the guide to the correct position for the size of the paper being
loaded.

3

1 2

Notes:

• Lock the length guide for all paper sizes.

• Use the paper size indicators on the bottom of the tray to help position the guides.
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4 Flex and fan the sheets to loosen them. Do not fold or crease the paper. Straighten the edges on a level surface.

5 Load the paper stack with the printable side facedown.

Note: Make sure the paper or envelope is loaded properly.

• There are different ways for loading letterhead depending on whether an optional staple finisher is installed or
not.

Without an optional staple finisher With an optional staple finisher

One‑sided printing One‑sided printing
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Without an optional staple finisher With an optional staple finisher

Two‑sided printing Two‑sided printing

• Do not slide the paper into the tray. Load paper as shown in the illustration.

• If you are loading envelopes, then make sure that the flap side is facing up and the envelopes are on the left
side of the tray.
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• Make sure the paper is below the maximum paper fill indicator.

Warning—Potential Damage: Overfilling the tray can cause paper jams.

6 For custom‑ or Universal‑size paper, adjust the paper guides to lightly touch the sides of the stack, and then lock
the length guide.

7 Insert the tray.

8 From the printer control panel, set the paper size and type in the Paper menu to match the paper loaded in the
tray.

Note: Set the correct paper size and type to avoid paper jams and print quality problems.

Loading the 2100‑sheet tray
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

1 Pull out the tray.

2 Adjust the width and length guides.
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Loading A5‑size paper
a Pull up and slide the width guide to the position for A5.

2

LGL
OFC

FOLIO

LTR

1

b Squeeze and slide the length guide to the position for A5 until it clicks into place.

1 2
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c Remove the A5 length guide from its holder.

1 2

d Insert the A5 length guide into its designated slot.

Note: Press the A5 length guide until it clicks into place.

Loading A4‑, letter‑, legal‑, oficio‑, and folio‑size paper
a Pull up and slide the width guide to the correct position for the size of the paper being loaded.

2

LGL
OFC

FOLIO

LTR

1
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b If the A5 length guide is still attached to the length guide, then remove it from its place. If the A5 length guide
is not attached, then proceed to step d.

c Put the A5 length guide in its holder.

1 2
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d Squeeze the length guide and slide it to the correct position for the size of the paper being loaded until it clicks
into place.

3 Flex and fan the sheets to loosen them. Do not fold or crease the paper. Straighten the edges on a level surface.

4 Load the paper stack with the printable side facedown.

Note: Make sure the paper is loaded properly.

• There are different ways for loading letterhead depending on whether an optional staple finisher is installed or
not.
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Without an optional staple finisher With an optional staple finisher

ABC

One‑sided printing

ABC

One‑sided printing

ABC

Two‑sided printing

ABC

Two‑sided printing
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• Make sure the paper is below the maximum paper fill indicator.

Warning—Potential Damage: Overfilling the tray can cause paper jams.

5 Insert the tray.

Note: Press the paper stack down while inserting the tray.
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6 From the printer control panel, set the size and type in the Paper menu to match the paper loaded in the tray.

Note: Set the correct paper size and type to avoid paper jams and print quality problems.

Loading the multipurpose feeder
1 Pull down the multipurpose feeder door.

Note: Do not load or close the multipurpose feeder while a job is printing.
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2 Pull the multipurpose feeder extender.

Note: Guide the extender gently so that the multipurpose feeder is fully extended and open.

3 Slide the width guide to the correct position for the size of the paper being loaded.

Note: Use the paper size indicators on the bottom of the tray to help position the guides.

4 Prepare the paper or specialty media for loading.

• Flex and fan the sheets to loosen them. Do not fold or crease the paper. Straighten the edges on a level surface.
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• Hold transparencies by the edges. Flex and fan the transparencies to loosen them. Straighten the edges on a
level surface.

Note: Avoid touching the printable side of the transparencies. Be careful not to scratch them.

• Flex and fan the stack of envelopes to loosen them. Straighten the edges on a level surface.

5 Load the paper or specialty media.

Note:  Slide the stack gently into the multipurpose feeder until it comes to a stop.

• Load only one size and type of paper or specialty media at a time.

• Make sure the paper fits loosely in the multipurpose feeder, lies flat, and is not bent or wrinkled.

• There are different ways of loading letterhead depending on whether an optional staple finisher is installed or
not.

Without an optional staple finisher With an optional staple finisher

One‑sided printing One‑sided printing

Two‑sided printing Two‑sided printing
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• Load envelopes with the flap side down and on the left of the multipurpose feeder.

Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, coated linings, or
self‑stick adhesives. These envelopes may severely damage the printer.

• Make sure the paper or specialty media is below the maximum paper fill indicator.

Warning—Potential Damage: Overfilling the feeder can cause paper jams.

6 For custom- or Universal-size paper, adjust the width guides to lightly touch the sides of the stack.

7 From the printer control panel, set the paper size and type in the Paper menu to match the paper loaded in the
tray.

Note: Set the correct paper size and type to avoid paper jams and print quality problems.
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Linking and unlinking trays

Linking and unlinking trays
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address on the printer control panel in the TCP/IP section under the Network/Ports
menu. The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu.

3 Change the paper size and type settings for the trays you are linking.

• To link trays, make sure the paper size and type for the tray match that of the other tray.

• To unlink trays, make sure the paper size or type for the tray does not match that of the other tray.

4 Click Submit.

Note: You can also change the paper size and type settings using the printer control panel. For more information,
see “Setting the paper size and type” on page 44.

Warning—Potential Damage: Paper loaded in the tray should match the paper type name assigned in the printer.
The temperature of the fuser varies according to the specified paper type. Printing issues may occur if settings are
not properly configured.

Creating a custom name for a paper type

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Names.

3 Select a custom name, and then type a new custom paper type name.

4 Click Submit.

5 Click Custom Types, and then verify if the new custom paper type name has replaced the custom name.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Names

2 Select a custom name, and then type a new custom paper type name.
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3 Press .

4 Press Custom Types, and then verify if the new custom paper type name has replaced the custom name.

Assigning a custom paper type name

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Names.

3 Type a name for the paper type, and then click Submit.

4 Select a custom type, and then verify that the correct paper type is associated with the custom name.

Note: Plain Paper is the factory default paper type for all user‑defined custom names.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Names

2 Type a name for the paper type, and then press .

Assigning a custom paper type

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Types.

3 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user‑defined custom names.

4 Click Submit.
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Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Types

2 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user‑defined custom names.

3 Press .
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Paper and specialty media guide
Notes:

• Make sure the paper size, type, and weight are set correctly on the computer or printer control panel.

• Flex, fan and straighten specialty media before loading it.

• The printer may print at a reduced speed to prevent damage to the fuser.

Using specialty media

Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly affect print quality.

• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the card
stock loaded in the tray.

• Print samples on the card stock being considered for use before buying large quantities.

• Specify the paper texture and weight from the tray settings to match the paper loaded in the tray.

• Preprinting, perforation, and creasing may significantly affect the print quality and cause jams or other paper feed
problems.

• Before loading the card stock on the tray, flex and fan the card stock to loosen them. Straighten the edges on a
level surface.

Tips on using envelopes
• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the

envelopes loaded in the tray.

• Print samples on the envelopes being considered for use before buying large quantities.

• Use envelopes designed specifically for laser printers.

• For best performance, use envelopes made from 90‑g/m2 (24‑lb) paper or 25% cotton.

• Use only new envelopes from undamaged packages.

• To optimize performance and minimize jams, do not use envelopes that:

– Have excessive curl or twist.

– Are stuck together or damaged in any way.

– Have windows, holes, perforations, cutouts, or embossing.

– Have metal clasps, string ties, or folding bars.

– Have an interlocking design.

– Have postage stamps attached.

– Have any exposed adhesive when the flap is in the sealed or closed position.

– Have bent corners.

– Have rough, cockle, or laid finishes.
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• Adjust the width guides to fit the width of the envelopes.

• Before loading the envelopes on the tray, flex and fan the envelopes to loosen them. Straighten the edges on a
level surface.

Note: A combination of high humidity (over 60%) and high printing temperature may wrinkle or seal envelopes.

Tips on using labels
• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the labels

loaded in the tray.

• Print samples on labels being considered for use before buying large quantities.

• Use labels designed specifically for laser printers.

• Do not use labels with slick backing material.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and toner cartridge
warranties.

• Do not use labels with exposed adhesive.

• Before loading labels on the tray, flex and fan labels to loosen them. Straighten the edges on a level surface.

Tips on using transparencies
• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the

transparencies loaded in the tray.

• Print a test page on the transparencies being considered for use before buying large quantities.

• Use transparencies designed specifically for laser printers.

• Avoid getting fingerprints on the transparencies to prevent print quality problems.

• Before loading transparencies, flex and fan the sheets to prevent them from sticking together.

Paper guidelines

Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these factors before printing on them:

Weight

The printer trays and multipurpose feeder can automatically feed paper weights between 60–176 g/m2 (16–47‑lb) grain
long paper. The 2100‑sheet tray can automatically feed paper weights up to 60–135 g/m2 (16–36‑lb) grain long paper.
Paper lighter than 60 g/m2 (16 lb) might not be stiff enough to feed properly, and may cause jams.

Note: Two‑sided printing is supported for 60–176 g/m2 (16–47‑lb) paper.
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Curl

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after
the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid,
cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding
problems.

Smoothness

Paper smoothness directly affects print quality. If paper is too rough, toner cannot fuse to it properly. If paper is too
smooth, it can cause paper feeding or print quality issues. Always use paper between 100 and 300 Sheffield points;
smoothness between 150 and 250 Sheffield points produces the best print quality.

Moisture content

The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.

Store paper in its original wrapper in the same environment as the printer for 24 to 48 hours before printing. Extend
the time several days if the storage or transportation environment is very different from the printer environment. Thick
paper may also require a longer conditioning period.

Grain direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.

For 60–176 g/m2 (16–47‑lb) paper, grain long paper is recommended.

Fiber content

Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability, resulting in fewer paper feeding problems and better print quality. Paper containing
fibers such as cotton can negatively affect paper handling.

Selecting paper
Using the appropriate paper prevents jams and helps ensure trouble‑free printing.

To help avoid paper jams and poor print quality:

• Always use new, undamaged paper.

• Before loading paper, know the recommended printable side of the paper. This information is usually indicated on
the paper package.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, types, or weights in the same tray; mixing results in jams.

• Do not use coated papers unless they are specifically designed for electrophotographic printing.
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Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60–90‑g/m2 (16–24‑lb) paper.

• Use only forms and letterhead printed using an offset lithographic or engraved printing process.

• Avoid paper with rough or heavily textured surfaces.

Use inks that are not affected by the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these
requirements; latex inks might not.

When in doubt, contact your paper supplier.

Using recycled paper and other office papers
As an environmentally conscientious company, we support the use of recycled paper produced specifically for use in
laser (electrophotographic) printers.

While no blanket statement can be made that all recycled paper will feed well, we consistently test papers that represent
recycled cut size copier papers available on the global market. This scientific testing is conducted with rigor and
discipline. Many factors are taken into consideration both separately and as a whole, including the following:

• Amount of post-consumer waste (We test up to 100% post-consumer waste content.)

• Temperature and humidity conditions (Testing chambers simulate climates from all over the world.)

• Moisture content (Business papers should have low moisture: 4–5%.)

• Bending resistance and proper stiffness means optimum feeding through the printer.

• Thickness (impacts how much can be loaded into a tray)

• Surface roughness (measured in Sheffield units, impacts print clarity and how well toner fuses to the paper)

• Surface friction (determines how easily sheets can be separated)

• Grain and formation (impacts curling, which also influences the mechanics of how the paper behaves as it moves
through the printer)

• Brightness and texture (look and feel)

Recycled papers are better than ever; however, the amount of recycled content in a paper affects the degree of control
over foreign matter. And while recycled papers are one good path to printing in an environmentally responsible manner,
they are not perfect. The energy required to de-ink and deal with additives such as colorants and “glue” often generates
more carbon emissions than does normal paper production. However, using recycled papers enables better resource
management overall.

We concern ourselves with the responsible use of paper in general based on life cycle assessments of its products. To
gain a better understanding of the impact of printers on the environment, the company commissioned a number of
life cycle assessments and found that paper was identified as the primary contributor (up to 80%) of carbon emissions
caused throughout the entire life of a device (from design to end-of-life). This is due to the energy-intensive
manufacturing processes required to make paper.

Thus, we seek to educate customers and partners on minimizing the impact of paper. Using recycled paper is one way.
Eliminating excessive and unnecessary paper consumption is another. We are well-equipped to help customers
minimize printing and copying waste. In addition, the company encourages purchasing paper from suppliers who
demonstrate their commitment to sustainable forestry practices.

We do not endorse specific suppliers, although a converter’s product list for special applications is maintained. However,
the following paper choice guidelines will help alleviate the environmental impact of printing:

1 Minimize paper consumption.
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2 Be selective about the origin of wood fiber. Buy from suppliers who carry certifications such as the Forestry
Stewardship Council (FSC) or The Program for the Endorsement of Forest Certification (PEFC). These certifications
guarantee that the paper manufacturer uses wood pulp from forestry operators that employ environmentally and
socially responsible forest management and restoration practices.

3 Choose the most appropriate paper for printing needs: normal 75 or 80 g/m2 certified paper, lower weight paper,
or recycled paper.

Unacceptable paper examples

Test results indicate that the following paper types are at risk for use with laser printers:

• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers

• Preprinted papers with chemicals that may contaminate the printer

• Preprinted papers that can be affected by the temperature in the printer fuser

• Preprinted papers that require a registration (the precise location on the page) greater than ± 2.3 mm (± 0.9 in.),
such as optical character recognition (OCR) forms. In some cases, registration can be adjusted with a software
application to successfully print on these forms.)

• Coated papers (erasable bond), synthetic papers, thermal papers

• Rough-edged, rough or heavily textured surface papers or curled papers

• Recycled papers that fail EN12281:2002 (European testing)

• Paper weighing less than 60 g/m2 (16 lb)

• Multiple part forms or documents

Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40 percent. Most
label manufacturers recommend printing in a temperature range of 18–24°C (65–75°F) with relative humidity
between 40 and 60 percent.

• Store paper in cartons, on a pallet or shelf, rather than on the floor.

• Store individual packages on a flat surface.

• Do not store anything on top of individual paper packages.

• Take paper out of the carton or wrapper only when you are ready to load it in the printer. The carton and wrapper
help keep the paper clean, dry, and flat.

Supported paper sizes, types, and weights
The following tables provide information on standard and optional paper sources and the types of paper they support.

Note: For an unlisted paper size, select the closest larger listed size.

Paper types and weights supported by the printer

The printer engine supports 60–176‑g/m2 (16–47‑lb) paper weights.
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Paper type 550‑sheet tray 2100‑sheet tray Multipurpose feeder Duplex

Paper

Card stock X

Plain Envelope X X

Rough Envelope X X

Paper and Vinyl Labels X X

Pharmacy labels X

Transparencies X X

Paper sizes supported by the printer

Paper size1 Dimensions Standard or
optional
550‑sheet tray

Optional
2100‑sheet tray

Multipurpose
feeder

Duplex

A4 210 x 297 mm
(8.3 x 11.7 in.)

A5 148 x 210 mm
(5.8 x 8.3 in.)

A6 105 x 148 mm
(4.1 x 5.8 in.)

X

JIS B5 182 x 257 mm
(7.2 x 10.1 in.)

X

Letter 216 x 279 mm
(8.5 x 11 in.)

Legal 216 x 356 mm
(8.5 x 14 in.)

Executive 184 x 267 mm
(7.3 x 10.5 in.)

X

Oficio 216 x 340 mm
(8.5 x 13.4 in.)

Folio 216 x 330 mm
(8.5 x 13 in.)

Statement 140 x 216 mm
(5.5 x 8.5 in.)

X

1 If your preferred default paper size cannot be set in the printer control panel, then you may select common paper sizes
that correspond to the position of the length guide in the tray from the Paper Size/Type menu. If the paper size is not
available, then select Universal or turn off tray size sensing. For more information, contact technical support.
2 To support two‑sided (duplex) printing, the Universal width must be between 105 mm (4.13 inches) and 216 mm
(8.5 inches); the Universal length must be between 148 mm (5.83 inches) and 356 mm (14 inches).
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Paper size1 Dimensions Standard or
optional
550‑sheet tray

Optional
2100‑sheet tray

Multipurpose
feeder

Duplex

Universal2 105  x  148 mm to
216  x 356 mm
(4.13 x  5.83 in. to
8.5 x 14 in.)

X

70 x 127 mm to
216 x 356 mm
(2.76 x 5  to
8.5 x 14 in.)

X X X

7 3/4 Envelope
(Monarch)

98 x 191 mm
(3.9 x 7.5 in.)

X X

9 Envelope 98 x 225 mm
(3.9 x 8.9 in.)

X X

10 Envelope 105 x 241 mm
(4.1 x 9.5 in.)

X X

DL Envelope 110 x 220 mm
(4.3 x 8.7 in.)

X X

C5 Envelope 162 x 229 mm
(6.38 x 9.01 in.)

X X

B5 Envelope 176 x 250 mm
(6.93 x 9.84 in.)

X X

Other Envelope 98 x 162 mm
(3.9 x 6.4 in.) to
176 x 250 mm
(6.9 x 9.8 in.)

X X

1 If your preferred default paper size cannot be set in the printer control panel, then you may select common paper sizes
that correspond to the position of the length guide in the tray from the Paper Size/Type menu. If the paper size is not
available, then select Universal or turn off tray size sensing. For more information, contact technical support.
2 To support two‑sided (duplex) printing, the Universal width must be between 105 mm (4.13 inches) and 216 mm
(8.5 inches); the Universal length must be between 148 mm (5.83 inches) and 356 mm (14 inches).

Paper sizes, types, and weights supported by the finishers

Supported paper sizes

Paper size 4‑bin mailbox High‑capacity output
expander

Staple finisher Staple, hole punch
finisher

A6 X X

A5 2 1

1 The finisher stacks the paper but does not staple or punch holes in it.
2 The finisher staples the paper if it is loaded short edge first.
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Paper size 4‑bin mailbox High‑capacity output
expander

Staple finisher Staple, hole punch
finisher

JIS B5 1 1

Executive 1 1

Letter

A4

Legal 1

Folio 1

Statement 1 1

Universal X X

Envelopes X X X

1 The finisher stacks the paper but does not staple or punch holes in it.
2 The finisher staples the paper if it is loaded short edge first.

Supported paper types and weights

Paper type Paper weight 4‑bin mailbox High‑capacity
output expander

Staple finisher Staple, hole punch
finisher

Plain Paper 90–176 g/m2

(24–47 lb)
X X X

60–90 g/m2

(16–24 lb)

Card Stock 163 g/m2

(110 Ib)
X  *  *

Transparency 146 g/m2

(39 Ib)
X  *  *

Recycled 90–176 g/m2

(24–47 lb)
X X X

60–90 g/m2

(16–24 lb)

Paper labels 180 g/m2

(48 Ib)
X X X

Vinyl Labels 300 g/m2

(92 Ib)
X X X

Dual web and
Integrated

180 g/m2

(48 Ib)
X X X

* The finisher stacks the paper but does not staple or punch holes in it.

Paper and specialty media guide 70



Paper type Paper weight 4‑bin mailbox High‑capacity
output expander

Staple finisher Staple, hole punch
finisher

Polyester 220 g/m2

(59 Ib)
X X X

Bond 90–176 g/m2

(24–47 lb)
X X X

60–90 g/m2

(16–24 lb)

Envelope 105 g/m2

(28 Ib)
X X X

Letterhead 90–176 g/m2

(24–47 lb)
X X X

60–90 g/m2

(16–24 lb)

Preprinted 90–176 g/m2

(24–47 lb)
X X X

60–90 g/m2

(16–24 lb)

Colored Paper 90–176 g/m2

(24–47 lb)
X X X

60–90 g/m2

(16–24 lb)

* The finisher stacks the paper but does not staple or punch holes in it.
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Printing

Printing a document

Printing a document
1 From the Paper menu on the printer control panel, set the paper type and size to match the paper loaded.

2 Send the print job:

For Windows users

a With a document open, click File > Print.

b Click Properties, Preferences, Options, or Setup.

c Adjust the settings, if necessary.

d Click OK > Print.

For Macintosh users

a Customize the settings in the Page Setup dialog if necessary:
1 With a document open, choose File > Page Setup.
2 Choose a paper size or create a custom size to match the paper loaded.
3 Click OK.

b Customize the settings in the Page Setup dialog if necessary:
1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.
2 From the Print dialog and pop‑up menus adjust the settings if necessary.

Note: To print on a specific paper type, adjust the paper type setting to match the paper loaded, or
select the appropriate tray or feeder.

3 Click Print.

Adjusting toner darkness

Using the Embedded Web Server

1 Open a Web browser, and then type the IP address of the printer in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Quality Menu > Toner Darkness.

3 Adjust the toner darkness, and then click Submit.
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Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Print Settings >  > Quality Menu >  > Toner Darkness

2 Adjust the toner darkness, and then press .

Printing from a flash drive

Supported flash drives and file types

Notes:

• High‑speed USB flash drives must support the full‑speed standard. Low-speed USB devices are not supported.

• USB flash drives must support the File Allocation Table (FAT) system. Devices formatted with New Technology
File System (NTFS) or any other file system are not supported.

Recommended flash drives File type

Many flash drives are tested and approved for use with the printer. For more information, visit
http://support.dell.com.

Documents:

• .pdf

• .xps

Images:

• .dcx

• .gif

• .jpeg or .jpg

• .bmp

• .pcx

• .tiff or .tif

• .png

• .fls
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Printing from a flash drive

Notes:

• Before printing an encrypted PDF file, you will be prompted to enter the file password from the printer control
panel.

• You cannot print files for which you do not have printing permissions.

1 Insert a flash drive into the USB port.

Notes:

• A flash drive icon appears on the printer control panel and in the held jobs icon when a flash drive is
installed.

• If you insert the flash drive when the printer requires attention, such as when a jam has occurred, then the
printer ignores the flash drive.

• If you insert the flash drive while the printer is processing other print jobs, then Busy appears. After these
print jobs are processed, you may need to view the held jobs list to print documents from the flash drive.

Warning—Potential Damage: Do not touch the printer or the flash drive in the area shown while actively
printing, reading, or writing from the memory device. Loss of data can occur.
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2 From the printer control panel, select the document you want to print.

3 Press the left or right arrow button to specify the number of copies for printing, and then press .

Notes:

• Do not remove the flash drive from the USB port until the document has finished printing.

• If you leave the flash drive in the printer after leaving the initial USB menu screen, then access held jobs
from the printer control panel to print files from the flash drive.

Printing confidential and other held jobs

Storing print jobs in the printer
1 From the printer control panel, navigate to:

 > Settings >  > Security >  > Confidential Print > select the print job type

Print job type Description

Max Invalid PIN Limits the number of times an invalid PIN can be entered.

Note: When the limit is reached, the print jobs for that user name and PIN are
deleted.

Confidential Job Expiration Lets you hold print jobs in the computer until you enter the PIN from the printer
control panel.

Note: The PIN is set from the computer. It must be four digits, using the
numbers 0–9.

Repeat Job Expiration Lets you print and store print jobs in the printer memory for reprinting.

Verify Job Expiration Lets you print one copy of a print job while the printer holds the remaining
copies. It allows you to examine if the first copy is satisfactory. The print job is
automatically deleted from the printer memory once all copies are printed.

Reserve Job Expiration Lets you store print jobs for printing at a later time. The print jobs are held until
deleted from the Held Jobs menu.

Notes:

• Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to
process additional held jobs.

• You can set the printer to store print jobs in the printer memory until you start the print job from the printer
control panel.

• All print jobs that can be initiated by the user at the printer are called held jobs.

2 Press .
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Printing confidential and other held jobs
Note: Confidential and Verify print jobs are automatically deleted from memory after printing. Repeat and Reserve
jobs are held in the printer until you choose to delete them.

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Click Print and Hold.

4 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four‑digit PIN.

5 Click OK or Print.

6 From the printer control panel, release the print job.

• For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > select the print job > specify the number
of copies > Print

• For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print

For Macintosh users

1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.

2 From the print options or Copies & Pages pop‑up menu, choose Job Routing.

3 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four‑digit PIN.

4 Click OK or Print.

5 From the printer control panel, release the print job:

• For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > select the print job > specify the number
of copies > Print

• For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print
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Printing information pages
For more information on printing information pages, see “Printing a menu settings page” on page 42 and “Printing a
network setup page” on page 43.

Printing a font sample list
1 From the printer control panel, navigate to:

 > Settings >  > Reports >  > Print Fonts

2 Press the up or down arrow button to select the font setting.

3 Press .

Note: The PPDS fonts appear only when the PPDS data stream is activated.

Printing a directory list
From the printer control panel, navigate to:

 > Settings > Reports >  > Print Directory > 

Note: The Print Directory menu item appears only when an optional flash memory or printer hard disk is installed.

Canceling a print job

Canceling a print job from the printer control panel

From the printer control panel, press  > .

Canceling a print job from the computer

For Windows users

1 Open the printers folder.

a Click , or click Start and then click Run.

b In the Start Search or Run dialog, type control printers.

c Press Enter, or click OK.

2 Double‑click the printer icon.

3 Select the print job you want to cancel.

4 Click Delete.
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For Macintosh users

1 From the Apple Menu, navigate to either of the following:

• System Preferences > Print & Scan > select a printer > Open Print Queue

• System Preferences > Print & Fax > select a printer > Open Print Queue

2 From the printer window, select the print job you want to cancel, and then click Delete.
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Understanding printer menus

Menus list
Paper Menu Reports Network/Ports

Default Source

Paper Size/Type

Configure MP

Substitute Size

Paper Texture

Paper Weight

Paper Loading

Custom Types

Universal Setup

Bin Setup

Menu Settings Page

Device Statistics

Stapler Test

Network Setup Page 1

Profiles List

Print Fonts

Print Directory

Asset Report

Active NIC

Standard Network 2

Standard USB

Parallel [x]

Serial [x]

SMTP Setup

Security Settings Help

Miscellaneous Security Settings 3

Confidential Print

Security Audit Log

Set Date and Time

General Settings

Flash Drive Menu

Print Settings

Print All Guides

Print Quality

Printing Guide

Print Defects Guide

Information Guide

1 Depending on the printer setup, this menu item appears as Network Setup Page or Network [x] Setup Page.
2 Depending on the printer setup, this menu item appears as Standard Network or Network [x].

Paper menu

Default Source menu

Use To

Default Source
Tray [x]
MP Feeder
Manual Paper
Manual Envelope

Set a default paper source for all print jobs.

Notes:

• Tray 1 (standard tray) is the factory default setting.

• From the Paper menu, set Configure MP to "Cassette" for MP Feeder to
appear as a menu setting.

• If two trays contain paper of the same size and type, and the trays have
the same settings, then the trays are automatically linked. When one tray
is empty, the print job continues using the linked tray.

Understanding printer menus 79



Paper Size/Type menu

Use To

Tray [x] Size
A4
A5
A6
JIS‑B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the paper size loaded in each tray.

Notes:

• Letter is the US factory default setting. A4 is the international factory
default setting.

• If two trays contain paper of the same size and type, and the trays have
the same settings, then the trays are automatically linked. The
multipurpose feeder may also be linked. When one tray is empty, the
print job continues using the linked tray.

• The A6 paper size is supported only in Tray 1 and the multipurpose
feeder.

Tray [x] Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Vinyl Labels
Bond
Envelope
Rough Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of paper loaded in each tray.

Notes:

• Plain Paper is the factory default setting for Tray 1. Custom Type [x] is
the factory default setting for all other trays.

• If available, a user‑defined name will appear instead of Custom Type [x].

• Use this menu to configure automatic tray linking.

Note: Only installed trays and feeders are listed in this menu.
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Use To

MP Feeder Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the paper size loaded in the multipurpose feeder.

Notes:

• Letter is the US factory default setting. A4 is the international factory
default setting.

• From the Paper menu, set Configure MP to “Cassette” for MP Feeder
Size to appear as a menu.

• The multipurpose feeder does not automatically detect paper size.
Make sure to set the paper size value.

MP Feeder Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Vinyl Labels
Bond
Envelope
Rough Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the paper type loaded in the multipurpose feeder.

Notes:

• Plain Paper is the factory default setting.

• From the Paper menu, set Configure to “Cassette” for MP Feeder Type
to appear as a menu.

Note: Only installed trays and feeders are listed in this menu.
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Use To

Manual Paper Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

Specify the size of the paper being manually loaded.

Note: Letter is the US factory default setting. A4 is the international factory
default setting.

Manual Paper Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Vinyl Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the paper type being manually loaded.

Notes:

• Plain Paper is the factory default setting.

• From the Paper menu, set Configure MP to “Manual” for Manual Paper
Type to appear as a menu.

Manual Envelope Size
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the envelope size being manually loaded.

Note: 10 Envelope is the US factory default setting. DL Envelope is the
international factory default setting.

Manual Envelope Type
Envelope
Rough Envelope
Custom Type [x]

Specify the envelope type being manually loaded.

Note: Envelope is the factory default setting.

Note: Only installed trays and feeders are listed in this menu.
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Configure MP menu

Use To

Configure MP
Cassette
Manual
First

Determine when the printer selects paper from the multipurpose feeder.

Notes:

• Cassette is the factory default setting. Cassette configures the
multipurpose feeder as the automatic paper source.

• Manual sets the multipurpose feeder only for manual‑feed print jobs.

• First configures the multipurpose feeder as the primary paper source.

Substitute Size menu

Use To

Substitute Size
Off
Statement/A5
Letter/A4
All Listed

Substitute a specified paper size if the requested paper size is not available.

Notes:

• All Listed is the factory default setting. All available substitutions are
allowed.

• Off indicates that no size substitutions are allowed.

• Setting a size substitution lets the print job continue without Change
Paper appearing.

Paper Texture menu

Use To

Plain Texture
Smooth
Normal
Rough

Specify the relative texture of the plain paper loaded in a specific tray.

Note: Normal is the factory default setting.

Card Stock Texture
Smooth
Normal
Rough

Specify the relative texture of the card stock loaded in a specific tray.

Notes:

• Normal is the factory default setting.

• These options appear only if card stock is supported.

Transparency Texture
Smooth
Normal
Rough

Specify the relative texture of the transparencies loaded in a specific tray.

Note: Normal is the factory default setting.

Recycled Texture
Smooth
Normal
Rough

Specify the relative texture of the recycled paper loaded in a specific tray.

Note: Normal is the factory default setting.
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Labels Texture
Smooth
Normal
Rough

Specify the relative texture of the labels loaded in a specific tray.

Note: Normal is the factory default setting.

Vinyl Labels Texture
Smooth
Normal
Rough

Specify the relative texture of the vinyl labels loaded in a specific tray.

Note: Normal is the factory default setting.

Bond Texture
Smooth
Normal
Rough

Specify the relative texture of the bond paper loaded in a specific tray.

Note: Rough is the factory default setting.

Envelope Texture
Smooth
Normal
Rough

Specify the relative texture of the envelopes loaded in a specific tray.

Note: Normal is the factory default setting.

Rough Envelope Texture
Rough

Specify the relative texture of the rough envelopes loaded in a specific tray.

Note: Rough is the factory default setting.

Letterhead Texture
Smooth
Normal
Rough

Specify the relative texture of the letterhead loaded in a specific tray.

Note: Normal is the factory default setting.

Preprinted Texture
Smooth
Normal
Rough

Specify the relative texture of the preprinted paper loaded in a specific tray.

Note: Normal is the factory default setting.

Colored Texture
Smooth
Normal
Rough

Specify the relative texture of the colored paper loaded in a specific tray.

Note: Normal is the factory default setting.

Light Texture
Smooth
Normal
Rough

Specify the relative texture of the light paper loaded in a specific tray.

Note: Normal is the factory default setting.

Heavy Texture
Smooth
Normal
Rough

Specify the relative texture of the heavy paper loaded in a specific tray.

Note: Normal is the factory default setting.

Rough/Cotton Texture
Rough

Specify the relative texture of the rough or cotton paper loaded in a specific tray.

Note: Rough is the factory default setting.
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Custom [x] Texture
Smooth
Normal
Rough

Specify the relative texture of the custom paper loaded in a specific tray.

Note: Normal is the factory default setting.

Paper Weight menu

Use To

Plain Weight
Light
Normal
Heavy

Specify the relative weight of the plain paper loaded.

Note: Normal is the factory default setting.

Card Stock Weight
Light
Normal
Heavy

Specify the relative weight of the card stock loaded.

Note: Normal is the factory default setting.

Transparency Weight
Light
Normal
Heavy

Specify the relative weight of the transparencies loaded.

Note: Normal is the factory default setting.

Recycled Weight
Light
Normal
Heavy

Specify the relative weight of the recycled paper loaded.

Note: Normal is the factory default setting.

Labels Weight
Light
Normal
Heavy

Specify the relative weight of the labels loaded.

Note: Normal is the factory default setting.

Vinyl Labels Weight
Light
Normal
Heavy

Specify the relative weight of the vinyl labels loaded.

Note: Normal is the factory default setting.

Bond Weight
Light
Normal
Heavy

Specify the relative weight of the bond paper loaded.

Note: Normal is the factory default setting.

Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the envelope loaded.

Note: Normal is the factory default setting.
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Rough Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the rough envelope loaded.

Note: Normal is the factory default setting.

Letterhead Weight
Light
Normal
Heavy

Specify the relative weight of the letterhead loaded.

Note: Normal is the factory default setting.

Preprinted Weight
Light
Normal
Heavy

Specify the relative weight of the preprinted paper loaded.

Note: Normal is the factory default setting.

Colored Weight
Light
Normal
Heavy

Specify the relative weight of the colored paper loaded.

Note: Normal is the factory default setting.

Light Weight
Light

Specify that the weight of the paper loaded is light.

Heavy Weight
Heavy

Specify that the weight of the paper loaded is heavy.

Rough/Cotton Weight
Light
Normal
Heavy

Specify the relative weight of the cotton or rough paper loaded.

Note: Normal is the factory default setting.

Custom [x] Weight
Light
Normal
Heavy

Specify the relative weight of the custom paper loaded.

Notes:

• Normal is the factory default setting.

• The options appear only when the custom type is supported.

Paper Loading menu

Use To

Card Stock Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Card Stock
as the paper type.

Notes:

• Off is the factory default setting for all Paper Loading menu selections.

• Duplex sets the printer default to two‑sided printing for every print job unless one‑sided printing is selected from
Print Properties or the print dialog, depending on your operating system.
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Recycled Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Recycled
as the paper type.

Labels Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Labels as
the paper type.

Vinyl Labels Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Vinyl
Labels as the paper type.

Bond Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Bond as
the paper type.

Letterhead Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Letterhead
as the paper type.

Preprinted Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Preprinted
as the paper type.

Colored Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Colored
as the paper type.

Light Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Light as
the paper type.

Heavy Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Heavy as
the paper type.

Rough/Cotton Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Rough or
Cotton as the paper type.

Custom [x] Loading
Duplex
Off

Determine and set two-sided printing for all print jobs with Custom [x]
as the paper type.

Note: Custom [x] Loading is available only when the custom type is
supported.

Notes:

• Off is the factory default setting for all Paper Loading menu selections.

• Duplex sets the printer default to two‑sided printing for every print job unless one‑sided printing is selected from
Print Properties or the print dialog, depending on your operating system.
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Custom Types menu

Use To

Custom Type [x]
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Envelope

Associate a paper or specialty media type with a factory default custom type name or a user‑defined
custom name created from the Embedded Web Server.

Notes:

• Paper is the factory default setting.

• The custom media type must be supported by the selected tray or multipurpose feeder to print
from that source.

Recycled
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Envelope

Specify a paper type when Recycled is selected in other menus.

Notes:

• Paper is the factory default setting.

• The custom media type must be supported by the selected tray or multipurpose feeder to print
from that source.

Universal Setup menu

Use To

Units of Measure
Inches
Millimeters

Identify the units of measure.

Notes:

• Inches is the US factory default setting.

• Millimeters is the international factory default setting.

Portrait Width
3–8.5 inches
76–216 mm

Set the portrait width.

Notes:

• If the width exceeds the maximum, then the printer uses the
maximum width allowed.

• 8.5 inches is the US factory default setting. You can increase the
width in 0.01‑inch increments.

• 216 mm is the international factory default setting. You can increase
the width in 1‑mm increments.

Portrait Height
3–14.17 inches
76–360 mm

Set the portrait height.

Notes:

• If the height exceeds the maximum, then the printer uses the
maximum height allowed.

• 14 inches is the US factory default setting. You can increase the
height in 0.01‑inch increments.

• 356 mm is the international factory default setting. You can increase
the height in 1‑mm increments.
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Feed Direction
Short Edge
Long Edge

Specify the feed direction if the paper can be loaded in either direction.

Notes:

• Short Edge is the factory default setting.

• Long Edge appears only when the longest edge is shorter than the
maximum width supported in the tray.

Bin Setup menu

Use To

Output Bin
Standard Bin
Bin [x]

Specify the default bin.

Notes:

• If multiple bins are assigned the same name, then the
name appears only once in the menu.

• Standard Bin is the factory default setting.

Configure Bins
Mailbox
Link
Mail Overflow
Link Optional
Type Assignment

Specify configuration options for bins.

Notes:

• Mailbox is the factory default setting. This setting
treats each bin as a separate mailbox.

• Link configures all available bins as one large bin.

• Mail Overflow configures each bin as a separate
mailbox.

• Link Optional links all available bins except the
standard bin and only appears when at least two
optional bins are installed.

• Type Assignment assigns each paper type to a bin or
linked bin set.

• Bins assigned the same name are automatically
linked unless Link Optional is selected.

Overflow Bin
Standard Bin
Bin [x]

Specify an alternative bin when a designated bin is full.

Notes:

• Standard Bin is the factory default setting.

• If multiple bins are assigned the same name, then the
name only appears once in the bin list.

• [x] can be any number between 1 and 12 if the
appropriate optional bins are installed.
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Assign Type/Bin
Plain Paper Bin
Card Stock Bin
Transparency Bin
Recycled Bin
Labels Bin
Vinyl Labels Bin
Bond Bin
Envelope Bin
Rough Envelope Bin
Letterhead Bin
Preprinted Bin
Colored Bin
Light Paper Bin
Heavy Paper Bin
Rough/Cotton Bin
Custom [x] Bin

Select a bin for each supported paper type.

For each type, select the following options:
Disabled
Standard Bin
Bin [x]

Notes:

• Disabled is the factory default setting.

• [x] can be any number between 1 and 12 if the
appropriate optional bins are installed.

• If multiple bins are assigned the same name, then the
name only appears once in the bin list.

Reports menu

Reports menu

Use To

Menu Settings Page Print a report containing information about the paper loaded in trays, installed
memory, total page count, alarms, timeouts, printer control panel language,
TCP/IP address, status of supplies, status of the network connection, and other
information.

Device Statistics Print a report containing printer statistics such as supply information and details
about printed pages.

Stapler Test Print a report that confirms that the staple finisher is functioning properly.

Note: This menu appears only if an optional staple finisher is installed.

Network Setup Page Print a report containing information about the network printer settings, such as
the TCP/IP address information.

Note: This menu item appears only in network printers or in printers connected
to print servers.

Network [x] Setup Page Print a report containing information about the network printer settings, such as
the TCP/IP address information.

Notes:

• This menu item is available only when more than one network option is
installed.

• This menu item appears only in network printers or in printers connected
to print servers.

Understanding printer menus 90



Use To

Profiles List Print a list of profiles stored in the printer.

Note: This menu item appears only when LDSS is enabled.

Print Fonts
PCL Fonts
PostScript Fonts

Print a report of all the fonts available for the printer language currently set in
the printer.

Note: A separate list is available for PCL and PostScript emulations.

Print Directory Print a list of all the resources stored in an optional flash memory card or printer
hard disk.

Notes:

• Job Buffer Size must be set to 100%.

• Make sure the optional flash memory or printer hard disk is installed
correctly and working properly.

• This menu item appears only when an optional flash drive or printer hard
disk is installed.

Asset Report Print a report containing printer asset information, such as serial number and
model name.

Network/Ports menu

Active NIC menu

Use To

Active NIC
Auto
[list of available network cards]

Allow the printer to connect to a network.

Notes:

• Auto is the factory default setting.

• This menu item appears only if an optional network adapter is installed.

Standard Network or Network [x] menu
Note: Only active ports appear in this menu. All inactive ports are omitted.

Use To

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job requires
it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• If PCL SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.
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PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job requires it,
regardless of the default printer language.

Notes:

• On is the factory default setting.

• If PS SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.

NPA Mode
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel, and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Network Buffer
Auto
3KB to [maximum size allowed]

Set the size of the network input buffer.

Notes:

• Auto is the factory default setting.

• The value can be changed in 1KB increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel, serial, and USB buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Job Buffering
Off
On
Auto

Temporarily store print jobs in the printer hard disk before printing. This menu only
appears when a formatted disk is installed.

Notes:

• Off is the factory default setting.

• On buffers print jobs on the printer hard disk.

• Auto buffers print jobs only when the printer is busy processing data from
another input port.

• Changing this setting from the printer control panel, and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• Off filters print jobs using the standard protocol.

• On processes raw binary PostScript print jobs.

Understanding printer menus 92



Use To

Standard Network Setup OR
Network [x] Setup

Reports
Network Card
TCP/IP
IPv6
Wireless
AppleTalk

Show and set the printer network settings.

Note: The Wireless menu appears only when the printer is connected to a wireless
network.

Reports menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > Reports

• Network/Ports > Network [x] > Network [x] Setup > Reports

Use To

Print Setup Page Print a report containing information about the network printer settings, such as the TCP/IP address.

Network Card menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > Network Card

• Network/Ports > Network [x] > Network [x] Setup > Network Card

Use To

View Card Status
Connected
Disconnected

View the connection status of the wireless network adapter.

View Card Speed View the speed of an active wireless network adapter.

Network Address
UAA
LAA

View the network addresses.

Job Timeout

0, 10–225 seconds

Set the amount of time it takes for a network print job to be canceled.

Notes:

• “90 seconds” is the factory default setting.

• A setting value of 0 disables the timeout.

• If a value between 1 and 9 is selected, then Invalid appears on the
display, and the value is not saved.

Banner Page
Off
On

Allow the printer to print a banner page.

Note: Off is the factory default setting.
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TCP/IP menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > TCP/IP

• Network/Ports > Network [x] > Network [x] Setup > TCP/IP

Note: This menu is available only in network printers or printers attached to print servers.

Use To

Set Hostname Set the current TCP/IP host name.

Note: This can be changed only from the Embedded Web Server.

IP Address View or change the current TCP/IP address.

Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP
settings to Off. It also sets Enable BOOTP and Enable RARP to Off on systems that
support BOOTP and RARP.

Netmask View or change the current TCP/IP netmask.

Gateway View or change the current TCP/IP gateway.

Enable DHCP
On
Off

Specify the DHCP address and parameter assignment.

Note: On is the factory default setting.

Enable RARP
On
Off

Specify the RARP address assignment setting.

Note: Off is the factory default setting.

Enable BOOTP
On
Off

Specify the BOOTP address assignment setting.

Note: On is the factory default setting.

Enable AutoIP
Yes
No

Specify the Zero Configuration Networking setting.

Note: Yes is the factory default setting.

Enable FTP/TFTP
Yes
No

Enable the built-in FTP server, which lets you send files to the printer using File Transfer
Protocol.

Note: Yes is the factory default setting.

Enable HTTP Server
Yes
No

Enable the built-in Web server (Embedded Web Server). When enabled, the printer
can be monitored and managed remotely using a Web browser.

Note: Yes is the factory default setting.

WINS Server Address View or change the current WINS server address.

Enable DDNS
Yes
No

View or change the current DDNS setting.

Note: Yes is the factory default setting.

Enable mDNS
Yes
No

View or change the current mDNS setting.

Note: Yes is the factory default setting.

DNS Server Address View or change the current DNS server address.
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Backup DNS Server Address View or change the backup DNS server addresses.

Backup DNS Server Address 2

Backup DNS Server Address 3

Enable HTTPS
Yes
No

View or change the current HTTPS setting.

Note: Yes is the factory default setting.

IPv6 menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > IPv6

• Network/Ports > Network [x] > Network [x] Setup > IPv6

Note: This menu is available only in network printers or printers that are attached to print servers.

Use To

Enable IPv6
On
Off

Enable IPv6 in the printer.

Note: On is the factory default setting.

Auto Configuration
On
Off

Specify whether or not the wireless network adapter accepts the
automatic IPv6 address configuration entries provided by a router.

Note: On is the factory default setting.

View Hostname Set the host name.

Note: These settings can be changed only from the Embedded Web
Server.

View Address

View Router Address

Enable DHCPv6
On
Off

Enable DHCPv6 in the printer.

Note: On is the factory default setting.

Wireless menu

Note:  This menu is available only in printers connected to a wireless network or printer models that have a wireless
network adapter.

To access the menu, navigate to:

Network/Ports > Network [x] > Network [x] Setup > Wireless
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Wi‑Fi Protected Setup
Start Push Button Method
Start PIN Method

Establish a wireless network and enable network security.

Notes:

• Start Push Button Method connects the printer to a wireless
network when buttons on both the printer and the access point
(wireless router) are pressed within a given period of time.

• Start PIN Method connects the printer to a wireless network when
a PIN on the printer is entered into the wireless settings of the
access point.

Enable/Disable WPS Auto‑detection
Enable
Disable

Automatically detect the connection method that an access point with
WPS uses—Start Push Button Method or Start PIN Method.

Note: Disable is the factory default setting.

Network Mode

BSS Type
Infrastructure
Ad hoc

Specify the network mode.

Notes:

• Infrastructure is the factory default setting. This lets the printer
access a network using an access point.

• Ad hoc configures wireless connection directly between the printer
and a computer.

Compatibility
802.11b/g
802.11b/g/n

Specify the wireless standard for the wireless network.

Note: 802.11b/g/n is the factory default setting.

Choose Network Select an available network for the printer to use.

View Signal Quality View the quality of the wireless connection.

View Security Mode View the encryption method for the wireless network.

AppleTalk menu

Note: This menu appears only in printer models that are connected to an Ethernet network or when an optional
wireless network adapter is installed.

To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > AppleTalk

• Network/Ports > Network [x] > Network [x] Setup > AppleTalk

Use To

Activate
Yes
No

Enable or disable AppleTalk support.

Note: Yes is the factory default setting.

View Name Show the assigned AppleTalk name.

Note: The AppleTalk name can be changed only from the Embedded Web
Server.
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View Address Show the assigned AppleTalk address.

Note: The AppleTalk address can be changed only from the Embedded Web
Server.

Set Zone
[list of zones available on the network]

Provide a list of AppleTalk zones available on the network.

Note: The default zone for the network is the factory default setting.

Standard USB menu

Use To

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job received
through a USB port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PostScript emulation if the PS SmartSwitch is set to On. It uses the default
printer language specified in the Setup menu if the PS SmartSwitch is set to
Off.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job received
through a USB port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PCL emulation if the PCL SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if the PCL SmartSwitch is set to Off.

NPA Mode
On
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting. Auto sets the printer to examine data,
determine the format, and then process it appropriately.

• The printer automatically restarts when changing the setting from the printer
control panel. The menu selection is then updated.
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USB Buffer
Disabled
Auto
3K to [maximum size allowed]

Set the size of the USB input buffer.

Notes:

• Auto is the factory default setting.

• Disabled turns off job buffering. Any jobs already buffered on the printer hard
disk are printed before normal processing resumes.

• The USB buffer size value can be changed in 1-K increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the USB Buffer, disable or reduce the
size of the parallel, serial, and network buffers.

• The printer automatically restarts when the setting is changed from the printer
control panel. The menu selection is then updated.

Job Buffering
Off
On
Auto

Temporarily store print jobs in the printer hard disk before printing.

Notes:

• Off is the factory default setting.

• On buffers jobs on the printer hard disk.

• Auto buffers print jobs only if the printer is busy processing data from another
input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• On processes raw binary PostScript print jobs.

• Off filters print jobs using the standard protocol.

ENA Address
yyy.yyy.yyy.yyy

Set the network address information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.

ENA Netmask
yyy.yyy.yyy.yyy

Set the netmask information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.

ENA Gateway
yyy.yyy.yyy.yyy

Set the gateway information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.

Parallel [x] menu
Note: This menu appears only when an optional parallel card is installed.
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PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job received
through a serial port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PostScript emulation if PS SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job received
through a serial port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PCL emulation if PCL SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
On
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Parallel Buffer
Disabled
Auto
3K to [maximum size allowed]

Set the size of the parallel input buffer.

Notes:

• Auto is the factory default setting.

• Disabled turns off job buffering. Any print jobs already buffered on the printer
hard disk are printed before normal processing resumes.

• The parallel buffer size setting can be changed in 1‑KB increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Parallel Buffer, disable or reduce
the size of the USB, serial, and network buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Job Buffering
Off
On
Auto

Temporarily store print jobs on the printer hard disk before printing.

Notes:

• Off is the factory default setting.

• On buffers print jobs on the printer hard disk.

• Auto buffers print jobs only if the printer is busy processing data from another
input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.
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Advanced Status
On
Off

Enable bidirectional communication through the parallel port.

Notes:

• On is the factory default setting.

• Off disables parallel port negotiation.

Protocol
Standard
Fastbytes

Specify the parallel port protocol.

Notes:

• Fastbytes is the factory default setting. It provides compatibility with most
existing parallel ports and is the recommended setting.

• Standard tries to resolve parallel port communication problems.

Honor Init
On
Off

Determine if the printer honors printer hardware initialization requests from the
computer.

Notes:

• Off is the factory default setting.

• The computer requests initialization by activating the Init signal from the
parallel port. Many personal computers activate the Init signal each time the
computer is turned on.

Parallel Mode 2
On
Off

Determine if the parallel port data is sampled on the leading or trailing edge of a
strobe.

Note: On is the factory default setting.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• Off filters print jobs using the standard protocol.

• On processes raw binary PostScript print jobs.

ENA Address
yyy.yyy.yyy.yyy

Set the network address information for an external print server.

Note: This menu item is available only if the printer is attached to an external print
server through the USB port.

ENA Netmask
yyy.yyy.yyy.yyy

Set the netmask information for an external print server.

Note: This menu item is available only if the printer is attached to an external print
server through the USB port.

ENA Gateway
yyy.yyy.yyy.yyy

Set the gateway information for an external print server.

Note: This menu item is available only if the printer is attached to an external print
server through the USB port.

Serial [x] menu

Note: This menu appears only when an optional serial card is installed.
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PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job received
through a serial port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PostScript emulation if PS SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job received
through a serial port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PCL emulation if PCL SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
On
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting. Auto sets the printer to examine data,
determine the format, and then processes it appropriately.

• When set to On, the printer performs NPA processing. If the data is not in NPA
format, it is rejected as bad data.

• When set to Off, the printer does not perform NPA processing.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Serial Buffer
Disabled
Auto
3K to [maximum size allowed]

Set the size of the serial input buffer.

Notes:

• Auto is the factory default setting.

• Disabled turns off job buffering. Any jobs already buffered on the disk are
printed before normal processing is resumed.

• The serial buffer size setting can be changed in 1‑KB increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Serial Buffer, disable or reduce
the size of the parallel, serial, and network buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.
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Job Buffering
Off
On
Auto

Temporarily store print jobs on the printer hard disk before printing.

Notes:

• Off is the factory default setting. The printer does not buffer print jobs on the
printer hard disk.

• On buffers print jobs on the printer hard disk.

• Auto buffers print jobs only if the printer is busy processing data from another
input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Protocol
DTR
DTR/DSR
XON/XOFF
XON/XOFF/DTR
XONXOFF/DTRDSR

Select the hardware and software handshaking settings for the serial port.

Notes:

• DTR is the factory default setting.

• DTR/DSR is a hardware handshaking setting.

• XON/XOFF is a software handshaking setting.

• XON/XOFF/DTR and XON/XOFF/DTR/DSR are combined hardware and
software handshaking settings.

Robust XON
On
Off

Determine whether the printer communicates availability to the computer.

Notes:

• Off is the factory default setting.

• This menu item applies only to the serial port if Serial Protocol is set to
XON/XOFF.

Baud
1200
2400
4800
9600
19200
38400
57600
115200
138200
172800
230400
345600

Specify the rate at which data can be received through the serial port.

Notes:

• 9600 is the factory default setting.

• 138200, 172800, 230400, and 345600 baud rates are only displayed in the
Standard Serial menu. These settings do not appear in the Serial Option 1,
Serial Option 2, or Serial Option 3 menus.

Data Bits
7
8

Specify the number of data bits sent in each transmission frame.

Note: 8 is the factory default setting.

Understanding printer menus 102



Use To

Parity
Even
Odd
None
Ignore

Set the parity for serial input and output data frames.

Note: None is the factory default setting.

Honor DSR
On
Off

Determine whether the printer uses the DSR Signal.

Notes:

• Off is the factory default setting.

• DSR is a handshaking signal used by most serial cables. The serial port uses
DSR to distinguish data sent by the computer from data created by electrical
noise in the serial cable. The electrical noise can cause stray characters to
print. Set this to On to prevent stray characters from printing.

SMTP Setup menu

Use To

Primary SMTP Gateway Specify SMTP server gateway and port information.

Note: 25 is the default SMTP gateway port.Primary SMTP Gateway Port

Secondary SMTP Gateway

Secondary SMTP Gateway Port

SMTP Timeout
5–30

Specify the amount of time in seconds before the server stops trying to
send an e‑mail.

Note: 30 is the factory default setting.

Reply Address Specify a reply address of up to 128 characters in the e-mail sent by the
printer.

Use SSL
Disabled
Negotiate
Required

Set the printer to use SSL for increased security when connecting to the
SMTP server.

Notes:

• Disabled is the factory default setting.

• When the Negotiate setting is used, the SMTP server determines if
SSL will be used.

SMTP Server Authentication
No authentication required
Login/Plain
CRAM‑MD5
Digest‑MD5
NTLM
Kerberos 5

Specify the type of user authentication required for printing privileges.

Note: “No authentication required” is the factory default setting.
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Device‑Initiated E‑mail
None
Use Device SMTP Credentials

Specify what credentials will be used when communicating to the SMTP
server. Some SMTP servers require credentials to send an e-mail.

Notes:

• None is the factory default setting for Device‑Initiated E‑mail and
User‑Initiated E‑mail.

• Device Userid and Device Password are used to log in to the SMTP
server when Use Device SMTP Credentials is selected.

Device Userid

Device Password

Kerberos 5 Realm

NTLM Domain

Security menu

Miscellaneous Security Settings menu

Use To

Login Restrictions
Panel Login Timeout
Remote Login Timeout

Limit the number and time frames of failed login attempts from the printer control
panel before all users are locked out.

Notes:

• Panel Login Timeout specifies how long the printer remains idle on the printer
control panel before automatically logging the user off. Select from 1 to 900
seconds. 30 seconds is the factory default setting.

• Remote Login Timeout specifies how long a remote interface remains idle
before automatically logging the user off. Select from 1 to 120 seconds. 10
minutes is the factory default setting.

Confidential Print menu

Use To

Max Invalid PIN
Off
2–10

Limit the number of times an invalid PIN can be entered.

Notes:

• This menu appears only when a formatted, non-defective printer hard disk is installed.

• Once the limit is reached, the print jobs for that user name and PIN are deleted.

Confidential Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Limit the amount of time a confidential print job stays in the printer before it is deleted.

Notes:

• If the “Confidential Job Expiration” setting is changed while confidential print jobs
reside in the printer RAM or printer hard disk, then the expiration time for those print
jobs does not change to the new default value.

• If the printer is turned off, then all confidential jobs held in the printer RAM are
deleted.

Note: Off is the factory default setting.
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Repeat Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs.

Verify Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs needing verification.

Reserve Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs for printing at a later time.

Note: Off is the factory default setting.

Disk Wiping menu
Disk Wiping erases only print job data on the printer hard disk that are not currently in use by the file system. All
permanent data on the printer hard disk are preserved, such as downloaded fonts, macros, and held jobs.

Note: This menu appears only when a formatted, non-defective printer hard disk is installed.

Use To

Wiping Mode
Auto

Specify the mode for disk wiping.

Automatic Method
Single pass
Multiple pass

Mark all disk space used by a previous print job. This method does not permit the file
system to reuse this space until it has been cleared.

Notes:

• “Single pass” is the factory default setting.

• Only automatic wiping enables users to activate disk wiping without having to
turn the printer off for an extended amount of time.

• Highly confidential information should be wiped using only the Multiple pass
method.
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Security Audit Log menu

Use To

Export Log Let an authorized user export the audit log.

Notes:

• To export the audit log from the printer control panel, a flash drive must be
attached to the printer.

• The audit log can be downloaded from the Embedded Web Server and saved
on a computer.

Delete Log
Yes
No

Specify whether or not audit logs are deleted.

Note: Yes is the factory default setting.

Configure Log
Enable Audit

Yes
No

Enable Remote Syslog
No
Yes

Remote Syslog Facility
0–23

Severity of events to log
0–7

Specify how and whether or not audit logs are created.

Notes:

• Enable Audit determines if events are recorded in the secure audit log and
remote syslog. No is the factory default setting.

• Enable Remote Syslog determines if logs are sent to a remote server. No is the
factory default setting.

• Remote Syslog Facility determines the value used to send logs to the remote
syslog server. 4 is the factory default setting.

• If the security audit log is activated, then the severity value of each event is
recorded. 4 is the factory default setting.

Set Date and Time menu

Use To

Current Date and Time Show the current date and time settings for the printer.

Manually Set Date and Time
[input date/time]

Enter the date and time.

Notes:

• Manually setting the date and time sets Enable NTP to No.

• The wizard lets you set the date and time in YYYY‑MM‑DD‑HH:MM format.

Time Zone
[list of time zones]

Select the time zone.

Note: GMT is the factory default setting.

Automatically observe DST
On
Off

Set the printer to use the applicable daylight saving time (DST) start and end times
associated with the printer Time Zone setting.

Note: On is the factory default setting.

Enable NTP
On
Off

Enable Network Time Protocol, which synchronizes the clocks of devices on a
network.

Notes:

• On is the factory default setting.

• The setting is turned off if you manually set the date and time.
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Settings menu

General Settings

General Settings menu

Use To

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Greek
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Set the language of the text that appears on the printer display.

Note: Not all languages are available for all printer models.

Show Supply Estimates
Show estimates
Do not show estimates

Get an estimate on the status of supplies.

Notes:

• “Show estimates” shows the estimated supply status in
pages on the printer control panel, Embedded Web Server,
menu settings, and the device statistics reports.

• “Do not show estimates” hides the estimated supply status
in any location.
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Eco-Mode
Off
Energy
Energy/Paper
Paper

Minimize the use of energy, paper, or specialty media.

Notes:

• Off is the factory default setting. Off resets the printer to its
factory default settings.

• Energy minimizes the power used by the printer.
Performance may be affected, but print quality is not.

• Energy/Paper minimizes the use of power and of paper and
specialty media.

• Paper minimizes the amount of paper and specialty media
needed for a print job. Performance may be affected, but
print quality is not.

Quiet Mode
Off
On

Reduce the amount of noise produced by the printer.

Notes:

• Off is the factory default setting. This setting supports the
performance specifications for your printer.

• On configures the printer to produce as little noise as
possible. This setting is best suited for printing text and line
art.

• Selecting Photo from the printer driver may disable Quiet
mode and provide better print quality and full‑speed
printing.

Run Initial setup
Yes
No

Instruct the printer to run the setup wizard.

Notes:

• Yes is the factory default setting.

• After completing the setup wizard by selecting Done at the
Country select screen, the default becomes No.

Paper Sizes
US
Metric

Specify the unit of measurement for paper sizes.

Notes:

• US is the factory default setting.

• The initial setting is determined by your country or region
selection in the initial setup wizard.

Home screen customization
Change Language
Search Held Jobs
Held Jobs
USB Drive
Bookmarks
Jobs by user

Change the icons and buttons that appear on the printer control
panel.

For each icon or button, select from the following options:
Display
Do not display

Note: “Do not display” is the factory default setting.
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Home screen customization
Eco-Settings
Showroom
Change Background

Change the icons and buttons that appear on the printer control
panel.

For each icon or button, select from the following options:
Display
Do not display

Note: “Do not display” is the factory default setting.

Output Lighting
Normal/Standby Mode

Off
Dim
Bright

Set the amount of light from the bin.

Notes:

• If Eco-Mode is set to Energy or Energy/Paper, then the
factory default setting is Dim.

• If Eco-Mode is set to Off or set to Paper, then the factory
default setting is Bright.

• This menu appears only when an indicator light is installed
on the bin or when an optional bin with an indicator light is
added.

Alarms
Alarm Control
Cartridge Alarm
Staple Alarm
Hole Punch Alarm

Set an alarm to sound when the printer requires user intervention.

For each alarm type, select from the following options:
Off
Single
Continuous

Notes:

• Off is the factory default setting for Alarm Control, Staple
Alarm, and Hole Punch Alarm. Off means no alarm will
sound.

• Single is the factory default setting for Cartridge Alarm,
Staple Alarm, and Hole Punch Alarm. Single sounds three
quick beeps.

• Continuous repeats three beeps every 10 seconds.

Timeouts
Sleep Mode

Disabled
1–180

Set the amount of time the printer waits after a job is printed before
it goes into a reduced power state.

Notes:

• 30 is the factory default setting.

• Disabled appears only when Energy Conserve is set to Off.

• Lower settings conserve more energy, but may require
longer warm‑up times.

• Select a high setting if the printer is in constant use. Under
most circumstances, this keeps the printer ready to print
with minimum warm‑up time.
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Timeouts
Hibernate Timeout

Disabled
1 hour
2 hours
3 hours
6 hours
1 day
2 days
3 days
1 week
2 weeks
1 month

Set the printer to operate at a low power state.

Notes:

• When the Hibernate Timeout timer expires, the printer uses
Ethernet connection to check the value of “Hibernate
Timeout on Connection.”

• If “Hibernate Timeout on Connection” is set to “Do Not
Hibernate,” then the printer never automatically hibernates.

• If “Hibernate Timeout on Connection” is set to “Hibernate,”
then the printer follows the Hibernate Timeout value, except
when it is set to Disabled.

• Disabled is the factory default setting except for European
Union countries, Canada, and Switzerland.

• “3 days” is the factory default setting for European Union
countries, Canada, and Switzerland.

Timeouts
Screen Timeout

15–300 sec

Set the amount of time in seconds the printer waits before
returning the display to a ready state.

Note: “30 sec” is the factory default setting.

Timeouts
Print Timeout

Disabled
1–255 sec

Set the amount of time in seconds the printer waits to receive an
end‑of‑job message before canceling the remainder of the print
job.

Notes:

• “90 sec” is the factory default setting.

• When the timer expires, any partially printed page still in the
printer is printed, and then the printer checks to see if any
new print jobs are waiting.

• Print Timeout is available only when using PCL emulation.
This setting has no effect on PostScript emulation print jobs.

Timeouts
Wait Timeout

Disabled
15–65535 sec

Set the amount of time in seconds the printer waits for additional
data before canceling a print job.

Notes:

• “40 sec” is the factory default setting.

• Wait Timeout is available only when the printer is using
PostScript emulation. This setting has no effect on PCL
emulation print jobs.

Timeouts
Job Hold Timeout

5–255 sec

Set the amount of time the printer waits for user intervention
before it holds jobs that require unavailable resources and
continues to print other jobs in the print queue.

Notes:

• “30 sec” is the factory default setting.

• This menu appears only when a printer hard disk is installed.
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Error Recovery
Auto Reboot

Reboot when idle
Reboot always
Reboot never

Max Auto Reboots
1–20

Set the printer to restart when an error is encountered.

Notes:

• “Reboot always” is the factory default setting for Auto
Reboot.

• 5 is the factory default setting for Max Auto Reboots.

• If the printer performs the same number of automatic
reboots that is set in the printer within a certain amount of
time, then the printer shows the applicable error instead of
rebooting.

Error Recovery
Max Auto Reboots

1–20

Set the number of automatic reboots that the printer can perform.

Notes:

• 5 is the factory default setting.

• If the printer performs a number of automatic reboots that is
the same as the menu setting within a certain amount of
time, then the printer displays the applicable error instead of
rebooting.

Print Recovery
Auto Continue

Disabled
5–255

Let the printer automatically continue printing from certain offline
situations when these are not resolved within the specified time
period.

Note: Disabled is the factory default setting.

Print Recovery
Jam Recovery

On
Off
Auto

Specify whether the printer reprints jammed pages.

Notes:

• Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the
pages is needed for other printer tasks.

• On sets the printer to always reprint jammed pages.

• Off sets the printer to never reprint jammed pages.

Print Recovery
Jam Assist

On
Off

Set the printer to check for jammed paper automatically.

Note: On is the factory default setting.

Print Recovery
Page Protect

Off
On

Let the printer successfully print a page that may not have printed
otherwise.

Notes:

• Off is the factory default setting. Off prints a partial page
when there is not enough memory to print the whole page.

• On sets the printer to process the whole page so that the
entire page prints.
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Hibernate Timeout on Connection
Do Not Hibernate
Hibernate

To set the printer to follow the setting of “Hibernate Timeout” even
when an active Ethernet connection exists.

Notes:

• If “Hibernate Timeout on Connection” is set to “Do Not
Hibernate,” then the printer never automatically hibernates.

• If “Hibernate Timeout on Connection” is set to “Hibernate,”
then the printer follows the value of the “Hibernate
Timeout” setting, except when it is set to Disabled.

• “Do Not Hibernate” is the factory default setting.

Press Sleep Button
Do nothing
Sleep

Determine how the printer, while in idle state, reacts to a short
press of the Sleep button.

Note: Sleep is the factory default setting.

Press and Hold Sleep Button
Do nothing
Sleep

Determine how the printer, while in idle state, reacts when you
press and hold the Sleep button.

Note: Sleep is the factory default setting.

Factory Defaults
Do Not Restore
Restore Now

Restore the printer settings to the factory default settings.

Notes:

• Do Not Restore is the factory default setting. Do Not Restore
keeps the user‑defined settings.

• Restore Now returns all printer settings to the factory
default settings except Network/Ports menu settings. All
downloads stored in the RAM are deleted. Downloads stored
in the flash memory or in the printer hard disk are not
affected.

Export Configuration Package
Export

Export the printer configuration package to a flash drive.

Note: The configuration package cannot be exported unless a
flash drive is attached to the printer.

Flash Drive Menu

Print Settings menu

Use To

Copies
1–999

Specify a default number of copies for each print job.

Note: 1 is the factory default setting.

Paper Source
Tray [x]
MP Feeder
Manual Paper
Manual Envelope

Set a default paper source for all print jobs.

Note: Tray 1 is the factory default setting.
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Collate
(1,1,1) (2,2,2)
(1,2,3) (1,2,3)

Stack the pages of a print job in sequence when printing multiple copies.

Note: “(1,1,1) (2,2,2)” is the factory default setting.

Sides (Duplex)
1 sided
2 sided

Specify whether prints are on one side or on both sides of the page.

Note: 1 sided is the factory default setting.

Staple
Off
On

Specify whether prints are stapled.

Notes:

• Off is the factory default setting.

• On allows the printer to staple print jobs.

• This menu appears only when a supported staple finisher is installed.

Hole Punch
Off
On

Specify whether prints have holes for binding.

Notes:

• Off is the factory default setting.

• This menu appears only when a supported staple, hole punch finisher is
installed.

Hole Punch Mode
2 holes
3 holes
4 holes

Specify the number of holes to be made on the prints.

Notes:

• “3 holes” is the factory default setting.

• This menu appears only when a supported staple, hole punch finisher is
installed.

Duplex Binding
Long Edge
Short Edge

Define the way duplexed pages are bound and printed.

Notes:

• Long Edge assumes binding along the long edge of the page (left edge for
portrait and top edge for landscape). This is the factory default setting.

• Short Edge assumes binding along the short edge of the page (top edge for
portrait and left edge for landscape).

Paper Saver Orientation
Auto
Landscape
Portrait

Specify the orientation of a multiple‑page document.

Notes:

• Auto is the factory default setting.

• This setting affects jobs if the value of the Paper Saver setting in the same
menu is not set to Off.
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Paper Saver
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Specify that multiple‑page images be printed on one side of a paper.

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per side.

Paper Saver Border
None
Solid

Print a border on each page image when using N‑Up (pages per side).

Notes:

• None is the factory default setting.

• This setting affects jobs if the value of the Paper Saver setting in the same
menu is not set to Off.

Paper Saver Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specify the positioning of multiple‑page images when using N‑Up (pages per side).

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of page images and whether they are in
portrait or landscape orientation.

• This setting affects jobs if the value of the Paper Saver setting in the same
menu is not set to Off.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify if blank separator sheets are inserted.

Notes:

• Off is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if
Collate is set to On. If Collate is set to Off, then a blank page is inserted
between each set of printed pages, such as after all page 1's and after all page
2's.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing on transparencies or when inserting blank pages
in a document for notes.

Separator Sheet Source
Tray [x]
Manual Feeder

Specify the paper source for separator sheets.

Note: Tray 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specify if blank pages are inserted in a print job.

Note: Do Not Print is the factory default setting.
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Print Settings

Setup menu

Use To

Printer Language
PCL Emulation
PS Emulation

Set the default printer language.

Notes:

• PCL Emulation is the factory default setting.

• PostScript emulation uses a PostScript interpreter for
processing print jobs.

• PCL Emulation uses a PCL interpreter for processing print
jobs.

• Setting a printer language default does not prevent a
software program from sending print jobs that use another
printer language.

Job Waiting
On
Off

Determine if print jobs are removed from the print queue when
they require unavailable printer options or custom settings. These
print jobs are stored in a separate print queue, so other jobs print
normally. When the missing information or options, or both are
obtained, the stored jobs print.

Notes:

• Off is the factory default setting.

• This menu appears only if a non-read‑only printer hard disk
is installed. This requirement ensures that stored jobs are
not deleted if the printer loses power.

Print Area
Normal
Whole Page

Set the logical and physical printable area.

Notes:

• Normal is the factory default setting. When attempting to
print data in the non‑printable area defined by the Normal
setting, the printer clips the image at the boundary.

• Whole Page allows the image to be moved into the
non‑printable area defined by the Normal setting, but the
printer clips the image at the Normal setting boundary. This
setting affects only pages printed using a PCL 5e interpreter
and has no effect on pages printed using the PCL XL or
PostScript interpreter.
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Download Target
RAM
Flash
Disk

Set the storage location for downloads.

Notes:

• RAM is the factory default setting. Storing downloads in the
RAM is temporary.

• Storing downloads in a flash memory or in a printer hard disk
places them in permanent storage. Downloads remain in the
flash memory or printer hard disk even when the printer is
turned off.

• This menu item appears only if an optional flash memory or
printer hard disk is installed.

Resource Save
On
Off

Specify how the printer handles temporary downloads, such as
fonts and macros stored in the RAM, when the printer receives a
print job that requires more than the available memory.

Notes:

• Off is the factory default setting. Off sets the printer to retain
downloads only until memory is needed. Downloads are
deleted in order to process print jobs.

• On sets the printer to retain downloads during language
changes and printer resets. If the printer runs out of
memory, then Memory Full [38] appears on the
printer display, but downloads are not deleted.

Print All Order
Alphabetical
Oldest First
Newest First

Specify the order in which held and confidential jobs are printed
when Print All is selected.

Note: Alphabetical is the factory default setting

Finishing menu

Use To

Sides (Duplex)
1 sided
2 sided

Specify whether two‑sided (duplex) printing is set as the default for all print jobs.

Notes:

• “1 sided” is the factory default setting.

• You can set two‑sided printing from the printer software.
For Windows users:

Click File > Print, and then click Properties, Preferences, Options, or Setup.
For Macintosh users:

Choose File > Print, and then adjust the settings from the Print dialog and pop‑up
menus.
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Duplex Binding
Long Edge
Short Edge

Define the way duplexed pages are bound and printed.

Notes:

• Long Edge is the factory default setting. Long Edge assumes binding along the
long edge of the page (left edge for portrait and top edge for landscape).

• Short Edge assumes binding along the short edge of the page (top edge for
portrait and left edge for landscape).

Copies
1–999

Specify the default number of copies for each print job.

Note: 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specify whether blank pages are inserted in a print job.

Note: Do Not Print is the factory default setting.

Collate
(1,1,1) (2,2,2)
(1,2,3) (1,2,3)

Stack the pages of a print job in sequence when printing multiple copies.

Notes:

• “(1,1,1) (2,2,2)” is the factory default setting.

• On stacks the print job in sequence.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify whether blank separator sheets are inserted.

Notes:

• None is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if
Collate is set to “(1,2,3) (1,2,3).” If Collate is set to “(1,1,1) (2,2,2),” then a
blank page is inserted between each set of printed pages, such as after all
page 1's and after all page 2's.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of a print job. This
setting is useful when printing transparencies or when inserting blank pages in
a document.

Separator Source
Tray [x]
Manual Feeder

Specify the paper source for separator sheets.

Notes:

• Tray 1 (standard tray) is the factory default setting.

• From the Paper menu, set Configure MP to "Cassette" for Manual Feeder to
appear as a menu setting.

Paper Saver
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Print multiple‑page images on one side of a paper.

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per side.
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Paper Saver Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specify the positioning of multiple‑page images when using Paper Saver.

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of page images and whether they are in
portrait or landscape orientation.

Paper Saver Orientation
Auto
Landscape
Portrait

Specify the orientation of a multiple‑page document.

Note: Auto is the factory default setting. The printer chooses between portrait and
landscape.

Paper Saver Border
None
Solid

Print a border when using Paper Saver.

Note: None is the factory default setting.

Staple Job
Off
On

Specify whether printed output is stapled.

Notes:

• Off is the factory default setting.

• This menu appears only when a supported staple finisher is installed.

Run Stapler Test Print a report that confirms that the staple finisher is functioning properly.

Note: This menu appears only when a supported staple finisher is installed.

Hole Punch
On
Off

Specify whether holes will be created on printed outputs for the purpose of collecting
the sheets in a binder or folder.

Notes:

• Off is the factory default setting.

• This menu appears only when a supported staple, hole punch finisher is
installed.

Hole Punch Mode
2 holes
3 holes
4 holes

Specify the number of holes to be created on printed outputs for the purpose of
collecting the sheets in a binder or folder.

Notes:

• “3 holes” is the US factory default setting. “4 holes” is the international factory
default setting.

• This menu appears only when a supported staple, hole punch finisher is
installed.

Offset Pages
None
Between Copies
Between Jobs

Offset pages at certain instances.

Notes:

• None is the factory default setting.

• Between Copies offsets each copy of a print job if Collate is set to On. If Collate
is set to Off, then each set of printed pages are offset, such as all page 1's and
all page 2's.

• Between Jobs sets the same offset position for the entire print job regardless
of the number of copies printed.

• This menu appears only when a supported staple finisher is installed.
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Quality menu

Use To

Print Resolution
300 dpi
600 dpi
1200 dpi
1200 Image Q
2400 Image Q

Specify the printed output resolution in dots per inch.

Note: 600 dpi is the factory default setting.

Pixel Boost
Off
Fonts
Horizontally
Vertically
Both directions
Isolated

Enable more pixels to print in clusters for clarity, in order to enhance images horizontally
or vertically, or to enhance fonts.

Note: Off is the factory default setting.

Toner Darkness
1–10

Lighten or darken the printed output.

Notes:

• 8 is the factory default setting.

• Selecting a smaller number can help conserve toner.

Enhance Fine Lines
On
Off

Enable a print mode preferable for files such as architectural drawings, maps, electrical
circuit diagrams, and flow charts.

Notes:

• Off is the factory default setting.

• You can set this option from the printer software. For Windows users, click File >
Print, and then click Properties, Preferences, Options, or Setup. For Macintosh
users, choose File > Print, and then adjust the settings from the Print dialog and
pop‑up menus.

• To set this option using the Embedded Web Server, type the network printer IP
address in the Web browser address field.

Gray Correction
Auto
Off

Automatically adjust the contrast enhancement applied to images.

Note: Auto is the factory default setting.

Brightness
‑6 to 6

Adjust the printed output either by lightening or darkening it. You can conserve toner
by lightening the output.

Note: 0 is the factory default setting.

Contrast
0–5

Adjust the contrast of printed objects.

Note: 0 is the factory default setting.

Job Accounting menu

Note: This menu item appears only when a formatted, non-defective printer hard disk is installed. Make sure the
printer hard disk is not read/write‑ or write‑protected.
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Job Accounting Log
Off
On

Determine and set if the printer creates a log of the print jobs it receives.

Note: Off is the factory default setting.

Job Accounting Utilities Print and delete log files or export them to a flash drive.

Accounting Log Frequency
Weekly
Monthly

Determine and set how often a log file is created.

Note: Monthly is the factory default setting.

Log Action at End of Frequency
None
E‑mail Current Log
E‑mail & Delete Current Log
Post Current Log
Post & Delete Current Log

Determine and set how the printer responds when the frequency threshold expires.

Note: None is the factory default setting.

Disk Near Full Level
Off
1–99

Specify the maximum size of the log file before the printer executes Disk Near Full
Action.

Note: 5 is the factory default setting.

Disk Near Full Action
None
E‑mail Current Log
E‑mail & Delete Current Log
E‑mail & Delete Oldest Log
Post Current Log
Post & Delete Current Log
Post & Delete Oldest Log
Delete Current Log
Delete Oldest Log
Delete All Logs
Delete All But Current

Determine and set how the printer responds when the printer hard disk is nearly full.

Notes:

• None is the factory default setting.

• The value defined in Disk Near Full Level determines when this action is
triggered.

Disk Full Action
None
E‑mail & Delete Current Log
E‑mail & Delete Oldest Log
Post & Delete Current Log
Post & Delete Oldest Log
Delete Current Log
Delete Oldest Log
Delete All Logs
Delete All But Current

Determine and set how the printer responds when disk usage reaches the maximum
limit (100MB).

Note: None is the factory default setting.

URL to Post Logs Determine and set where the printer posts job accounting logs.

E-mail to Send Logs Specify the e‑mail address to which the printer sends job accounting logs.
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Log File Prefix Specify the prefix you want for the log file name.

Note: The current host name defined in the TCP/IP menu is used as the default log
file prefix.

Utilities menu

Use To

Remove Held Jobs
Confidential
Held
Not Restored
All

Delete confidential and held jobs from the printer hard disk.

Notes:

• Selecting a setting affects only print jobs that are resident in the printer.
Bookmarks, print jobs on flash drives, and other types of held jobs are not
affected.

• Not Restored removes all Print and Hold jobs that are not restored from the
printer hard disk or memory.

Format Flash
Yes
No

Format the flash memory.

Warning—Potential Damage: Do not turn off the printer while the flash memory is
being formatted.

Notes:

• Yes deletes all data stored in flash memory.

• No cancels the format request.

• Flash memory refers to the memory added by installing a flash memory card in
the printer.

• The flash memory option card must not be read/write‑ or write‑protected.

• This menu item appears only when a non‑defective flash memory card is
installed.

Delete Downloads on Disk
Delete Now
Do Not Delete

Delete downloads from the printer hard disk, including all held jobs, buffered jobs,
and parked jobs.

Notes:

• Delete Now sets the printer to delete the downloads and allows the display to
return to the originating screen after the deletion.

• Do Not Delete sets the printer to return to the originating screen after the
deletion.

Activate Hex Trace Assist in isolating the source of a print job problem.

Notes:

• When activated, all data sent to the printer is printed in hexadecimal and
character representation, and control codes are not executed.

• To exit or deactivate Hex Trace, turn off or reset the printer.

Coverage Estimator
Off
On

Provide an estimate of the percentage coverage of toner on a page. The estimate is
printed on a separate page at the end of each print job.

Note: Off is the factory default setting.
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XPS menu

Use To

Print Error Pages
Off
On

Print a page containing information on errors, including XML markup errors.

Note: Off is the factory default setting.

PDF menu

Use To

Scale to Fit
Yes
No

Scale page content to fit the selected paper size.

Note: No is the factory default setting.

Annotations
Do Not Print
Print

Print annotations in a PDF.

Note: Do Not Print is the factory default setting.

PostScript menu

Use To

Print PS Error
On
Off

Print a page containing the PostScript error.

Note: Off is the factory default setting.

Lock PS Startup Mode
On
Off

Disable the SysStart file.

Note: Off is the factory default setting.

Font Priority
Resident
Flash/Disk

Establish the font search order.

Notes:

• Resident is the factory default setting.

• This menu item is available only when a formatted flash memory option
card or printer hard disk is installed and operating properly.

• Make sure the flash memory option or printer hard disk is not
read/write‑, write‑, or password‑protected.

• Job Buffer Size must not be set to 100%.
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PCL Emul menu

Use To

Font Source
Resident
Disk
Download
Flash
All

Specify the set of fonts used by the Font Name menu.

Notes:

• “Resident” is the factory default setting. Resident shows the factory
default set of fonts downloaded in the RAM.

• “Flash” and “Disk” settings show all fonts resident in that option.

• The flash option must be properly formatted and cannot be read/write‑,
write‑, or password‑protected.

• “Download” shows all the fonts downloaded in the RAM.

• “All” shows all fonts available to any option.

Font Name
Courier 10

Identify a specific font and the option where it is stored.

Note: Courier 10 is the factory default setting. Courier 10 shows the font
name, font ID, and the storage location in the printer. The font source
abbreviation is R for Resident, F for Flash, K for Disk, and D for Download.

Symbol Set
10U PC‑8
12U PC‑850

Specify the symbol set for each font name.

Notes:

• 10U PC‑8 is the US factory default setting. 12U PC‑850 is the international
factory default setting.

• A symbol set is a set of alphabetic and numeric characters, punctuation,
and special symbols. Symbol sets support the different languages or
specific programs such as math symbols for scientific text. Only the
supported symbol sets are shown.

PCL Emulation Settings
Point Size

1.00–1008.00

Change the point size for scalable typographic fonts.

Notes:

• 12 is the factory default setting.

• Point size refers to the height of the characters in the font. One point
equals approximately 0.014 inch.

• Point sizes can be increased or decreased in 0.25‑point increments.

PCL Emulation Settings
Pitch

0.08–100

Specify the font pitch for scalable monospaced fonts.

Notes:

• 10 is the factory default setting.

• Pitch refers to the number of fixed‑space characters per inch (cpi).

• Pitch can be increased or decreased in 0.01‑cpi increments.

• For nonscalable monospaced fonts, the pitch appears on the display but it
cannot be changed.

PCL Emulation Settings
Orientation

Portrait
Landscape

Specify the orientation of text and graphics on the page.

Notes:

• Portrait is the factory default setting. Portrait prints text and graphics
parallel to the short edge of the page.

• Landscape prints text and graphics parallel to the long edge of the page.
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PCL Emulation Settings
Lines per Page

1–255

Specify the number of lines that print on each page.

Notes:

• 60 is the US factory default setting. 64 is the international default setting.

• The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the Paper Size
and Orientation you want before setting Lines per Page.

PCL Emulation Settings
A4 Width

198 mm
203 mm

Set the printer to print on A4‑size paper.

Notes:

• “198 mm” is the factory default setting.

• The 203‑mm setting sets the width of the page to allow printing of eighty
10‑pitch characters.

PCL Emulation Settings
Auto CR after LF

On
Off

Specify whether the printer automatically performs a carriage return (CR) after
a line feed (LF) control command.

Note: Off is the factory default setting.

PCL Emulation Settings
Auto LF after CR

On
Off

Specify whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command.

Note: Off is the factory default setting.

Tray Renumber
Assign MP Feeder

Off
None
0–199

Assign Tray [x]
Off
None
0–199

Assign Manual Paper
Off
None
0–199

Assign Manual Env
Off
None
0–199

Configure the printer to work with printer software or programs that use
different source assignments for trays and feeders.

Notes:

• “Off” is the factory default setting.

• “None” ignores the Select Paper Feed command. This option appears only
when it is selected by the PCL 5 interpreter.

• “0–199” allows a custom setting to be assigned.
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Tray Renumber
View Factory Defaults

MPF Default = 8
T1 Default = 1
T1 Default = 4
T1 Default = 5
T1 Default = 20
T1 Default = 21
Env Default = 6
MPaper Default = 2
MEnv Default = 3

Display the factory default setting assigned to each tray or feeder.

Tray Renumber
Restore Defaults

Yes
No

Restore all tray and feeder assignments to the factory default settings.

HTML menu

Use To

Font Name
Albertus MT
Antique Olive
Apple Chancery
Arial MT
Avant Garde
Bodoni
Bookman
Chicago
Clarendon
Cooper Black
Copperplate
Coronet
Courier
Eurostile
Garamond
Geneva
Gill Sans
Goudy
Helvetica
Hoefler Text
Intl CG Times
Intl Courier
Intl Univers

Joanna MT
Letter Gothic
Lubalin Graph
Marigold
MonaLisa Recut
Monaco
New CenturySbk
New York
Optima
Oxford
Palatino
StempelGaramond
Taffy
Times
TimesNewRoman
Univers
Zapf Chancery
NewSansMTCS
NewSansMTCT
New SansMTJA
NewSansMTKO

Set the default font for HTML documents.

Note: The Times font is used in HTML documents that do not
specify a font.
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Font Size
1–255 pt

Set the default font size for HTML documents.

Notes:

• 12 pt is the factory default setting.

• Font size can be increased in 1‑point increments.

Scale
1–400%

Scale the default font for HTML documents.

Notes:

• 100% is the factory default setting.

• Scaling can be increased in 1% increments.

Orientation
Portrait
Landscape

Set the page orientation for HTML documents.

Note: Portrait is the factory default setting.

Margin Size
8–255 mm

Set the page margin for HTML documents.

Notes:

• 19 mm is the factory default setting.

• Margin size can be increased in 1‑mm increments.

Backgrounds
Do Not Print
Print

Specify whether to print backgrounds on HTML documents.

Note: Print is the factory default setting.

Image menu

Use To

Auto Fit
On
Off

Select the optimal paper size, scaling, and orientation.

Note: On is the factory default setting. It overrides scaling and orientation settings
for some images.

Invert
On
Off

Invert bitonal monochrome images.

Notes:

• Off is the factory default setting.

• This setting does not apply to GIF or JPEG images.

Scaling
Anchor Top Left
Best Fit
Anchor Center
Fit Height/Width
Fit Height
Fit Width

Scale the image to fit the selected paper size.

Notes:

• Best Fit is the factory default setting.

• When Auto Fit is set to On, Scaling is automatically set to Best Fit.
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Orientation
Portrait
Landscape
Reverse Portrait
Reverse Landscape

Set the image orientation.

Note: Portrait is the factory default setting.

Help menu
The Help menu consists of a series of Help pages that are stored in the printer as PDFs. They contain information about
using the printer and performing printing tasks.

English, French, German, and Spanish translations are stored in the printer. Other translations are available at
http://support.dell.com.

Menu item Description

Print All Guides Prints all the guides

Print Quality Provides information about solving print quality issues

Printing Guide Provides information about loading paper and other specialty media

Media Guide Provides a list of the paper sizes supported in trays and feeders

Print Defects Guide Provides information about resolving print defects

Menu Map Provides a list of the printer control panel menus and settings

Information Guide Provides help in locating additional information

Connection Guide Provides information about connecting the printer locally (USB) or to a network

Moving Guide Provides instructions for safely moving the printer

Supplies Guide Provides part numbers for ordering supplies
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Saving money and the environment

Saving paper and toner
Studies show that as much as 80% of the carbon footprint of a printer is related to paper usage. You can significantly
reduce your carbon footprint by using recycled paper and the following printing suggestions, such as printing on both
sides of the paper and printing multiple pages on one side of a single sheet of paper.

For more information on how you can quickly save paper and energy using one printer setting, see “Using Eco‑Mode”
on page 128.

Using recycled paper
As an environmentally conscious company, we support the use of recycled office paper produced specifically for use
in laser printers. For more information on recycled papers that work well with your printer, see “Using recycled paper
and other office papers” on page 66.

Conserving supplies

Use both sides of the paper

If your printer model supports duplex printing, then you can control whether print appears on one or two sides of the
paper by selecting 2‑sided printing from the Print dialog.

Place multiple pages on one sheet of paper

You can print up to 16 consecutive pages of a multiple‑page document onto one side of a single sheet of paper by
selecting a setting from the Multipage printing (N‑Up) section of the Print dialog screen.

Check your first draft for accuracy

Before printing or making multiple copies of a document:

• Use the preview feature, which you can select from the Print dialog to see how the document will look like before
you print it.

• Print one copy of the document to check its content and format for accuracy.

Avoid paper jams

Correctly set the paper type and size to avoid paper jams. For more information, see “Avoiding jams” on page 152.

Saving energy

Using Eco‑Mode
1 Open a Web browser, and then type the printer IP address in the address field.
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Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Eco‑Mode.

3 Select a setting.

Use To

Off Use the factory default settings for all settings associated with Eco‑Mode.

Notes:

• Settings that were changed when other modes were selected are reset to the factory default
settings.

• Off supports the performance specifications of the printer.

Energy Reduce energy use, especially when the printer is idle.

Notes:

• Printer engine motors do not start until a document is ready to print. You may notice a short
delay before the first page is printed.

• The printer enters Sleep mode after one minute of inactivity.

• The printer display is turned off when the printer is in Sleep mode.

• Lights on the staple finisher and other optional finishers are turned off when the printer is in
Sleep mode.

Energy/Paper Use all the settings associated with Energy and Paper modes.

Plain Paper Enable the automatic two‑sided (duplex) printing feature.

4 Click Submit.

Reducing printer noise
Enable Quiet mode to reduce the printer noise.

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Quiet Mode > 

2 Select a setting.
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On Reduce printer noise.

Notes:

• Print jobs process at a reduced speed.

• Printer engine motors do not start until a document
is ready to print. There is a short delay before the
first page is printed.

• The alarm control and cartridge alarm sounds are
turned off.

• The printer ignores the Advance Start command.

Off Use factory default settings.

Note: This setting supports the performance
specifications of the printer.

3 Press .

Adjusting Sleep mode
To save energy, decrease the number of minutes before the printer enters Sleep mode. Select from 1 to 120. The factory
default setting is 30 minutes.

Note: The printer still accepts print jobs when in Sleep mode.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Navigate to:

Settings > General Settings > Timeouts

3 In the Sleep Mode field, enter the number of minutes you want the printer to wait before it enters Sleep mode.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Timeouts >  > Sleep Mode > 

2 In the Sleep Mode field, select the number of minutes you want the printer to wait before it enters Sleep mode.

3 Press .

Saving money and the environment 130



Using Hibernate mode
Hibernate is an ultra‑low‑power operating mode. When operating in Hibernate mode, all other systems and devices
are powered down safely.

Notes:

• Make sure to wake the printer from Hibernate mode before sending a print job. A hard reset or a long press of
the Sleep button wakes the printer from Hibernate mode.

• If the printer is in Hibernate mode, then the Embedded Web Server is disabled.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If your are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Sleep Button Settings.

3 From the “Press Sleep Button” or “Press and Hold Sleep Button” drop‑down menu, select Hibernate.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings > 

2 Press the arrow buttons until Press Sleep Button or Press and Hold Sleep Button appears, and

then press .

3 Press the arrow buttons until Hibernate appears, and then press .

Notes:

• When Press Sleep Button is set to Hibernate, a short press of the Sleep button sets the printer to Hibernate
mode.

• When Press and Hold Sleep Button is set to Hibernate, a long press of the Sleep button sets the printer to
Hibernate mode.

Adjusting the brightness of the printer display
To save energy, or if you have trouble reading the display, adjust its brightness settings.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.
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Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings.

3 In the Screen Brightness field, enter the brightness percentage you want for the display.

4 Click Submit.

Recycling

Recycling Dell products
To return Dell products for recycling:

1 Visit our Web site at www.dell.com/recycle.

2 Select your country or region.

3 Follow the instructions on the computer screen.
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Securing the printer

Using the security lock feature
The printer is equipped with a security lock feature. When a lock compatible with most laptop computers is attached,
the printer is locked. When locked, the controller board shield and the controller board cannot be removed. Attach a
security lock to the printer in the location shown.

Statement of Volatility
Your printer contains various types of memory that can store device and network settings, and user data.

Type of memory Description

Volatile memory Your printer uses standard random access memory (RAM) to
temporarily buffer user data during simple print jobs.

Non-volatile memory Your printer may use two forms of non-volatile memory:
EEPROM and NAND (flash memory). Both types are used to
store the operating system, device settings, network
information, bookmark settings, and embedded solutions.

Hard disk memory Some printers have a hard disk drive installed. The printer
hard disk is designed for device-specific functionality. This lets
the device retain buffered user data from complex print jobs,
as well as form data, and font data.

Erase the content of any installed printer memory in the following circumstances:

• The printer is being decommissioned.

• The printer hard disk is being replaced.

• The printer is being moved to a different department or location.

• The printer is being serviced by someone from outside your organization.
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• The printer is being removed from your premises for service.

• The printer is being sold to another organization.

Disposing of a printer hard disk

Note: Some printer models may not have a printer hard disk installed.

In high‑security environments, it may be necessary to take additional steps to make sure that confidential data stored
in the printer hard disk cannot be accessed when the printer—or its hard disk—is removed from your premises.

• Degaussing—Flushes the hard disk with a magnetic field that erases stored data

• Crushing—Physically compresses the hard disk to break component parts and render them unreadable

• Milling—Physically shreds the hard disk into small metal bits

Note: Most data can be erased electronically, but the only way to guarantee that all data is completely erased is to
physically destroy each hard disk where data is stored.

Erasing volatile memory
The volatile memory (RAM) installed in your printer requires a power source to retain information. To erase the buffered
data, turn off the printer.

Erasing non‑volatile memory
Erase individual settings, device and network settings, security settings, and embedded solutions by following these
steps:

1 Turn off the printer.

2 Hold down 2 and 6 on the keypad while turning the printer on. Release the buttons only when the screen with the
progress bar appears.

The printer performs a power-on sequence, and then the Configuration menu appears. When the printer is fully
turned on, a list of functions appears on the printer display.

3 Press the up or down arrow button until Wipe All Settings appears.

The printer will restart several times during this process.

Note: Wipe All Settings securely removes device settings, solutions, jobs, and passwords from the printer
memory.

4 Navigate to:

Back > Exit Config Menu

The printer will perform a power‑on reset, and then return to normal operating mode.
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Erasing printer hard disk memory
Note: Some printer models may not have a printer hard disk installed.

Configuring Disk Wiping in the printer menus lets you remove residual confidential material left by print jobs by securely
overwriting files that have been marked for deletion.

Using the printer control panel

1 Turn off the printer.

2 Hold down 2 and 6 while turning the printer on. Release the buttons only when the screen with the progress bar
appears.

The printer performs a power-on sequence, and then the Configuration menu appears. When the printer is fully
turned on, a list of functions appears on the printer display.

3 Press the up or down arrow button until Wipe Disk appears, and then select one of the following:

• Wipe disk (fast)—This lets you overwrite the disk with all zeroes in a single pass.

• Wipe disk (secure)—This lets you overwrite the disk with random bit patterns several times, followed by a
verification pass. A secure overwrite is compliant with the DoD 5220.22‑M standard for securely erasing data
from a hard disk. Highly confidential information should be wiped using this method.

4 Press the up or down arrow button until Yes appears, and then proceed with disk wiping.

Notes:

• A status bar will indicate the progress of the disk wiping task.

• Disk wiping can take from several minutes to more than an hour, during which the printer will be unavailable
for other user tasks.

5 Navigate to:

Back > Exit Config Menu

The printer will perform a power‑on reset, and then return to normal operating mode.

Configuring printer hard disk encryption
Enable hard disk encryption to prevent loss of sensitive data in the event the printer or its hard disk is stolen.

Note: Some printer models may not have a printer hard disk installed.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Security > Disk Encryption.

Note: Disk Encryption appears in the Security menu only when a formatted, non‑defective printer hard disk is
installed.
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3 From the Disk Encryption menu, select Enable.

Notes:

• Enabling disk encryption will erase the content of the printer hard disk.

• Disk encryption can take from several minutes to more than an hour, during which the printer will be
unavailable for other user tasks.

Using the printer control panel

1 Turn off the printer.

2 Hold down 2 and 6 while turning the printer on. Release the buttons only when the screen with the progress bar
appears.

The printer performs a power-on sequence, and then the Configuration menu appears. When the printer is fully
turned on, a list of functions appears on the printer display.

3 Navigate to:

Disk Encryption > Enable

Note: Enabling disk encryption will erase the contents of the printer hard disk.

4 Select Yes to proceed with disk wiping.

Notes:

• Do not turn off the printer during the encryption process. Doing so may result in loss of data.

• Disk encryption can take from several minutes to more than an hour, during which the printer will be
unavailable for other user tasks.

• A status bar will indicate the progress of the disk wiping task. After the disk has been encrypted, the printer
will return to the screen for enabling or disabling disk encryption.

5 Navigate to:

Back > Exit Config Menu

The printer will perform a power‑on reset, and then return to normal operating mode.

Finding printer security information
In high-security environments, you may need to take additional steps to make sure that confidential data stored in the
printer cannot be accessed by unauthorized persons. For more information, see the Embedded Web Server
Administrator’s Guide.
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Maintaining the printer
Periodically, certain tasks are required to maintain optimum performance of your printer.

Warning—Potential Damage: Failure to maintain optimum printer performance, or to replace parts and supplies,
may cause damage to your printer.

Estimated number of remaining pages
The estimated number of remaining pages is based on the recent printing history of the printer. Its accuracy may
vary significantly and is dependent on many factors, such as actual document content, print quality settings, and
other printer settings.

The accuracy of the estimated number of remaining pages may decrease when the actual printing consumption is
different from the historical printing consumption. Consider the variable level of accuracy before purchasing or replacing
supplies based on the estimate. Until an adequate print history is obtained on the printer, initial estimates assume
future supplies consumption based on the International Organization for Standardization* test methods and page
content.

* Average continuous black declared cartridge yield in accordance with ISO/IEC 19752.

Cleaning the printer

Cleaning the printer
Note: You may need to perform this task after every few months.

Warning—Potential Damage: Damage to the printer caused by improper handling is not covered by the printer
warranty.

1 Make sure that the printer is turned off and unplugged from the electrical outlet.

CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before
proceeding.

2 Remove paper from the standard bin and multipurpose feeder.

3 Remove any dust, lint, and pieces of paper around the printer using a soft brush or vacuum.

4 Dampen a clean, lint-free cloth with water, and use it to wipe the outside of the printer.

Warning—Potential Damage: Do not use household cleaners or detergents to prevent damage to the exterior
of the printer.

5 Make sure all areas of the printer are dry before sending a new print job.
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Emptying the hole punch box
1 Pull out the hole punch box.

2 Empty the container.

3 Insert the emptied hole punch box back into the finisher until it clicks into place.

Checking the status of parts and supplies
A message appears on the printer display when a replacement supply item is needed or when maintenance is required.

Checking the status of parts and supplies on the printer control panel
From the printer control panel, navigate to:

 > Status/Supplies >  View Supplies > 

Checking the status of parts and supplies from the Embedded Web Server
Note: Make sure the computer and printer are connected to the same network.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Device Status > More Details.
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Configuring supply notifications from the Embedded Web Server
You can determine how you would like to be notified when supplies run nearly low, low, very low, or reach their
end‑of‑life by setting the selectable alerts.

Notes:

• Selectable alerts can be set on the toner cartridge, imaging unit, and maintenance kit.

• All selectable alerts can be set for nearly low, low, and very low supply conditions. Not all selectable alerts can
be set for the end‑of‑life supply condition. E‑mail selectable alert is available for all supply conditions.

• The percentage of estimated remaining supply that prompts the alert can be set on some supplies for some
supply conditions.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Supply Notifications.

3 From the drop‑down menu for each supply, select one of the following notification options:

Notification Description

Off The normal printer behavior for all supplies occurs.

E‑mail Only The printer generates an e-mail when the supply condition is reached. The status of the
supply will appear on the menus page and status page.

Warning The printer displays the warning message and generates an email about the status of the
supply. The printer does not stop when the supply condition is reached.

Continuable Stop1 The printer stops processing jobs when the supply condition is reached, and the user needs
to press a button to continue printing.

Non Continuable Stop1,2 The printer stops when the supply condition is reached. The supply must be replaced to
continue printing.

1 The printer generates an e-mail about the status of the supply when supply notification is enabled.
2 The printer stops when some supplies become empty to prevent damage.

4 Click Submit.

Ordering supplies

Ordering supplies using the Supplies Ordering Utility

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.
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3 Select your printer, and then navigate to:

Status Monitor Center > Order Supplies

4 From the Order Printer Supplies dialog, do any of the following:

• Click Order Online to order supplies on the Internet.

• Click Order by Phone to order supplies by phone.

Ordering supplies using Printer Home

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Select your printer, and then navigate to:

Dell Printer Home > Maintenance > Order supplies

4 From the Order Printer Supplies dialog, do any of the following:

• Click Order Online to order supplies on the Web.

• Click Order by Phone to order supplies by phone.

Ordering a maintenance kit
To order a maintenance kit, contact the place where you purchased the printer.

Ordering a roller kit
To order a roller kit, contact the place where you purchased the printer.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you
are ready to use them.

Do not expose supplies to:

• Direct sunlight

• Temperatures above 35°C (95°F)

• High humidity above 80%

• Salty air

• Corrosive gases

• Heavy dust
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Replacing supplies

Replacing the toner cartridge
1 Lift the front cover, and then pull down the multipurpose feeder door.

2

1

2 Pull the cartridge out of the printer using the handle.

3 Unpack the new toner cartridge, then remove the packing material, and then shake the cartridge to redistribute
the toner.
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4 Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on the side rails
inside the printer.

Note: Make sure the cartridge is fully pushed in.

Warning—Potential Damage: When replacing a toner cartridge, do not leave the imaging unit exposed to direct
light for an extended period of time. Extended exposure to light may cause print quality problems.

5 Close the multipurpose feeder door and the front cover.

2

1
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Replacing the imaging unit
1 Lift the front cover, and then pull down the multipurpose feeder door.

2

1

2 Pull the cartridge out of the printer using the handle.

3 Pull the imaging unit out of the printer using the handle.

1

2

4 Unpack the new imaging unit, and then remove all packing materials.

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

Warning—Potential Damage: Do not touch the shiny blue photoconductor drum under the imaging unit. Doing
so may affect the quality of future print jobs.
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5 Shake the new imaging unit.

6 Insert the imaging unit into the printer by aligning the arrows on the side rails of the imaging unit with the arrows
on the side rails inside the printer.

7 Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on the side rails
inside the printer.
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8 Close the multipurpose feeder door and the front cover.

2

1

Replacing a staple cartridge
1 Open the stapler door.

2 Pull down the latch of the staple cartridge holder, and then pull the holder out of the finisher.
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3 Squeeze both sides of the empty staple case with your fingers, and then remove the staple case from the cartridge.

1

1
2

4 Insert the front side of the new staple case into the staple cartridge, and then push the rear side into the cartridge.

1

2

5 Push the staple cartridge into the finisher until it clicks into place.

6 Close the stapler door.

Moving the printer

Before moving the printer
CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn off the printer, and then unplug the power cord from the electrical outlet.

• Disconnect all cords and cables from the printer.

• If two or more optional finishers are installed, then remove the finishers individually from the printer.

Notes:

– Make sure to remove the topmost finisher first.

– To remove the finisher, hold the finisher on both sides, and then lift the latches to unlock the finisher.

Maintaining the printer 146



• If the printer does not have a caster base but is configured with optional trays, then remove the trays.

Note: Slide the latch on the right side of the optional tray toward the front of the tray until it clicks into place.

• Use the handholds located on both sides of the printer to lift it.

• Make sure your fingers are not under the printer when you set it down.

• Make sure there is adequate clearance around the printer.

• Use only the power cord provided with this product or the manufacturer's authorized replacement.

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.
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Moving the printer to another location
The printer and its hardware options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer.

• Any cart used to move the hardware options must have a surface able to support the dimensions of the hardware
options.

• Keep the printer in an upright position.

• Avoid severe jarring movements.

Shipping the printer
When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
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Managing the printer

Managing printer messages
Use the Status Messenger application to view error messages requiring your intervention on your printer. When there
is an error, a bubble appears telling you what the error is, and points you to the appropriate recovery information.

If you installed Status Messenger with your printer software, then the application launches automatically when the
software installation is completed. The installation is successful if you see the Status Messenger icon in the system tray.

Notes:

• This feature is available only in Windows XP or later.

• Make sure bidirectional communication support is in place so the printer and computer can communicate.

Disabling Status Messenger

1 From the system tray, right click the Status Messenger icon.

2 Select Exit.

Enabling Status Messenger

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Select your printer, and then click Status Messenger.

Accessing Status Monitor Center
Use the Status Monitor Center application to view the status of any USB‑ or network‑connected printer and order
supplies online.

Note: Make sure bidirectional communication support is in place so the printer and computer can communicate.

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Click Status Monitor Center.

Note: To order supplies online, click the Supplies Ordering Utility link.

Checking the virtual display
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
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• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Check the virtual display that appears at the top left corner of the screen.

The virtual display works as an actual display would work on a printer control panel.

Modifying confidential print settings
Note: This feature is available only in network printers or printers connected to print servers.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Configuration > Other Settings tab > Security > Confidential Print Setup.

3 Modify the settings:

• Set a maximum number of PIN entry attempts. When a user exceeds a specific number of PIN entry attempts,
all of the jobs for that user are deleted.

• Set an expiration time for confidential print jobs. When a user has not printed the jobs within the specified time,
all of the jobs for that user are deleted.

4 Save the modified settings.

Copying printer settings to other printers
Note: This feature is available only in network printers.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click the Copy Printer Settings.

3 To change the language, select a language from the drop-down menu, and then click Click here to submit language.

4 Click Printer Settings.

5 Type the IP addresses of the source and target printers in their appropriate fields.

Note: If you want to add or remove a target printer, then click Add Target IP or Remove Target IP.

6 Click Copy Printer Settings.
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Restoring factory default settings
If you want to keep a list of the current menu settings for reference, then print a menu settings page before restoring
the factory default settings. For more information, see “Printing a menu settings page” on page 42.

If you want a more comprehensive method of restoring the printer factory default settings, then perform the Wipe All
Settings option. For more information, see “Erasing non‑volatile memory” on page 134.

Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original factory default
settings. Exceptions include the display language, custom sizes and messages, and network/port menu settings. All
downloads stored in the RAM are deleted. Downloads stored in the flash memory or in the printer hard disk are not
affected.

From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Factory Defaults >  > Restore Now > 
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Clearing jams
Carefully select paper and specialty media and load them properly to avoid most jams. For more information, see
“Avoiding jams” on page 152. If jams occur, then follow the steps outlined in this chapter.

Note: Jam recovery is set to Auto by default. The printer reprints jammed pages unless the memory required to hold
the pages is needed for other printer tasks.

Avoiding jams

Load paper properly
• Make sure paper lies flat in the tray.

Correct loading of paper Incorrect loading of paper

• Do not remove a tray while the printer is printing.

• Do not load a tray while the printer is printing. Load it before printing, or wait for a prompt to load it.

• Do not load too much paper. Make sure the stack height is below the maximum paper fill indicator.
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• Do not slide the paper into the tray. Load paper as shown in the illustration.

• Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing tightly
against the paper or envelopes.

• Push the tray firmly into the printer after loading paper.

• If you are loading prepunched paper for use with the staple finisher, then make sure the holes on the long edge of
the paper are on the right side of the tray.

Source Printing Orientation

Tray One‑sided The short edge with holes enters the printer first.

Two‑sided The short edge without holes enters the printer first.

Multipurpose feeder One‑sided The short edge with holes enters the printer first.

Two‑sided The short edge without holes enters the printer first.

Note: If the holes on the long edge of the paper are on the left side of the tray, then a jam may occur.

Allow the paper to enter the optional mailbox bins properly
• Make sure to adjust the bin extender so that the paper size indicators match the size of the paper used.

Notes:

– If the bin extender is shorter than the size of the paper you are printing on, then the paper causes a jam in
the mailbox bin. For example, if you are printing on a legal-size paper and the bin extender is set to letter-
size, then a jam occurs.
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– If the bin extender is longer than the size of the paper you are printing on, then the edges become uneven
and the paper is not stacked properly. For example, if you are printing on a letter-size paper and the bin
extender is set to legal-size, then the paper does not stack properly.

• If paper needs to be returned to the mailbox bin, then insert the paper under the bin arm, and then push the paper
all the way back.

1

2

Note: If the paper is not under the bin arm, then a jam occurs due to an overfilled bin.

Use recommended paper
• Use only recommended paper or specialty media.

• Do not load wrinkled, creased, damp, bent, or curled paper.

• Flex, fan, and straighten paper or specialty media before loading it.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, weights, or types in the same tray.

• Make sure the paper size and type are set correctly on the computer or printer control panel.

• Store paper per manufacturer recommendations.

Understanding jam messages and locations
When a jam occurs, a message indicating the jam location and information to clear the jam appears on the printer
display. Open the doors, covers, and trays indicated on the display to remove the jam.

Notes:

• When Jam Assist is set to On, Discarding pages appears on the display and the printer flushes blank or
pages with partial prints to the standard bin after a jammed page is cleared. Check your printed output for blank
pages.

• When Jam Recovery is set to On or Auto, the printer reprints jammed pages. However, the Auto setting reprints
jammed pages if adequate printer memory is available.
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Jam location Printer message What to do

1 Staple finisher [x]‑page jam, remove paper, open
stapler door. Leave paper in bin. [455–
457]

Remove paper from the stapler bin, open the stapler
door, then remove the staple cartridge, and then
remove the jammed staples.

2 Standard bin [x]‑page jam, remove standard bin
jam. [203]

Remove jammed paper from the standard bin.

3 Inside the printer [x]‑page jam, lift front cover to
remove cartridge. [200–201]

Open the front cover and the multipurpose feeder,
then remove the toner cartridge and the imaging unit,
and then remove the jammed paper.

4 Multipurpose feeder [x]‑page jam, clear manual
feeder. [250]

Remove all paper from the multipurpose feeder, and
then remove the jammed paper.

5 Duplex area [x]‑page jam, remove tray 1 to clear
duplex. [235–239]

Pull out tray 1 completely, then push the front duplex
flap down, and then remove the jammed paper.

6 Trays [x]‑page jam, open tray [x]. [24x] Pull out the indicated tray, and then remove the
jammed paper.

7 High‑capacity output
expander

[x]‑page jam, remove paper, open
expander rear door. Leave paper in
bin. [43y.xx]

Open the rear door of the high‑capacity output
expander, and then remove the jammed paper.

8 Upper rear door [x]‑page jam, open upper rear
door. [202]

Open the rear door of the printer, and then remove
the jammed paper.

9 Upper door and rear
duplex area

[x]‑page jam, open upper and lower
rear door. [231–234]

Open the rear door of the printer and the rear duplex
area, and then remove the jammed paper.
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Jam location Printer message What to do

10 Mailbox [x]‑page jam, remove paper, open
mailbox rear door. Leave paper in
bin. [41y.xx]

Open the rear door of the mailbox, and then remove
the jammed paper.

11 Staple finisher rear
door

[x]‑page jam, remove paper, open
finisher rear door. Leave paper in
bin. [451]

Open the rear door of the staple finisher, and then
remove the jammed paper.

[x]‑page jam, lift front cover to remove cartridge. [200–201]
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

1 Lift the front cover, and then pull down the multipurpose feeder door.

2

1

2 Lift the blue handle, and then pull the toner cartridge out of the printer.

3 Place the cartridge aside.
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4 Lift the blue handle, and then pull the imaging unit out of the printer.

1

2

5 Place the imaging unit aside on a flat, smooth surface.

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

6 Pull the jammed paper gently to the right, and then remove it from the printer.

Note: Make sure all paper fragments are removed.

1 2

Warning—Potential Damage: The jammed paper may be covered with toner, which can stain garments and
skin.

7 Install the imaging unit.

Note: Use the arrows on the side of the printer as a guide.

8 Insert the cartridge into the printer, and then push the blue handle back into place.
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Notes:

• Align the arrows on the guides of the toner cartridge with the arrows in the printer.

• Make sure the cartridge is fully pushed in.

9 Close the multipurpose feeder door and the front cover.

2

1

10 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.

[x]‑page jam, open upper rear door. [202]
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

1 Pull down the rear door.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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3 Close the rear door.

4 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.

[x]‑page jam, remove standard bin jam. [203]
1 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

2 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.

[x]‑page jam, open upper and lower rear door. [231–234]
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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1 Pull down the rear door.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Close the rear door.
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4 Push the back of the standard tray.

5 Press down the rear duplex flap, then firmly grasp the jammed paper, and then gently pull the paper out.

Note: Make sure all paper fragments are removed.

2

1

6 Insert the standard tray.

7 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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[x]‑page jam, remove tray 1 to clear duplex. [235–239]
1 Pull out the tray completely.

Note: Lift the tray slightly and pull it out.

2

3
1

2 Push down the front duplex flap, then firmly grasp the jammed paper, and then gently pull the paper to the right
and out of the printer.

Note: Make sure all paper fragments are removed.

2

1

3 Insert the tray.

4 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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[x]‑page jam, open tray [x]. [24x]
1 Check which tray is indicated on the printer display, and then pull the tray.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Insert the tray.

4 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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[x]‑page jam, clear manual feeder. [250]
1 From the multipurpose feeder, firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

2 Flex and fan the sheets to loosen them. Do not fold or crease the paper. Straighten the edges on a level surface.

3 Reload paper into the multipurpose feeder.

4 Slide the paper guide until it lightly rests against the edge of the paper.

5 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.

Clearing jams 164



[x]‑page jam, remove paper, open mailbox rear door. Leave
paper in bin. [41y.xx]
1 Open the rear mailbox door.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Close the rear mailbox door.
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4  If the jam is in the mailbox bin, then firmly grasp the jammed paper, and then gently pull it out.

Notes:

• Make sure all paper fragments are removed.

• When using A4‑, folio‑, or legal‑size paper, make sure to adjust the bin extender so that the paper enters the
bin properly.

5 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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[x]‑page jam, remove paper, open expander rear door. Leave
paper in bin. [43y.xx]
1 Open the rear door of the high‑capacity output expander.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Close the rear door of the high‑capacity output expander.

4 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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[x]‑page jam, remove paper, open finisher rear door. Leave
paper in bin. [451]
1 Open the rear staple finisher door.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Close the staple finisher door.

4 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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[x]‑page jam, remove paper, open stapler door. Leave paper in
bin. [455–457]
1 From the stapler bin, firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

2 Open the stapler door.

3 Pull down the latch of the staple cartridge holder, and then pull the holder out of the printer.
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4 Use the metal tab to lift the staple guard, and then remove any loose staples.

5 Press down the staple guard until it clicks into place.
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6 Press the staples against the metal bracket.

Note: If the staples are at the rear of the cartridge, then shake the cartridge downward to bring the staples near
the metal bracket.

7 Push the cartridge holder firmly back into the stapler unit until the cartridge holder clicks into place.

8 Close the stapler door.

9 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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Troubleshooting

Understanding the printer messages

Cartridge, imaging unit mismatch [41.xy]
1 Check if the toner cartridge and imaging unit are both MICR (Magnetic Imaging Content Recording) or non-MICR

supplies.

Note: For a list of supported supplies, contact the place where you purchased the printer.

2 Change the toner cartridge or imaging unit so that both are MICR or non‑MICR supplies.

Notes:

• Use MICR toner cartridge and imaging unit for printing checks and other similar documents.

• Use non-MICR toner cartridge and imaging unit for regular print jobs.

Cartridge low [88.xy]

You may need to order a toner cartridge. Press  to clear the message and continue printing.

Cartridge nearly low [88.xy]

If necessary, press  on the printer control panel to clear the message and continue printing.

Cartridge very low [88.xy]
You may need to replace the toner cartridge very soon. For more information, see the “Replacing supplies” section of
the User’s Guide.

If necessary, press  to clear the message and continue printing.

Change [paper source] to [custom string] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the printer control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Cancel the print job.
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Change [paper source] to [custom type name] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the printer control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Change [paper source] to [paper size] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the printer control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Change [paper source] to [paper type] [paper size] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the printer control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Check tray [x] connection
Try one or more of the following:

• Turn off the printer, and then turn it back on.

If the error occurs a second time, then:

1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the specified tray.

4 Reattach the tray.

5 Connect the power cord to a properly grounded electrical outlet.

6 Turn the printer back on.

If the error occurs again, then:

1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the tray.

4 Contact technical support.

• From the printer control panel, press  to clear the message and continue printing.
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Close door or insert cartridge
The toner cartridge is missing or not installed properly. Insert the cartridge, and then close all doors and covers.

Close front door
Close the front door of the printer.

Complex page, some data may not have printed [39]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Reduce the number and size of fonts, the number and complexity of images, and the number of pages in the print
job.

• Cancel the print job.

• Install additional printer memory.

Configuration change, some held jobs were not restored [57]
Held jobs are unavailable because of any of the following possible changes in the printer:

• The printer firmware has been updated.

• The tray for the print job is removed.

• The print job is sent from a flash drive that is no longer attached to the USB port.

• The printer hard disk contains print jobs that were stored when the hard disk was installed in a different printer
model.

From the printer control panel, press  to clear the message and continue printing.

Defective flash detected [51]
Try one or more of the following:

• Replace the defective flash memory card.

• From the printer control panel, press  to ignore the message and continue printing.

• Cancel the current print job.

Disk full [62]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Delete fonts, macros, and other data stored in the printer hard disk.

• Install a printer hard disk with larger capacity.

Troubleshooting 174



Disk must be formatted for use in this device
From the printer control panel, select Format disk to format the printer hard disk and clear the message.

Note: Formatting deletes all the files stored in the printer hard disk.

Disk near full. Securely clearing disk space.
Try one or more of the following:

• From the printer control panel, press  to clear the message.

• Delete fonts, macros, and other data stored in the printer hard disk.

• Install a printer hard disk with higher capacity.

Empty the hole punch box
1 Empty the hole punch box.

For more information, see the “Cleaning the printer” section of the User’s Guide.

2 Reinsert the hole punch box into the finisher, and then press  on the printer control panel to clear the message.

Error reading USB drive. Remove USB.
An unsupported USB device is inserted. Remove the USB device, and then insert a supported one.

Error reading USB hub. Remove hub.
An unsupported USB hub has been inserted. Remove the USB hub, and then install a supported one.

Imaging unit low [84.xy]

You may need to order an imaging unit. If necessary, press to clear the message and continue printing.

Imaging unit nearly low [84.xy]

If necessary, press  on the printer control panel to clear the message and continue printing.

Imaging unit very low [84.xy]
You may need to replace the imaging unit very soon. For more information, see the "Replacing supplies" section of the
User’s Guide.

If necessary, press  to clear the message and continue printing.
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Incompatible output bin [x] [59]
Do either of the following:

• Remove the specified bin.

• From the printer control panel, press  to clear the message and continue printing without using the specified
bin.

Incompatible tray [x] [59]
Do either of the following:

• Remove the specified tray.

• From the printer control panel, press  to clear the message and continue printing without using the specified
tray.

Incorrect paper size, open [paper source] [34]
Try one or more of the following:

• Load the correct size of paper in the tray.

• From the printer control panel, press  to clear the message and print using a different tray.

• Check the tray length and width guides and make sure the paper is loaded properly in the tray.

• Make sure the correct paper size and type are specified in Print Properties or in the Print dialog.

• Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Make sure the paper size is correctly set. For example, if the MP Feeder Size is set to Universal, then make sure the
paper is large enough for the data being printed.

• Cancel the print job.

Insert hole punch box

Insert the hole punch box into the finisher, and then press  on the printer control panel to clear the message.

Insert staple cartridge
Do either of the following:

• Insert a staple cartridge. For more information, see the instruction sheet that came with the supply.

• From the printer control panel, press  to clear the message and print without using the staple finisher.

Insert Tray [x]
Insert the indicated tray into the printer.
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Install bin [x]
Try one or more of the following:

• Install the specified bin:

1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Install the specified bin.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

• Cancel the print job.

• Reset active bin

Install Tray [x]
Try one or more of the following:

• Install the specified tray:

1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Install the specified tray.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

• Cancel the print job.

• Reset the active bin.

Insufficient memory for Flash Memory Defragment operation [37]
Try one or more of the following:

• From the printer control panel, press  to stop the defragmentation and continue printing.

• Delete fonts, macros, and other data in the printer memory. From the printer control panel, navigate to:

 > Settings >  > Settings >  >Print Settings >  > Utilities Menu >  > Format Flash >  > Yes >

• Install additional printer memory.

Insufficient memory, some Held Jobs were deleted [37]

From the printer control panel, press  to clear the message.
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Insufficient memory, some held jobs will not be restored [37]
Do either of the following:

• From the printer control panel, press  to clear the message.

• Delete other held jobs to free up additional printer memory.

Insufficient memory to collate job [37]
Try one or more of the following:

• From the printer control panel, press  to print the portion of the job already stored and begin collating the rest
of the print job.

• Cancel the current print job.

Insufficient memory to support Resource Save feature [35]
Try one or more of the following:

• From the printer control panel, press  to disable Resource Save, clear the message, and continue printing.

• Install additional printer memory.

Load staples
Try one or more of the following:

• Replace or insert the specified staple cartridge in the finisher.

For more information, see the “Replacing supplies” section of the User’s Guide.

• From the printer control panel, press  to clear the message and continue printing.

• Cancel the print job.

Load [paper source] with [custom string] [orientation]
Try one or more of the following:

• Load the indicated tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.
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Load [paper source] with [custom type name] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.

Load [paper source] with [paper size] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct paper size, then it feeds from that tray. If the printer cannot
find a tray that has the correct size of paper, then it prints from the default paper source.

• Cancel the current job.

Load [paper source] with [paper type] [paper size] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.

Load Manual Feeder with [custom string] [orientation]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the feeder, then the printer manually overrides the request, and then prints from
an automatically selected tray.

• Cancel the current job.
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Load Manual Feeder with [custom type name] [orientation]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the feeder, then the printer manually overrides the request, and then prints from
an automatically selected tray.

• Cancel the current job.

Load Manual Feeder with [paper size] [orientation]
Try one or more of the following:

• Load the feeder with the correct size of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the feeder, then the printer manually overrides the request, and then prints from
an automatically selected tray.

• Cancel the current job.

Load Manual Feeder with [paper type] [paper size] [orientation]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the feeder, then the printer manually overrides the request, and then prints from
an automatically selected tray.

• Cancel the current job.

Maintenance kit low [80.xy]
You may need to order a maintenance kit. Contact technical support or your Dell printer dealer, and then report the

message. If necessary, press  on the printer control panel to clear the message and continue printing.

Maintenance kit nearly low [80.xy]
For more information, contact technical support or your Dell printer dealer, and then report the message. If necessary,

press  on the printer control panel to clear the message and continue printing.
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Maintenance kit very low [80.xy]
You may need to order a maintenance kit very soon. For more information, contact technical support or your Dell

printer dealer, and then report the message. If necessary, press  on the printer control panel to clear the message
and continue printing.

Memory full [38]
Try one or more of the following:

• From the printer control panel, press  to clear the message.

• Decrease the resolution setting.

• Install additional printer memory.

Network [x] software error [54]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Unplug the router, then wait for 30 seconds, and then plug it back again.

• Turn off the printer, wait for about 10 seconds, and then turn the printer back on.

• Update the network firmware in the printer or the print server. For more information, contact your system support
person.

Non‑Dell [supply type], see User’s Guide [33.xy]
Note: The supply type can be toner cartridge or imaging unit.

The printer has detected a non‑Dell supply or part installed in the printer.

Your Dell printer is designed to function best with genuine Dell supplies and parts. Use of third-party supplies or parts
may affect the performance, reliability, or life of the printer and its imaging components.

All life indicators are designed to function with Dell supplies and parts and may deliver unpredictable results if third-
party supplies or parts are used. Imaging component usage beyond the intended life may damage your Dell printer or
associated components.

Warning—Potential Damage: Use of third-party supplies or parts can affect warranty coverage. Damage caused by
the use of third-party supplies or parts may not be covered by the warranty.

To accept any and all of these risks and to proceed with the use of non-genuine supplies or parts in your printer,

press  and  simultaneously for 15 seconds to clear the message and continue printing.

If you do not wish to accept these risks, then remove the third-party supply or part from your printer, and then install
a genuine Dell supply or part.

Note: For the list of supported supplies, see the “Ordering supplies” section of the User's Guide or visit
http://support.dell.com.
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Not enough free space in flash memory for resources [52]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Delete fonts, macros, and other data stored in the flash memory.

From the printer control panel, navigate to:

 > Settings >  > Settings >  > Print Settings >  > Utilities Menu >  > Format Flash >  >

Yes > 

• Use a larger‑capacity flash memory card.

Note: Downloaded fonts and macros that are not stored in the flash memory are deleted when the printer is turned
off or restarted.

PPDS font error [50]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• If the printer cannot find the requested font, then navigate to:

 > Settings >  > Settings > Print Settings >  > PPDS menu >  > Best Fit >  > On > 

The printer finds a similar font and reformats the affected text.

• Cancel the current print job.

Paper changes needed
Try one or more of the following:

• From the printer control panel, select Prompt for each page to continue printing.

• Select Use current supplies to continue printing using the paper loaded in the tray.

• Cancel the current print job.

Parallel port [x] disabled [56]
Do either of the following:

• From the printer control panel, select Continue to clear the message and continue printing.

The printer discards any data received through the parallel port.

• Select Reset active bin to reset the bin for a linked set of bins.
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Reattach bin [x]
Try one or more of the following:

• Turn off the printer, and then turn it back on.

• Reattach the specified bin.

1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the specified bin.

4 Reattach the bin.

5 Connect the power cord to a properly grounded electrical outlet.

6 Turn the printer back on.

• Remove the specified bin:

1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the specified bin.

4 Contact technical support.

• From the printer control panel, press  to clear the message and print without using the specified bin.

Reattach bins [x] – [y]
Try one or more of the following:

• Turn off the printer, and then turn it back on.

• Reattach the specified bins:

1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the specified bins.

4 Reattach the bins.

5 Connect the power cord to a properly grounded electrical outlet.

6 Turn the printer back on.

• Remove the specified bins:

1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the specified bins.

4 Contact technical support.

From the printer control panel, press  to clear the message and print without using the specified bins.
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Reinstall missing or unresponsive cartridge [31.xy]
Try one or more of the following:

• Check if the toner cartridge is missing. If missing, install the toner cartridge.

For information on installing the cartridge, see the “Replacing supplies” section of the User’s Guide.

• If the toner cartridge is installed, then remove the unresponsive toner cartridge, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the cartridge is defective. Replace the toner
cartridge.

Reinstall missing or unresponsive fuser [31.xy]
Try one or more of the following:

• Remove the unresponsive fuser, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the fuser is defective. Replace the fuser.

• Install the missing fuser.

For more information on installing the fuser, see the instruction sheet that came with the part.

Reinstall missing or unresponsive imaging unit [31.xy]
Try one or more of the following:

• Check if the imaging unit is missing. If missing, install the imaging unit.

For information on installing the imaging unit, see the “Replacing supplies” section of the User’s Guide.

• If the imaging unit is installed, then remove the unresponsive imaging unit, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the imaging unit is defective. Replace the
imaging unit.

Remove defective disk [61]
Remove and replace the defective printer hard disk.

Remove packaging material, [area name]
1 Remove any remaining packaging material from the specified location.

2 From the printer control panel, press  to clear the message and continue printing.

Remove paper from all bins
Remove paper from all bins to clear the message and continue printing.

Note: If removing the paper does not clear the message, then select Continue on the printer control panel.
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Remove paper from bin [x]
Remove paper from the specified bin to clear the message and continue printing.

Note: If removing the paper does not clear the message, then select Continue on the printer control panel.

Remove paper from [linked set bin name]
Remove paper from the specified bin to clear the message and continue printing.

If removing the paper does not clear the message, then select Continue on the printer control panel.

Remove paper from standard output bin
Remove the paper stack from the standard bin.

Replace cartridge, 0 estimated pages remain [88.xy]
Replace the toner cartridge to clear the message and continue printing. For more information, see the instruction sheet
that came with the supply or see the “Replacing supplies” section of the User’s Guide.

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit our Web site.

Replace defective imaging unit [31.xy]
Replace the defective imaging unit to clear the message. For more information, see the instruction sheet that came
with the supply.

Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the User’s Guide or
visit our Web site.

Replace imaging unit, 0 estimated pages remain [84.xy]
Replace the imaging unit to clear the message and continue printing. For more information, see the instruction sheet
that came with the supply or see the “Replacing supplies” section of the User’s Guide.

Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the User’s Guide or
visit our Web site.

Replace maintenance kit, 0 estimated pages remain [80.xy]
Contact technical support or your Dell printer dealer, and then report the message. The printer is scheduled for
maintenance.

Replace missing cartridge [31.xy]
Install the missing toner cartridge to clear the message. For more information, see the “Replacing supplies” section of
the User’s Guide.
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Replace missing fuser [31.xy]
Install the missing fuser. For more information, see the instruction sheet that came with the part.

Replace missing imaging unit [31.xy]
Install the missing imaging unit to clear the message. For more information, see the “Replacing supplies” section of the
User’s Guide.

Replace unsupported cartridge [32.xy]
Remove the toner cartridge, and then install a supported one to clear the message and continue printing. For more
information, see the instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s
Guide.

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit our Web site.

Replace unsupported fuser [32.xy]
Remove the fuser, and then install a supported one. For more information, see the instruction sheet that came with
the part.

Replace unsupported imaging unit [32.xy]
Remove the imaging unit, and then install a supported one to clear the message and continue printing. For more
information, see the instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s
Guide.

Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the User’s Guide or
visit our Web site.

Restore held jobs?
Do either of the following:

• Select Restore on the printer control panel to restore all held jobs stored in the printer hard disk.

• Select Do not restore if you do not want any print jobs to be restored.

Serial port [x] disabled [56]
Try one or more of the following:

• From the printer control panel, select Continue to clear the message.

The printer discards any data received through the specified serial port.

• Select Reset active bin to reset the active bin for a linked set of bins.

• Make sure the Serial Buffer menu is set to Enabled.
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Some held jobs were not restored
From the printer control panel, select Continue to clear the message and continue printing.

Note: Held jobs that are not restored remain in the printer hard disk and are inaccessible.

Standard network software error [54]
Try one or more of the following:

• From the printer control panel, press  to confirm.

• Unplug the router, then wait for 30 seconds, and then plug it back again.

• Turn off the printer, and then turn it back on.

• Update the network firmware in the printer or print server. For more information, contact your system support
person.

Standard USB port disabled [56]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

Note: The printer discards any data received through the USB port.

• From the printer control panel, set USB Buffer to Auto.

Supply needed to complete job
A supply needed to complete the job is missing. Cancel the current job.

Too many bins attached [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra bins.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Too many disks installed [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra printer hard disks.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.
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Too many flash options installed [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra flash memory.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Too many trays attached [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra trays.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Tray [x] paper size unsupported
The paper size in the specified tray is unsupported. Replace it with a supported paper size.

Unformatted flash detected [53]
Try one or more of the following:

• From the printer control panel, press  to stop the defragmentation and continue printing.

• Format the flash memory device.

Note: If the error message remains, then the flash memory device may be defective and need to be replaced.

Unsupported disk
An unsupported disk has been inserted. Remove the unsupported disk, and then install a supported one.

Unsupported option in slot [x] [55]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the unsupported option card from the printer controller board, and then replace it with a supported card.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.
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USB port [x] disabled [56]
Try one or more of the following:

• From the printer control panel, select Continue to clear the message and continue printing.

The printer discards any data received through the specified serial port.

• Select Reset active bin to reset the active bin for a linked set of bins.

• Make sure the USB Buffer menu is enabled.

Solving printer problems
• “Basic printer problems” on page 189

• “Hardware and internal option problems” on page 191

• “Paper feed problems” on page 195

Basic printer problems

The printer is not responding

Action Yes No

Step 1

Make sure the printer is turned on.

Is the printer turned on?

Go to step 2. Turn on the printer.

Step 2

Check if the printer is in Sleep mode or Hibernate mode.

Is the printer in Sleep mode or Hibernate mode?

Press the Sleep button
to wake the printer
from Sleep mode or
Hibernate mode.

Go to step 3.

Step 3

Check if one end of the power cord is plugged into the printer and the
other to a properly grounded electrical outlet.

Is the power cord plugged into the printer and a properly grounded
electrical outlet?

Go to step 4. Plug one end of the
power cord into the
printer and the other to
a properly grounded
electrical outlet.

Step 4

Check other electrical equipment plugged into the electrical outlet.

Does other electrical equipment work?

Unplug the other
electrical equipment,
and then turn on the
printer. If the printer
does not work, then
reconnect the other
electrical equipment.

Go to step 5.
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Action Yes No

Step 5

Check if the cables connecting the printer and the computer are inserted
in the correct ports.

Are the cables inserted in the correct ports?

Go to step 6. Make sure to match the
following:

• The USB symbol on
the cable with the
USB symbol on the
printer

• The appropriate
Ethernet cable with
the Ethernet port

Step 6

Make sure the electrical outlet is not turned off by a switch or breaker.

Is the electrical outlet turned off by a switch or breaker?

Turn on the switch or
reset the breaker.

Go to step 7.

Step 7

Check if the printer is plugged into any surge protectors, uninterruptible
power supplies, or extension cords.

Is the printer plugged into any surge protectors, uninterruptible power
supplies, or extension cords?

Connect the printer
power cord directly to
a properly grounded
electrical outlet.

Go to step 8.

Step 8

Check if one end of the printer cable is plugged into a port on the printer
and the other to the computer, print server, option, or other network
device.

Is the printer cable securely attached to the printer and the computer,
print server, option, or other network device?

Go to step 9. Connect the printer
cable securely to the
printer and the
computer, print server,
option, or other
network device.

Step 9

Make sure to install all hardware options properly and remove any packing
material.

Are all hardware options properly installed and all packing material
removed?

Go to step 10. Turn off the printer,
remove all packing
materials, then
reinstall the hardware
options, and then turn
on the printer.

Step 10

Check if you have selected the correct port settings in the printer driver.

Are the port settings correct?

Go to step 11. Use correct printer
driver settings.

Step 11

Check the installed printer driver.

Is the correct printer driver installed?

Go to step 12. Install the correct
printer driver.

Step 12

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Is the printer working?

The problem is solved. Contact technical
support.
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Printer display is blank

Action Yes No

Step 1

Press the Sleep button on the printer control panel.

Does Ready appear on the printer display?

The problem is solved. Go to step 2.

Step 2

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Do Please wait and Ready appear on the printer display?

The problem is solved. Turn off the printer,
and then contact
technical support.

Hardware and internal option problems

2100-sheet tray problems

Action Yes No

Step 1

a Pull out the tray, and then do one or more of the following:

• Make sure paper lies flat in the tray.

• Check for paper jams or misfeeds.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• Check if the paper guides are aligned against the edges of the
paper.

• Make sure the paper is below the maximum paper fill indicator.

• Check if you are printing on a recommended paper size and type.

• Check if the paper or specialty media meets specifications and is
not damaged.

b Insert the tray properly.

Note: Press the paper stack down while inserting the tray.

Does the tray operate properly?

The problem is solved. Go to step 2.

Step 2

Turn off the printer, then wait about 10 seconds, and then turn it back on.

Does the tray operate properly?

The problem is solved. Go to step 3.

Step 3

Print a menu settings page, and then check if the tray is listed in the
Installed Features list.

Note: If the tray is listed in the menu settings page, but paper jams
when it enters or exits the tray, then it may not be properly installed.

Is the tray listed in the menu settings page?

Go to step 4. For more information,
see the setup sheet
that came with the
2100-sheet tray.
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Action Yes No

Step 4

Check if the tray is available in the printer driver.

Note: You may need to manually add the tray in the printer driver to
make it available for print jobs. For more information, see “Updating
available options in the printer driver” on page 35.

Is the tray available in the printer driver?

Go to step 5. Manually add the tray
in the printer driver.

Step 5

Check if the tray is selected.
From the application you are using, select the tray. If you are using
Mac OS X version 9, then make sure the printer is set up in Chooser.

Does the tray operate properly?

The problem is solved. Contact technical
support.

Cannot detect internal option

Action Yes No

Step 1

Turn off the printer, then wait for about 10 seconds, and then turn on the
printer.

Does the internal option operate correctly?

The problem is solved. Go to step 2.

Step 2

Check if the internal option is properly installed in the controller board.

a Turn off the printer using the power switch, and then unplug the power
cord from the electrical outlet.

b Make sure the internal option is installed in the appropriate connector
in the controller board.

c Connect the power cord to the printer, then to a properly grounded
electrical outlet, and then turn on the printer.

Is the internal option properly installed in the controller board?

Go to step 3. Connect the internal
option to the controller
board.

Step 3

Print a menu settings page, and then check to see if the internal option is
listed in the Installed Features list.

Is the internal option listed in the menu settings page?

Go to step 4. Reinstall the internal
option.
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Action Yes No

Step 4

a Check if the internal option is selected.

It may be necessary to manually add the internal option in the printer
driver to make it available for print jobs. For more information, see
“Updating available options in the printer driver” on page 35.

b Resend the print job.

Does the internal option operate correctly?

The problem is solved. Contact technical
support.

Internal print server does not operate correctly

Action Yes No

Step 1

Reinstall the internal print server.

a Remove, and then install the internal print server. For more
information, see “Installing an Internal Solutions Port” on page 19.

b Print a menu settings page, and then check if the internal print server
is listed in the Installed Features list.

Is the internal print server listed in the Installed Features list?

Go to step 2. Check if the internal
print server is
supported by the
printer.

Note: An internal print
server from another
printer may not work
with this printer.

Step 2

Check the cable and the internal print server connection.
Use the correct cable, and then check if it is securely connected to the
internal print server.

Does the internal print server operate correctly?

The problem is solved. Contact technical
support.

Tray problems

Action Yes No

Step 1

a Open the tray and do one or more of the following:

• Check for paper jams or misfeeds.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• If you are printing on custom‑size paper, then make sure that the
paper guides rest against the edges of the paper.

• Make sure the paper is below the maximum paper fill indicator.

• Make sure paper lies flat in the tray.

b Check if the tray closes properly.

Is the tray working?

The problem is solved. Go to step 2.
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Action Yes No

Step 2

a Turn off the printer, then wait about 10 seconds, and then turn the
printer back on.

b Resend the print job.

Is the tray working?

The problem is solved. Go to step 3.

Step 3

Check if the tray is installed and recognized by the printer.
Print a menu settings page, and then check if the tray is listed in the
Installed Features list.

Is the tray listed in the menu settings page?

Go to step 4. Reinstall the tray. For
more information, see
the setup
documentation that
came with the tray.

Step 4

Check if the tray is available in the printer driver.

Note: If necessary, manually add the tray in the printer driver to make it
available for print jobs. For more information, see “Updating available
options in the printer driver” on page 35.

Is the tray available in the printer driver?

Go to step 5. Manually add the tray
in the printer driver.

Step 5

Check if the option is selected.

a From the application you are using, select the option. For Mac OS X
version 9 users, make sure the printer is set up in Chooser.

b Resend the print job.

Is the tray working?

The problem is solved. Contact technical
support.

Internal Solutions Port does not operate correctly

Action Yes No

Step 1

Make sure the Internal Solutions Port (ISP) is installed.

a Install the ISP. For more information, see “Installing an Internal
Solutions Port” on page 19.

b Print a menu settings page, and then check if the ISP is listed in the
Installed Features list.

Is the ISP listed in the Installed Features list?

Go to step 2. Check if you have a
supported ISP.

Note: An ISP from
another printer may
not work on this
printer.
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Action Yes No

Step 2

Check the cable and the ISP connection.

a Use the correct cable, and then make sure it is securely connected to
the ISP.

b Check if the ISP solution interface cable is securely connected into the
receptacle of the controller board.

Note: The ISP solution interface cable and the receptacle on the
controller board are color‑coded.

Does the Internal Solutions Port operate correctly?

The problem is solved. Contact technical
support.

USB/parallel interface card does not operate correctly

Action Yes No

Step 1

Make sure the USB or parallel interface card is installed.

a Install the USB or parallel interface card. For more information, see
“Installing an Internal Solutions Port” on page 19.

b Print a menu settings page, and then check if the USB or parallel
interface card is listed in the Installed Features list.

Is the USB or parallel interface card listed in the Installed Features list?

Go to step 2. Check if you have a
supported USB or
parallel interface card.

Note: A USB or parallel
interface card from
another printer may
not work on this
printer.

Step 2

Check the cable and the USB or parallel interface card connection.
Use the correct cable, and then make sure it is securely connected to
the USB or parallel interface card.

Does the USB or parallel interface card operate correctly?

The problem is solved. Contact technical
support.

Paper feed problems

Jammed pages are not reprinted

Action Yes No

a Turn on jam recovery.

1 From the printer control panel, navigate to:

Settings >  > General Settings >  > Print Recovery >  >
Jam Recovery

2 Press the left or right arrow button to scroll to On or Auto, and

then press .

b Resend the pages that did not print.

Were the jammed pages reprinted?

The problem is solved. Contact technical
support.
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Paper frequently jams

Action Yes No

Step 1

a Pull out the tray, and then do one or more of the following:

• Make sure paper lies flat in the tray.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• Check if the paper guides are aligned against the edges of the
paper.

• Make sure the paper is below the maximum paper fill indicator.

• Check if you are printing on a recommended paper size and type.

b Insert the tray properly.

If jam recovery is enabled, then the print jobs will reprint
automatically.

Do paper jams still occur frequently?

Go to step 2. The problem is solved.

Step 2

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do paper jams still occur frequently?

Go to step 3. The problem is solved.

Step 3

a Review the tips on avoiding jams. For more information, see “Avoiding
jams” on page 152.

b Follow the recommendations, and then resend the print job.

Do paper jams still occur frequently?

Contact technical
support.

The problem is solved.

Paper jam message remains after jam is cleared

Action Yes No

a From the printer control panel, navigate to:

Next >  > Clear the jam, press OK > 

b Follow the instructions on the printer display.

Does the paper jam message remain?

Contact technical
support.

The problem is solved.
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Solving print problems

Printing problems

Confidential and other held jobs do not print

Action Yes No

Step 1

a From the printer control panel, open the Held Jobs folder, and then
verify that your print job is listed.

b Resend the print job.

For more information, see “Printing confidential and other held jobs”
on page 76.

Did the jobs print?

The problem is solved. Go to step 2.

Step 2

Do one or more of the following:

• Delete the print job, and then resend it.

• If you are printing PDF files, then generate a new file, and then print
it again.

Did the jobs print?

The problem is solved. Go to step 3.

Step 3

a Increase the printer memory. Do one or more of the following:

• Delete some print jobs.

• Install additional printer memory.

b Resend the print job.

Did the jobs print?

The problem is solved. Contact technical
support.

Envelope seals when printing

Action Yes No

a Use envelopes that have been stored in a dry environment.

Note: Printing on envelopes with high moisture content can seal the
flaps.

b Resend the print job.

Does the envelope seal when printing?

Contact technical
support.

The problem is solved.
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Error message about reading the flash drive appears

Action Yes No

Step 1

Check if the flash drive is inserted into the front USB port.

Note: The flash drive will not work if it is inserted into the rear USB
port.

Is the flash drive inserted into the front USB port?

Go to step 2. Insert the flash drive
into the front USB port.

Step 2

Check if the indicator light on the printer control panel is blinking green.

Note: A green blinking light indicates that the printer is busy.

Is the indicator light blinking green?

Wait until the printer is
ready, then view the
held jobs list, and then
print the documents.

Go to step 3.

Step 3

a Check for an error message on the display.

b Clear the message.

Does the error message still appear?

Go to step 4. The problem is solved.

Step 4

Check if the flash drive is supported.
For more information on tested and approved USB flash drives, see
“Supported flash drives and file types” on page 73.

Does the error message still appear?

Go to step 5. The problem is solved.

Step 5

Check if the USB port is disabled by the system support person.

Does the error message still appear?

Contact technical
support.

The problem is solved.

Incorrect characters print

Action Yes No

Step 1

Make sure the printer is not in Hex Trace mode.

Note: If Ready Hex appears on the printer display, then turn off the
printer, and then turn it back on to deactivate Hex Trace mode.

Is the printer in Hex Trace mode?

Deactivate Hex Trace
mode.

Go to step 2.

Step 2

a From the printer control panel, select Standard Network or
Network [x], and then set SmartSwitch to On.

b Resend the print job.

Do incorrect characters print?

Contact technical
support.

The problem is solved.
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Job prints from the wrong tray or on the wrong paper

Action Yes No

Step 1

a Check if you are printing on paper that is supported by the tray.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 2.

Step 2

a From the Paper menu on the printer control panel, set the paper size
and type to match the paper loaded in the tray.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 3.

Step 3

a Depending on your operating system, open Printing Preferences or
the Print dialog, and then specify the paper type.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 4.

Step 4

a Check if the trays are not linked.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Contact technical
support.

Large jobs do not collate

Action Yes No

Step 1

a From the Finishing menu on the printer control panel, set Collate to
(1,2,3) (1,2,3).

b Resend the print job.

Did the job print and collate correctly?

The problem is solved. Go to step 2.

Step 2

a From the printer software, set Collate to (1,2,3) (1,2,3).

Note: Setting Collate to (1,1,1) (2,2,2) in the software overrides the
setting in the Finishing menu.

b Resend the print job.

Did the job print and collate correctly?

The problem is solved. Go to step 3.
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Action Yes No

Step 3

Reduce the complexity of the print job by eliminating the number and size
of fonts, the number and complexity of images, and the number of pages
in the job.

Did the job print and collate correctly?

The problem is solved. Contact technical
support.

Multiple‑language PDF files do not print

Action Yes No

Step 1

a Check if the print options for the PDF output are set to embed all fonts.

b Generate a new PDF file, and then resend the print job.

Do the files print?

The problem is solved. Go to step 2.

Step 2

a Open the document you want to print in Adobe Acrobat.

b Click File > Print > Advanced > Print As Image > OK > OK.

Do the files print?

The problem is solved. Contact technical
support.

Print job takes longer than expected

Action Yes No

Step 1

Change the environmental settings of the printer.

a From the printer control panel, navigate to:

Settings > General Settings

b Select Eco‑Mode or Quiet Mode, and then select Off.

Note: Disabling Eco-Mode or Quiet Mode may increase the
consumption of energy or supplies, or both.

Did the job print?

The problem is solved. Go to step 2.

Step 2

Reduce the number and size of fonts, the number and complexity of
images, and the number of pages in the print job, and then resend the job

Did the job print?

The problem is solved. Go to step 3.

Step 3

a Remove held jobs stored in the printer memory.

b Resend the print job.

Did the job print?

The problem is solved. Go to step 4.
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Action Yes No

Step 4

a Disable the Page Protect feature.

From the printer control panel, navigate to:

Settings > General Settings > Print Recovery > Page Protect > Off

b Resend the print job.

Did the job print?

The problem is solved. Go to step 5.

Step 5

Install additional printer memory, and then resend the print job.

Did the job print?

The problem is solved. Contact technical
support.

Print jobs do not print

Action Yes No

Step 1

a From the document you are trying to print, open the Print dialog and
check if you have selected the correct printer.

Note: If the printer is not the default printer, then you must select
the printer for each document that you want to print.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 2.

Step 2

a Check if the printer is plugged in and turned on, and if Ready appears
on the printer display.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 3.

Step 3

If an error message appears on the printer display, then clear the message.

Note: The printer continues to print after clearing the message.

Do the jobs print?

The problem is solved. Go to step 4.

Step 4

a Check if the ports (USB, serial, or Ethernet) are working and if the
cables are securely connected to the computer and the printer.

Note: For more information, see the setup documentation that
came with the printer.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 5.
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Action Yes No

Step 5

a Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 6.

Step 6

a Remove, and then reinstall the printer software. For more
information, see “Installing the printer software” on page 34.

Note: For more information, visit http://support.dell.com.

b Resend the print job.

Do the jobs print?

The problem is solved. Contact technical
support.

Printing slows down

Notes:

• When printing using narrow paper, the printer prints at a reduced speed to prevent damage to the fuser.

• The printer speed may be reduced when printing for long periods of time, or printing at elevated temperatures.

Action Yes No

a Make sure the size of the paper loaded in the tray matches the fuser
type.

Note: To identify the fuser type, view the label on the fuser.

b Resend the print job.

Does the print speed increase?

The problem is solved. Contact technical
support or your Dell
printer dealer.

Tray linking does not work

Notes:

• The trays can detect paper length.

• The multipurpose feeder does not automatically detect the paper size. You must set the size from the Paper
Size/Type menu.
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Action Yes No

Step 1

a Open the trays, and then check if they contain paper of the same size
and type.

• Check if the paper guides are in the correct positions for the size
of the paper loaded in each tray.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

b Resend the print job.

Do the trays link correctly?

The problem is solved. Go to step 2.

Step 2

a From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the trays to be linked.

Note: The paper size and type must match for trays to be linked.

b Resend the print job.

Do the trays link correctly?

The problem is solved. Contact technical
support.

Unexpected page breaks occur

Action Yes No

Step 1

Adjust the print timeout settings.

a From the printer control panel, navigate to:

Settings > General Settings > Timeouts > Print Timeout

b Select a higher setting, and then press .

c Resend the print job.

Did the file print correctly?

The problem is solved. Go to step 2.

Step 2

a Check the original file for manual page breaks.

b Resend the print job.

Did the file print correctly?

The problem is solved. Contact technical
support.
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Print quality problems

Characters have jagged or uneven edges

Action Yes No

Step 1

a Print a font sample list to check if the fonts you are using are supported
by the printer.

1 From the printer control panel, navigate to:

Menus > Reports > Print Fonts

2 Select PCL Fonts or PostScript Fonts.

b Resend the print job.

Are you using fonts that are supported by the printer?

Go to step 2. Select a font that is
supported by the
printer.

Step 2

Check if the fonts installed on the computer are supported by the printer.

Are the fonts installed on the computer supported by the printer?

The problem is solved. Contact technical
support.

Clipped pages or images

Leading edge

Trailing edge

ABCDE
ABCDE
ABCDE

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the paper loaded.

b Resend the print job.

Is the page or image clipped?

Go to step 2. The problem is solved.
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Action Yes No

Step 2

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.

Do the paper size and type match the paper loaded in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.

Step 3

a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.

b Resend the print job.

Is the page or image clipped?

Go to step 4. The problem is solved.

Step 4

a Reinstall the imaging unit.

1 Remove the toner cartridge.

2 Remove the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the page or image clipped?

Contact technical
support.

The problem is solved.

Compressed images appear on prints

Action Yes No

a Make sure the size of the paper loaded in the tray matches the fuser
type.

Note: To identify the fuser type, view the label on the fuser.

b Resend the print job.

Do compressed images still appear?

Contact technical
support or your Dell
printer dealer.

The problem is solved.
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Gray background on prints

ABCDE

ABCDE
ABCDE

Leading edge

Trailing edge

Action Yes No

Step 1

a From the Quality Menu on the printer control panel, decrease the
toner darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Did the gray background disappear from the prints?

The problem is solved. Go to step 2.

Step 2

Reinstall the imaging unit and the toner cartridge.

a Remove the toner cartridge.

b Remove the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to light
can cause print quality problems.

c Install the imaging unit, and then the cartridge.

d Resend the print job.

Did the gray background disappear from the prints?

The problem is solved. Go to step 3.

Step 3

Replace the imaging unit, and then resend the print job.

Did the gray background disappear from the prints?

The problem is solved. Contact technical
support.

Horizontal voids appear on prints

Leading edge

Trailing edge
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Action Yes No

Step 1

a Make sure your software program is using a correct fill pattern.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 2. The problem is solved.

Step 2

a Load the specified tray or feeder with a recommended type of paper.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 3. The problem is solved.

Step 3

a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 4. The problem is solved.

Step 4

Replace the imaging unit, and then resend the print job.

Do horizontal voids appear on prints?

Contact technical
support.

The problem is solved.

Incorrect margins on prints

ABC

DEF

ABC

DEF

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the paper size loaded.

b Resend the print job.

Are the margins correct?

The problem is solved. Go to step 2.
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Action Yes No

Step 2

From the printer control panel, set the paper size in the Paper menu to
match the paper loaded in the tray.

Does the paper size match the paper loaded in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.

Step 3

a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.

b Resend the print job.

Are the margins correct?

The problem is solved. Contact technical
support.

Paper curl

Action Yes No

Step 1

Move the width and length guides in the tray to the correct positions for
the size of the paper loaded.

Are the width and length guides positioned correctly?

Go to step 2. Adjust the width and
length guides.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Do the paper type and weight match the type and weight of the paper in
the tray?

Go to step 3. Specify the paper type
and weight from the
tray settings to match
the paper loaded in the
tray.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the paper still curled?

Go to step 4. The problem is solved.

Step 4

a Remove the paper from the tray, and then turn it over.

b Resend the print job.

Is the paper still curled?

Go to step 5. The problem is solved.
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Action Yes No

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the paper still curled?

Contact technical
support.

The problem is solved.

Print irregularities

) )ABCDE

ABCDE
ABCDE

Leading edge

Trailing edge

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded in the tray.

b Resend the print job.

Do print irregularities still appear?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.

Do the printer settings match the type and weight of the paper loaded in
the tray?

Go to step 3. Specify the paper size
and type from the tray
settings to match the
paper loaded in the
tray.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do print irregularities still appear?

Go to step 4. The problem is solved.

Step 4

Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded in the
tray.

Go to step 5.
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Action Yes No

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do print irregularities still appear?

Go to step 6. The problem is solved.

Step 6

Replace the imaging unit, and then resend the print job.

Do print irregularities still appear?

Contact technical
support or your Dell
printer dealer.

The problem is solved.

Print is too dark

ABC

DEF

ABC

DEF

Action Yes No

Step 1

a From the Quality menu on the printer control panel, reduce the toner
darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Is the print still too dark?

Go to step 2. The problem is solved.

Step 2

a From the printer control panel, set the paper type, texture and weight
in the Paper menu to match the paper loaded in the tray.

b Resend the print job.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 3. Do one or more of the
following:

• Specify the paper
type, texture, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the paper
loaded in the tray
to match the paper
type, texture and
weight specified in
the tray settings.
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Action Yes No

Step 3

a Depending on your operating system, specify the paper type, texture
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the print still too dark?

Go to step 4. The problem is solved.

Step 4

Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, change
the texture settings in
the Paper Texture
menu to match the
paper you are printing
on.

Go to step 5.

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the print still too dark?

Go to step 6. The problem is solved.

Step 6

Replace the imaging unit, and then resend the print job.

Is the print still too dark?

Contact technical
support.

The problem is solved.

Print is too light

ABC

DEF

Action Yes No

Step 1

a From the Quality menu on the printer control panel, increase the toner
darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Is the print still too light?

Go to step 2. The problem is solved.
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Action Yes No

Step 2

From the printer control panel, set the paper type, texture, and weight in
the Paper menu to match the paper loaded in the tray.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 3. Change the paper type,
texture, and weight to
match the paper
loaded in the tray.

Step 3

a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the print still too light?

Go to step 4. The problem is solved.

Step 4

Make sure that the paper has no texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, change
the texture settings in
the Paper Texture
menu to match the
paper you are printing
on.

Go to step 5.

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the print still too light?

Go to step 6. The problem is solved.

Step 6

a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the print still too light?

Go to step 7. The problem is solved.

Step 7

Replace the imaging unit, and then resend the print job.

Is the print still too light?

Contact technical
support.

The problem is solved.
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Printer is printing blank pages

Action Yes No

Step 1

a Check if there is packing material left on the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Check if the packing material is properly removed from the imaging
unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer still printing blank pages?

Go to step 2. The problem is solved.

Step 2

a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer still printing blank pages?

Go to step 3. The problem is solved.

Step 3

Replace the imaging unit, and then resend the print job.

Is the printer still printing blank pages?

Contact technical
support.

The problem is solved.
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Printer is printing solid black pages

Action Yes No

Step 1

a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer printing solid black pages?

Go to step 2. The problem is solved.

Step 2

Replace the imaging unit, and then resend the print job.

Is the printer printing solid black pages?

Contact technical
support.

The problem is solved.

Repeating defects appear on prints

)
)

)

)
)

)

Action Yes No

Step 1

a Replace the imaging unit if the distance between the defects is equal
to any of the following:

• 47.8 mm (1.88 in.)

• 96.8 mm (3.81 in.)

• 28.5 mm (1.12 in.)

b Resend the print job.

Do repeating defects still appear on prints?

Go to step 2. The problem is solved.
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Action Yes No

Step 2

a Replace the fuser if the distance between the defects is equal to either
of the following:

• 94.25 mm (3.71 in.)

• 95.2 mm (3.75 in.)

b Resend the print job.

Do repeating defects still appear on prints?

Contact technical
support.

The problem is solved.

Shadow images appear on prints

ABCD
ABCD
ABCD
ABCD

Leading edge

Trailing edge

Action Yes No

Step 1

Load paper with the correct paper type and weight in the tray.

Is paper with the correct paper type and weight loaded in the tray?

Go to step 2. Load paper with the
correct paper type and
weight in the tray.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Is the tray set to the type and weight of the paper loaded?

Go to step 3. Change the paper
loaded in the tray to
match the paper type
and weight specified in
the tray settings.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do shadow images still appear on prints?

Go to step 4. The problem is solved.

Step 4

Replace the imaging unit, and then resend the print job.

Do shadow images still appear on prints?

Contact technical
support.

The problem is solved.
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Skewed print

)
)ABCDE

ABCDEABCDE

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded.

b Resend the print job.

Is the print still skewed?

Go to step 2. The problem is solved.

Step 2

a Check if you are printing on a paper that is supported by the tray.

b Resend the print job.

Is the print still skewed?

Contact technical
support.

The problem is solved.

Streaked horizontal lines appear on prints

ABCDE
ABCDE
ABCDE

Action Yes No

Step 1

a Depending on your operating system, specify the tray or feeder from
Printing Preferences or the Print dialog.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Do the paper type and weight match the type and weight of the paper in
the tray?

Go to step 3. Change the paper type
and weight to match
the paper loaded in the
tray.
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Action Yes No

Step 3

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 4. The problem is solved.

Step 4

a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 5. The problem is solved.

Step 5

Replace the imaging unit, and then resend the print job.

Do streaked horizontal lines appear on prints?

Contact technical
support.

The problem is solved.

Streaked vertical lines appear on prints

ABCDE
ABCDE
ABCDE

Leading edge

Trailing edge

Action Yes No

Step 1

a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 2. The problem is solved.
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Action Yes No

Step 2

From the printer control panel, set the paper texture, type, and weight in
the Paper menu to match the paper loaded in the tray.

Do the paper texture, type, and weight match the paper in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
texture, type, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the paper
loaded in the tray
to match the paper
texture, type, and
weight specified in
the tray settings.

Step 3

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 4. The problem is solved.

Step 4

a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 5. The problem is solved.

Step 5

Replace the imaging unit, and then resend the print job.

Do streaked vertical lines appear on prints?

Contact technical
support or your Dell
printer dealer.

The problem is solved.
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Transparency print quality is poor

Action Yes No

Step 1

From the printer control panel, set the paper type in the Paper menu to
match the paper loaded in the tray.

Is the paper type for the tray set to Transparency?

Go to step 2. Set the paper type to
Transparency.

Step 2

a Check if you are using a recommended type of transparency.

b Resend the print job.

Is the print quality still poor?

Contact technical
support.

The problem is solved.

Toner specks appear on prints

Action Yes No

Replace the imaging unit, and then resend the print job.

Do toner specks appear on prints?

Contact technical
support.

The problem is solved.

Toner fog or background shading appears on prints

ABCDE

ABCDE
ABCDE

Action Yes No

Step 1

a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Did the toner fog or background shading disappear from the prints?

The problem is solved. Go to step 2.
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Action Yes No

Step 2

Replace the imaging unit, and then resend the print job.

Did the toner fog or background shading disappear from the prints?

The problem is solved. Contact technical
support.

Toner rubs off

Leading edge

Trailing edge

ABC

DEF

Action Yes No

Step 1

From the Paper menu on the printer control panel, check the paper type
and weight.

Do the paper type and weight match the paper loaded in the tray?

Go to step 2. Specify the paper type
and weight from the
tray settings to match
the paper loaded in the
tray.

Step 2

Check if you are printing on paper with texture or rough finishes.

Are you printing on textured or rough paper?

From the Paper menu
on the printer control
panel, set the paper
texture.

Go to step 3.

Step 3

a From the Paper Weight menu on the printer control panel, set Heavy
Weight to Heavy.

b Resend the print job.

Does the toner rub off?

Go to step 4. The problem is solved.

Step 4

a Enable Quiet mode.

From the printer control panel, navigate to:

Settings > General Settings > Quiet Mode > On

b Resend the print job.

Does the toner rub off?

Contact technical
support or your Dell
printer dealer.

The problem is solved.
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Uneven print density

Action Yes No

Replace the imaging unit, and then resend the print job.

Is the print density uneven?

Contact technical
support.

The problem is solved.

Vertical voids appear on prints

Leading edge

Trailing edge

Action Yes No

Step 1

a Make sure your software program is using a correct fill pattern.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 2. The problem is solved.

Step 2

a From the printer control panel, set the paper type and weight in the
Paper menu to match the paper loaded in the tray.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 3. The problem is solved.

Step 3

Check if you are using a recommended type of paper.

a Load the specified tray or feeder with a recommended type of paper.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 4. The problem is solved.
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Action Yes No

Step 4

a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 5. The problem is solved.

Step 5

Replace the imaging unit, and then resend the print job.

Do vertical voids appear on prints?

Contact technical
support.

The problem is solved.

Embedded Web Server does not open
Action Yes No

Step 1

Make sure the printer IP address is correct.
View the printer IP address:

• From the printer home screen

• From the TCP/IP section in the Network/Ports menu

• By printing a network setup page or menu settings page, and then
finding the TCP/IP section

Note: An IP address appears as four sets of numbers separated by
periods, such as 123.123.123.123.

Is the printer IP address correct?

Go to step 2. Type the correct
printer IP address in the
address field of your
Web browser.

Note: Depending on
the network settings,
you may need to type
“https://” instead of
“http://” before the
printer IP address to
access the Embedded
Web Server.

Step 2

Check if the printer is turned on.

Is the printer turned on?

Go to step 3. Turn on the printer.

Step 3

Check if the network connection is working.

Is the network connection working?

Go to step 4. Contact your system
support person.
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Action Yes No

Step 4

Make sure the cable connections to the printer and print server are secure.
For more information, see the setup documentation that came with
the printer.

Are the cable connections to the printer and print server secure?

Go to step 5. Tighten the cable
connection.

Step 5

Temporarily disable the Web proxy servers.

Note: Proxy servers may block or restrict you from accessing certain
Web sites including the Embedded Web Server.

Are the Web proxy servers disabled?

Go to step 6. Contact your system
support person.

Step 6

Access the Embedded Web Server again by typing the correct IP address
in the address field.

Did the Embedded Web Server open?

The problem is solved. Contact technical
support.

Contacting technical support
When you call technical support, describe the problem you are experiencing, the message on the display, and the
troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and the service tag number or express service code. For more information,
see the label at the back of the printer. The service tag number is listed on the menu settings page.

For more information, check the Dell Support Web site at http://support.dell.com.
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Appendix

Dell Technical Support Policy

Technician‑assisted technical support requires the cooperation and participation of the customer in the troubleshooting
process and provides for restoration of the Operating System, application software and hardware drivers to the original
default configuration as shipped from Dell, as well as the verification of appropriate functionality of the printer and all
Dell‑installed hardware. In addition to this technician assisted technical support, online technical support is available
at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell‑installed software and peripherals. Support for
third‑party software and peripherals is provided by the original manufacturer, including those purchased and/or
installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Contacting Dell

You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, and fill
in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

• World Wide Web

www.dell.com/

www.dell.com/ap/ (Asian/Pacific countries only)

www.dell.com/jp/ (Japan only)

www.euro.dell.com (Europe only)

www.dell.com/la/ (Latin American and Caribbean countries)

www.dell.ca (Canada only)

• Anonymous file transfer protocol (FTP)

ftp.dell.com

Log in as user: anonymous, and use your email address as your password.

• Electronic Support Service

mobile_support@us.dell.com

support@us.dell.com

la-techsupport@dell.com (Latin America and Caribbean countries only)

apsupport@dell.com (Asian/Pacific countries only)

support.jp.dell.com (Japan only)

support.euro.dell.com (Europe only)

• Electronic Quote Service

apmarketing@dell.com (Asian/Pacific countries only)

sales_canada@dell.com (Canada only)
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Warranty and Return Policy

Dell Inc. (“Dell”) manufactures its hardware products from parts and components that are new or equivalent to new
in accordance with industry‑standard practices. For information about the Dell warranty for your printer, refer to the
Product Information Guide.
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Index

Numerics
2100‑sheet tray 

installing  31
loading  49

550‑sheet tray 
installing  31

Symbols
[x]‑page jam, clear manual feeder.
[250]  164
[x]‑page jam, lift front cover to
remove cartridge. [200–201]  156
[x]‑page jam, open tray [x].
[24x]  163
[x]‑page jam, open upper and lower
rear door. [231–234]  159
[x]‑page jam, open upper rear door.
[202]  158
[x]‑page jam, remove paper, open
expander rear door. Leave paper in
bin. [43y.xx]  167
[x]‑page jam, remove paper, open
finisher rear door. Leave paper in
bin. [451]  168
[x]‑page jam, remove paper, open
mailbox rear door. Leave paper in
bin. [41y.xx]  165
[x]‑page jam, remove paper, open
stapler door. Leave paper in bin.
[455–457]  169
[x]‑page jam, remove standard bin
jam. [203]  159
[x]‑page jam, remove tray 1 to clear
duplex. [235–239]  162

A
accessing Status Monitor
Center  149
Active NIC menu  91
adjusting printer display
brightness  131
adjusting Sleep mode  130
adjusting toner darkness  72
AppleTalk menu  96
attaching cables  32
available internal options  14
avoiding jams  67

avoiding paper jams  152

B
Bin Setup menu  89
buttons, printer control panel  12

C
cables 

Ethernet  32
USB  32

canceling 
print job, from computer  77

canceling a print job 
from a computer  77
from the printer control panel  77

cannot open Embedded Web
Server  222
card stock 

loading  56
tips  63

Cartridge low [88.xy]  172
Cartridge nearly low [88.xy]  172
Cartridge very low [88.xy]  172
Cartridge, imaging unit mismatch
[41.xy]  172
Change [paper source] to [custom
string] load [orientation]  172
Change [paper source] to [custom
type name] load [orientation]  173
Change [paper source] to [paper
size] load [orientation]  173
Change [paper source] to [paper
type] [paper size] load
[orientation]  173
Check tray [x] connection  173
checking an unresponsive
printer  189
checking status of parts and
supplies  138
checking the status of parts and
supplies  138
checking the virtual display 

using the Embedded Web
Server  149

cleaning 
exterior of the printer  137

cleaning the printer  137
Close door or insert cartridge  174

Close front door  174
Complex page, some data may not
have printed [39]  174
compressed images appear on
prints  205
confidential data 

information on securing  136
confidential jobs 

modifying print settings  150
confidential print jobs  75

printing from a Macintosh
computer  76

printing from Windows  76
Confidential Print menu  104
Configuration change, some held
jobs were not restored [57]  174
configuration information 

wireless network  37
configurations 

printer  10
Configure MP menu  83
configuring 

multiple printers  150
supply notifications, imaging

unit  139
supply notifications, maintenance

kit  139
supply notifications, toner

cartridge  139
configuring port settings  40
configuring supply notifications  139
connecting to a wireless network 

using PBC, Push Button
Configuration method  38

using PIN, Personal Identification
Number method  38

using the Embedded Web
Server  39

conservation settings 
brightness, adjusting  131
conserving supplies  128
Eco‑Mode  128
Hibernate mode  131
Quiet mode  129
Sleep mode  130

conserving supplies  128
contacting technical support  223
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control panel, printer 
indicator light  12
Sleep button light  12

controller board 
accessing  14

custom paper type 
assigning  61

custom paper type name 
creating  60

custom paper type names 
assigning  61

Custom Type [x] 
assigning a paper type  61

Custom Type [x] name 
creating  60

Custom Types menu  88

D
Default Source menu  79
Defective flash detected [51]  174
device and network settings 

erasing  134
directory list 

printing  77
Disk full [62]  174
Disk must be formatted for use in
this device  175
Disk near full. Securely clearing disk
space.  175
disk wiping  135
Disk Wiping menu  105
display troubleshooting 

printer display is blank  191
display, printer control panel  12

adjusting brightness  131
disposing of printer hard disk  133
documents, printing 

from Macintosh  72
from Windows  72

E
Eco‑Mode setting  128
embedded solutions 

erasing  134
Embedded Web Server 

adjusting brightness  131
checking the status of parts  138
checking the status of

supplies  138
copying settings to other

printers  150

modifying confidential print
settings  150

problem accessing  222
Embedded Web Server
Administrator's Guide 

where to find  136
Empty the hole punch box  175
emptying the hole punch box  138
encrypting the printer hard
disk  135
envelopes 

loading  56
tips on using  63

environmental settings 
conserving supplies  128
Eco‑Mode  128
Hibernate mode  131
printer display brightness,

adjusting  131
Quiet mode  129
Sleep mode  130

erasing hard disk memory  135
erasing non‑volatile memory  134
erasing volatile memory  134
Error reading USB drive. Remove
USB.  175
Error reading USB hub. Remove
hub.  175
Ethernet network 

preparing to set up for Ethernet
printing  36

Ethernet network setup 
using Macintosh  36
using Windows  36

Ethernet networking 
Macintosh  36
Windows  36

Ethernet port  32
Ethernet setup 

preparing for an  36
exterior of the printer 

cleaning  137

F
factory defaults, restoring  151
finding more information about the
printer  8
finisher 

finishing features  69
supported paper sizes  69

finisher features  69
Finishing menu  116

firmware card  14
flash drive 

printing from  74
flash drives 

supported file types  73
font sample list 

printing  77

G
General Settings menu  107
green settings 

Eco‑Mode  128
Hibernate mode  131
Quiet mode  129

H
held jobs  75

printing from a Macintosh
computer  76

printing from Windows  76
Help menu  127
Hibernate mode 

using  131
hole punch box 

emptying  138
Home button 

printer control panel  12
HTML menu  125

I
Image menu  126
imaging unit 

replacing  143
Imaging unit low [84.xy]  175
Imaging unit nearly low [84.xy]  175
Imaging unit very low [84.xy]  175
Incompatible output bin [x]
[59]  176
Incompatible tray [x] [59]  176
Incorrect paper size, open [paper
source] [34]  176
indicator light 

printer control panel  12
individual settings 

erasing  134
Insert hole punch box  176
Insert staple cartridge  176
Insert Tray [x]  176
Install bin [x]  177
Install Tray [x]  177
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installing an Internal Solutions
Port  19
installing an optional card  23
installing options 

order of installation  30
installing printer hard disk  25
installing printer on a network 

Ethernet networking  36
installing printer software  34

adding options  35
installing the 2100‑sheet tray  31
installing the 550‑sheet tray  31
Insufficient memory for Flash
Memory Defragment operation
[37]  177
Insufficient memory to collate job
[37]  178
Insufficient memory to support
Resource Save feature [35]  178
Insufficient memory, some Held
Jobs were deleted [37]  177
Insufficient memory, some held
jobs will not be restored [37]  178
internal options  14
internal print server 

troubleshooting  193
Internal Solutions Port 

changing port settings  40
installing  19
troubleshooting  194

IPv6 menu  95

J
jams 

accessing  154
avoiding  152
understanding messages  154

jams, clearing 
behind rear door  158, 159
in duplex area  162
in finisher rear door  168
in mailbox rear door  165
in multipurpose feeder  164
in rear expander door  167
in standard bin  159
in staple finisher  169
in the tray  163
inside the printer  156

Job Accounting menu  119

K
keypad 

printer control panel  12

L
labels, paper 

tips  64
letterhead 

loading, 2100‑sheet tray  49
loading, multipurpose feeder  56
loading, trays  44

linking trays  60
assigning custom paper type

names  61
Load [paper source] with [custom
string] [orientation]  178
Load [paper source] with [custom
type name] [orientation]  179
Load [paper source] with [paper
size] [orientation]  179
Load [paper source] with [paper
type] [paper size] [orientation]  179
Load Manual Feeder with [custom
string] [orientation]  179
Load Manual Feeder with [custom
type name] [orientation]  180
Load Manual Feeder with [paper
size] [orientation]  180
Load Manual Feeder with [paper
type] [paper size] [orientation]  180
Load staples  178
loading 

2100‑sheet tray  49
card stock  56
envelopes  56
letterhead in 2100‑sheet tray  49
letterhead in multipurpose

feeder  56
letterhead in trays  44
multipurpose feeder  56
optional 550‑sheet tray  44
standard 550‑sheet tray  44
transparencies  56

lock, security  133

M
maintenance kit 

ordering  140
Maintenance kit low [80.xy]  180
Maintenance kit nearly low
[80.xy]  180

Maintenance kit very low
[80.xy]  181
managing printer messages  149
memory 

types installed on printer  133
memory card  14

installing  17
Memory full [38]  181
menu settings 

loading on multiple printers  150
menu settings page 

printing  42
menus 

Active NIC  91
AppleTalk  96
Bin Setup  89
Confidential Print  104
Configure MP  83
Custom Types  88
Default Source  79
Disk Wiping  105
Finishing  116
General Settings  107
Help  127
HTML  125
Image  126
IPv6  95
Job Accounting  119
list of  79
Miscellaneous  104
Network [x]  91
Network Card  93
Network Reports  93
Paper Loading  86
Paper Size/Type  80
Paper Texture  83
Paper Weight  85
Parallel [x]  98
PCL Emul  123
PDF  122
PostScript  122
Print Settings  112
Quality  119
Reports  90
Security Audit Log  106
Serial [x]  100
Set Date and Time  106
Setup  115
SMTP Setup menu  103
Standard Network  91
Standard USB  97
Substitute Size  83
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TCP/IP  94
Universal Setup  88
Utilities  121
Wireless  95
XPS  122

Miscellaneous menu  104
moving the printer  9, 146, 148
multipurpose feeder 

loading  56

N
Network [x] menu  91
Network [x] software error
[54]  181
Network Card menu  93
Network Reports menu  93
network setup page 

printing  43
noise, printer 

reducing  129
Non‑Dell [supply type], see User’s
Guide [33.xy]  181
non‑volatile memory  133

erasing  134
Not enough free space in flash
memory for resources [52]  182
number of remaining pages 

estimate  137

O
optional 550‑sheet tray 

loading  44
optional card 

installing  23
options 

2100‑sheet tray, installing  31
550‑sheet tray, installing  31
firmware cards  14
Internal Solutions Port,

installing  19
memory card  14, 17
printer hard disk, installing  25
printer hard disk, removing  29
updating in printer driver  35

ordering 
maintenance kit  140
roller kit  140

ordering supplies 
using Printer Home  140

P
paper 

characteristics  64
letterhead  66
preprinted forms  66
recycled  66
selecting  65
setting size  44
setting type  44
storing  64, 67
unacceptable  66
Universal size setting  44
using recycled  128

Paper changes needed  182
paper characteristics  64
paper feed troubleshooting 

message remains after jam is
cleared  196

paper jams 
avoiding  152

paper jams, clearing 
behind rear door  158, 159
in duplex area  162
in finisher rear door  168
in mailbox rear door  165
in multipurpose feeder  164
in rear expander door  167
in standard bin  159
in staple finisher  169
in the tray  163
inside the printer  156

Paper Loading menu  86
Paper Size/Type menu  80
paper sizes 

supported  68
Paper Texture menu  83
paper types 

supported  67
Paper Weight menu  85
paper weights 

supported  67
Parallel [x] menu  98
Parallel port [x] disabled [56]  182
parts 

checking status  138
checking, using the Embedded

Web Server  138
parts and supplies, status of 

checking, on printer control
panel  138

PCL Emul menu  123

PDF menu  122
Personal Identification Number
method 

using  38
port settings 

configuring  40
PostScript menu  122
PPDS font error [50]  182
preparing to set up the printer on
an Ethernet network  36
print irregularities  209
print job 

canceling from the printer control
panel  77

canceling, from computer  77
print quality troubleshooting 

blank pages  213
characters have jagged edges  204
clipped pages or images  204
compressed images appear on

prints  205
gray background on prints  206
horizontal voids appear on

prints  206
print irregularities  209
print is too dark  210
print is too light  211
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